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1.0 AIMS AND OBJECTIVES 

After studying this lesson, you should be able to: 

• Describe computer sys~em 

• Explain characteristics of computer system 

• Describe the uses of computer in business 

• Explain various computer generations 

1.1 INTRODUCTION 

Nothing has revolutionized modem life the way rapid progress of computers has. For 
better or worse, computers have infiltrated every aspect of our society. Today, 
computers do much more than simply compute. They make airline or railway 
reservation and teach on-line; some super store scanners calculate our grocery bills 
while keeping the store inventory; computerised telephone switching bas greatly 
improved the telephone system and Automatic Teller Machines (A TM) let us conduct 
banking transactions from virtually anywhere in the world. 

As computers become more widespread in the workplace, new ways to harness their 
potential developed. As smaller computers become more powerful, they couJ..; be 
linked together, or networked, to share memory space, software, and information and 
communicate with each other. 

1.2 WHAT IS A COMPUTER? 

In a laymans language, a computer is a fast calculating device that can perf onn 
arithmetic operations. Although the computer was originally invented mainly for 
doing high speed and accurate calculations, it is not just a calculating device. The 
computer can perform any kind of work involving arithmetic and logical operations 
on data. It gets the data through an input device, processes it as per the instructions 
given and gives the information as an output. We can define computer as follows: 

"A computer is a fast electronic device that processes the input data according to tht: 
instructions given by the programmer/user and provides the desired information as an 
output". 

Table 1.1: Terminology used In Defi.nltion of Computer 

Term Meaning 

Data A set of basic facts and entities which itself has no meaning 

Informatio.n Data whi<;h bas some meaning or value 

Instruction A statement givcn, to computer to pcrf onn a task 

Input Data and instructions given to computer 

Process Manipulation of data 

Output Information obtained after processing of data 

1.3 A SIMPLE MODEL OF A COMPUTER 

Computers have shaken up the world. They have made us dependent upon them. We 
expect them to be present at every place: be it the reservation counter, the mici:owave 
cooking or even driving a car. Now that computers have moved in our society so 
rapidly, one needs, at least the basic computer skills to pursue one's career goals and 
function effectively and efficiently. We can say that computer literacy is the .need of 
today and voice of tomorrow to survive i.o the fast changing world of computers. 



For most of the people computer literacy is restricted to using the keyboard :for typing 
a document or making use of it for the calculations. But this is not enough. One must 
know the fundamental concepts about what computers constitute of and how do they 
work. Take an example, you drive a motorbike and you take it for the servicing. There 
is one way that you tell the service boy to service the motorbike and I will collect it in 
the evening. Anothei: way could be th.at you tell him that. apart from servicing, please 
change the engine oil and clean the carburetor too. This way the service man would be 
more careful while doing the job of your motorbike and you too will be able to solve 
at least some of the small problems when the mechanic is not available. The lack of 
knowledge sometimes leads to getting into great troubles. Lack of knowlledge can 
cause mistakes while using the computer also. Sometimes this lack of knowledge 
causes some fear in the people. This fear is termed as CYBERPHOBIA. (This is not a 
technical term, it is just used for the people who are scared of using the computers.) 

1.3.1 Computer: The Definition 

For most of the people, computer is a machine used for calculations or corn1putation, 
but actually, it is much more than that. Precisely, "Computer is an electronic _device 
for perfonning arithmetic and logical operations", or "Computer is a device or flexible 
machine to process data and convert it into information". 

Now, in the above two definitions, three wo(ds are tricky that need some ex]Planation. 
Let us start with logical operations-these are the type of operations in which 
decision(s) is/are involved. Data is simply raw facts or figures collected whereas the 
information is what one gets after processing the data. Information is always useful 
and meaningful for the user. Let us consider an example in which marks of various 
subjects are collected for a particular group of stqdents. Now, these marks 
independently (data) are of no use as such for the class teacher, but once she he adds 
the marks of all the students and calculates their respective percentages, this. becomes 
information and it serves her/him in fmding out the answer for the queries like Who 
has stood 1st in the class? or How many people have got distinctions in the class? or 
What is the overall performance of the class? 

Computers are not only used for the pwpose of calculations. An accountant, a grocery 
shop owner, a bank or an A TM uses it like a computational device, where as an author 
uses it as a writing tool, a musician as a device for controlling the music, kids as a· 
machine for playing games and so on. 

Now, you must be thinking that what is so special about this machine that pe,ople from 
diversified fields can use it so flexibly for entirely different functions. The answer is 
that "computer is programmable" meaning that it all depends upon what program 
computer is using for performing a particular function. 

Now, the next question that comes into one•s mind is, what is a program? In a very 
simple language we can say that ''A Program is a set of instructions t1:lling the 
computer what to do." 

1.3.l. Basic Anatomy of Computers 

Broadly computer can be said to be made up of hardware and software. The computer 
hardware (actual machine) is defined in such a way that it does whatever th~: software 
(computer programs) tells it to do. 

There are four basic operations which a computer perfoans irrespective of the 
program which is running on it. They are classified as: 

1. Input: This is for the pwpose of inserting or feeding data into the computer by 
means of an input device like keyboard 

2. Processing: Some kind of processing is done in the computer to take out or 
transform the data.in some way. 

3 
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3. Output: The computer produces output on a device, such as printer or a monitor 
that shows the result of processing operations. 

4. Storage: The computer stores the result of processing operations for future use in 
some storage device like hard disk or a floppy disk. 

Figure 1.1 

These operations are often referred' to as IPOS cycle. But, the four steps of IPOS 
cycle - input, processing, output anostorage - may not necessarily appear in the 
same sequence as they are defined. 

Figure 1.2 

1.4 CHARACTERISTICS OF COMPUTERS 

The various characteristics of computers are: 

• Speed: A computer is a very fast and accurate device. It can process thousands of 
instructions within a few seconds for which a human being can take several days 
or months. 

• Accuracy: Degree of accuracy of the computer is very high. Errors can occur in 
computerized system also but most of them occur due to human mistakes rather 
than technical problems in the computer. 

• Versatility: We can perform many different tasks on the computer. One moment it 
might be busy in calculating the statistical data of a business organization for 
annual performance evaluation and at next moment it is capable of working on 
inventory control. 

• Permanent Memory: We can store very large amount of information in the 
secondary storage devices. This information stays with the computer for further 
use where as humans tend to forget things. 



• No Intelligence: A computer can perform the information processing and 
reasoning only on the basis of the intelligence provided by human beings (in 
tenns of programs developed) but it cannot make decisions on its own. 

• Diligence: Computer is free from problems like exhaustion, lack of concentration, 
confusion, etc., unlike human beings. 

1.5 CLASSIFICATION OF COMPUTERS 

The classification of computers is based on the following three criteria: 

(a) According to Purpose 

(b) According to Technology Used 

(c) According to Size and Capacity 

Based on these criteria, the classification of computers is illustrated in Figure 1.3 and 
discussed below: 

Classification of Computers 

Based on 

I 
Purpose Technology Used Size & Capacity 

i 

- Analog ~ Super 

I Computers Computers 

- General Purpose H Mainframe I Computers Computers 

- Digital 
Computers 

H Mini I Computers 

- Special Purpose - Hybrid Micro I 
Computers Computers Computers (PCs) 

Figure 1.3: Classification of Computers Based on Different Criteria 

According to Purpose 

According to the utilization of computer for different uses, computers are of following 
two types: 

l . General Purpose Computers: Computers that follow instructions for general 
requirements such as sales analysis, financial accounting, invoicing, inventory, 
management information etc. are called General Purpose Computers. Almost all 
computers used in offices for commercial, educational and other applications are 
general purpose computers. 

2. Special Purpose Computers: Computers designed from scratch to perform special 
tasks like scientific applications and research, weather forecasting, space 
applications, medical diagnostics etc. are called Special Purpose Computers. 

According to Technology Used 

According to the technology used, computers are of following three types: 

1. Analog Computers: Analog computers are special purpose computers that 
represent and store data in continuously varying physical quantities such as 

5 
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current, voltage or frequency. These computers are programmed for measuring 
physical quantities like pressure, temperature, speed etc. and to perform 
computations on these measurements. Analog computers are mainly used for 
scientific. and engineering applications. • Some of the examples of analog 
computers are given below: 

(a) Thermometer: It is a simple analog computer used to measure temperature. In 
thermometer, the mercury moves up or down as the temperature varies. 

(b) Speedometer: Car's speedometer is another example of analog computer 
where the position of the needle on the dial represents the speed of the car. 

2. Digital Computers: Digital computers are mainly general purpose computers that 
represent arid store data in discrete quantities or numbers. In these computers, all 
processing is done in terms of numeric representation (Binary Digits) of data and 
information. Although the user enter data in decimal or character fonn, it is 
converted into binary digits (O's and l's). Almost all the computers used nowadays 
are digital computers and we will discuss the detailed working and components of 
these computers in subsequent sections of this unit 

3. Hybrid Computers: Hybrid computers incorporate the technology of both analog 
and digital computers. These computers store and process analog signals which 
have been converted into discrete numbers using analog-to-digital converters. 
They can also convert the digital numbers into analog signals or physical 
properties using digital-to-analog converters. Hybrid computers are mainly used 
in artificial intelligence (robotics) and computer aided manufacturing (e.g., 
process control). 

According to Size and Capacity 

According to the size and memory/storage capacity, computers are of following four 
types: 

1. Supercomputer: Supercomputer is the biggest and fastest computer, which is 
mainly designed for complex scientific applications. It bas many CPUs (Central 
Processing Units - main part of computer) which operate in parallel to make it as 
a fastest computer. It is typically used for the following applications: 

❖ Weather Forecasting 

♦ Petroleum Exploration and Production 

(• Energy Management 

• Defense 

•:• Nuclear Energy Research 

Ct Structural Analysis 

♦ Electronic Design 

❖ Real-time Animation 

❖ Medicine 

Some of the examples of supercomputers are CRA Y3, CR.A Y-XMP-14, NECSOO, 
PARAM 9000 and PAR.AM 10000. 

2. Mainframe Computer: Mainframe computers are very large and fast computers 
but smaller and slower than supercomputers. These are used u;i a centralized 
locatiqn where many tenninals (input/output devices) are connected with one 
CPU and thus, allow different users to share the single CPU. They have a very 
high memory (several hundred Megabytes) and can support thou~ands of users. 
They are mainly used for following applications: 



❖ Railway and Airline Reservations 

❖ Banking Applications 

❖ Commercial Applications of Large Industries/Companies 

Some of the examples of mainframe computers are IBM 3090, IBM 4381, IBM 
4300 and IBM ES-9000. 

3. Minicomputer: Minicomputers are mediwn-scale, smaller and gene:rally slower 
than mainframe computers. Like mainframes, they have many terminals which are 
connected with one CPU and can support many users. The cost of minicomputer 
is very less as compared to mainframe. Therefore, it is mainly used in applications 
where processing can be distributed among several minicomputers rather than 
using a mainframe computer. 

Some of the examples of minicomputers are PDP-I , IBM AS/400 and DEC 
Micro VAX. IBM AS/400, which is actually a midicomputer (computer with 
performance between a mainframe and minicomputer) is becoming , ;ery popular 
among minicomputers. 

4. Microcomputer: A microcomputer is the smallest digital computer, which uses a 
microprocessor as its Cpu. Microprocessor is a single chip (Integrated Circuit) 
Cpu. Microcomputer is popularly called as Personal Computer (PC). It can be 
used both as a stand-alone machine and a terminal in a multi-user e1nvironment. 
Microcomputers are becoming very popular nowadays due to very high 
processing power and memory. Today, a powerful microcomputer may be used as 
a substitute for mini or mainframe computer. 

Microcomputers are either of desktop or portable model. Portable computers can 
be carried from one place to another. Some of the models are called as laptops 
while others as notebo0k computers. Notebook computers are smaller, lighter and 
costlier than laptops. Desktop computers fit on a desktop and are use:d widely in 
offices and homes. The pictures of some of the desktop and portable~ computers 
are shown in Figure 1.4. 

Figure 1.4: Some Desktop and Portable Computers 
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There are many. types and models of microcomputers, which are summarized in 
Table 1.2. 

Table 1.2: Different Types of Microcomputers along with the 
Technical Specifications of CPU 

CPU Model Clock Date Register Max.Memory Comments 
(MHz) Bus (BIT) (RAM) 

8088 8 8 16 !MB· First 8 bit microprocessor (Original PC) 

8086 8 t6 16 1MB Fi.rst 16 bit CPU on a chip (PCtxT)• 

80286 20 16 16 16MB 5 times faster than PC/XT (PC/ AT) .. 

80386 SX 33 16 32 16MB 80386 witb an 80286 bus 

80386 DX 40 32 32 4GB True 32 bit CPU on a cbip 

80486 sx 40 32 32 4GB 'Math co-processor disabled 

80486DX2 66 32 32 4GB More speed with Math co-processor 
enabled 

80486 DX4 100 32 32 4GB More speed than 486 DX2 

Pentium Pro (PS) 200 64 32 4GB Superscope arcbitecture Able to execute 
2 instructions simultaneously 

Pentium TI (P6) 266 64 32 64GB Faster tban Pentium Pro 

1.6 ARCHITECTURE OF A COMPUTER SYSTEM 

In last section, we discussed that there are many types of computers. The internal 
architectural design of computers differ fr ...... one model to another, however the basic 
components of a computer remains the same for all models. The diagram of a 
generalized architecture of a computer system is shown in Figure 1.3. Before 
discussing the details of computer architecture, .we would define the computer system 
as follows: 

"A complete computer installation including the central processing unit, · the 
peripherals such as hard disk drives, floppy disk drives, monitor, printer, mouse and 
operating system which are designed to work and interact with each other and with the 
user is called a computer system." 

Input Device Output Device 

Primary Memory Secondary Memory 

USER 

Figure 1.5: Functional Diagram of a Generalised Architecture of a Computer System 

A computer system has following three main components: 

(a) Input/Output Unit 

(b) Central Processing Unit 

(c) Memory Unit 



1.6.1 Input/Output Unit 
We know that the computer is a machine that processes the input data according to 
given set of instructions and gives the output. Before a computer does processing, it 
must be given data and instructions. After processing, the output must be displayed or 
printed by the computer. The unit used for getting the data and instructions into the 
computer and displaying or printing output is known as an Input/Outprnt Unit (I/0 
Unjt). 

The Input Unit is used to enter data and instructions into a computer. The:re are many 
peripheral devices which are used as input/output units for the computeir. The most 
common fonn of input device is known as a tenninal. A terminal has ;a electronic 
typewriter like device, called keyboard along with a display screen, c211led Visual 
Display Unit (VDU) or monitor. Keyboard is the main input device while monitor can 
be considered both as an input as well as an output device. There are some other 
common input devices -like mouse, punched card, tape, joystick, scanner, modem etc., 
which are explained in later part of trus unit. Monitor, printer and plotter a1re the main 
peripberaJ devices used as output units for the computer. 

1.6.2 Central Processing Unit 

Central Processing Unit (CPU) is the main component or ''brain" of a. computer, 
which perfonns all the processing of input data. Its function is to fetch, e:xarnine and 
then execute the instructions stored in main memory of computer. In microcomputers, 
the CPU is built on a single chip or Integrated Circuit (IC) and is called as 
Microprocessor. The CPU consists of following distinct parts: 

I. Arithmetic Logic Unit (ALU): The arithmetic and logic uni_t ()f CPU is 
responsible for all arithmetic operations like addition, subtraction, multiplfoation 
and division as well as logical operations such as less than, equal to and greater 
than. Actually, aJJ calculations aod comparisons are performed in thti arithmetic 
logic unit. 

2. Control Unit (CU): The control unit is responsible for controlling the: transfer of 
data and instructions among other units of computer. It is considered as a "Central 
Nervous System" of computer, as it manages and coordinates all ~he units of 
computer. It obtains the instructions from the memory, interprets them and directs 
the operation of the computer. It also performs the physical data transfer between 
memory and the peripheral device. 

3. Registers: Registers are the small high speed circuits (memory locations) which 
are used to store data, instructions and memory addresses (~emocy location 
numbers), when ALU performs arithmetic and logical operations. Ri!gisters can 
store one word of data (1 word = 2 bytes & 1 byte = 8 bit; details of BITS and 
BYTES are discussed in later part of this unit) until it is overwritten by another 
word. Depending on the processor's capability, the number and type of registers 
vary from one CPU to another. Registers can be divided into six cat1egories viz. 
General Purpose Registers, Pointer Registers, Segment Registers, Inde:"- Registers, 
Flags Registers and Instruction. Pointer Registers, depending upon the,ir function. 
The detailed functions of each and every register is bryond the scope of this book. 

4. Buses: Data is stored as a unit of eight bits (BIT stands for Binary Digit i .e. (0 or 
1) in a register. Each bit is transferred from one register to another by means of a 
separate wire. This group of eight wires, which is used as a common way to 
transfer data between registers is known as a bus. In general terms, bus is a 
connection between two components to transmit signal between them. Bus can be 
of three major types viz. Data Bus, Control Bus and Address Bus. The: data bus is 
used to move data, address bus to move address or memory location and control 
bus to send control signals between various components of a computer .. 

9 
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5. Clock: Clock is another important component of CPU, which measures and 
allocates a fixed time slot for processing each and every micro-operation (smallest 
functional operation). In simple terms, CPU is allocated one or more clock cycles 
to complete a micro-operation. CPU executes the instructions in synchronization 
with the clock pulse. 

The clock speed of CPU is measured in terms of Mega Hertz (MHz) or Millions 
of Cycles por second. The clock speed of CPU varies from one model to another 
in the range 4.77 MHZ (in 8088 processor) to 66 MHz (in Penti"L+m) CPU speed is 
also specified in terms of Millions of Instructions Per Second (MIPS) or Million 
of Floating Point Operations Per Second (MFLOPS). 

1.6.3 Memory Unit 

Memory Unit is that component of a computer system, which is used to store the data, 
instructions and information before, during and after the processing by ALU. It is 
actually a work area (physicaUy a collection of integrated circuits) within the 
computer, where the CPU stores the data and instructions. It is also known as a 
Main/Primary/Internal Memory. It is of following three types: 

(a) Read Only Memory (ROM pronounced as "Ra-omtt) 

(b) Random Access Memory (RAM pronounced as "R-aem") 

(c) Complementary Metal Oxide Semiconductor Memory (CMOS) 

(a) Read Only Memory: Read Only Memory is an essential component of the 
memory unit. We know that the computer, being a machine, itself has no 
intelligence or memory and requires the instructions which are given by man. 
Whenever the computer is switch(",d on, it searches for the required instructions. 
The memory, which bas these essential instructions, is known as Read Only 
Memory (ROM). This memory is permanent and is not erased when system is 
switched off. As appears with its name, it is read type of memory i.e. it can be 
read only and not be written by user/programmer. The memory capaci_ty of ROM 
varies from 64 KB to 256 KB (l Kilobyte= 1024 bytes) depending on the model 
of computer. 

ROM contains a number of programs (set of instructions). The most important 
program of ROM is the Basic Input Output System (BIOS, pronounced as "bye- . 
os") which activates the hardware (physical components of computer) such as 
keyboard, monitor, floppy disk etc. in communicating with the system and 
application software (set of instructions or programs). 

Types of ROM: There are many types of ROM available for microcomputers like 
Mask ROM, PROM, EPROM, EEPROM and EAPROM. 

(b) Random Access Memory: Random Access Memory (RAM) is another important 
component of Memory Unit. It is used to store the data and instructions during the 
execution of program. Contrary to ROM, RAM is temporary and is erased when 
computer is switched off. RAM is a ,eadlwrite type of memory and, thus can be 
read and written by user/programmer. As it is possible to randomly use any 
location of this memory, therefore, this memory is known as random access 
memory. The memory capacity of RAM varies from 640 KB to several megabytes 
( l Megabyte= 1024 KB) with different models of PC. 

Types of RAM: There are two types of RAM used in PCs - Dynamic and Static 
RAM. 

( c) Complementary Metal. Oxide Semiconductor Memory: Complementary Metal 
Oxide Semiconductor (CMOS) memory is used to store the system configuiation, 
date, time and other important data. When computer is switched on, BIOS 



matches the infonnation of CMOS with the peripheral devices and displays error 
in case of mismatching. 

1.7 COMPUTERS IN BUSINESS 

Computers can process vast quantities of business data at enormous spe¥d with 
unfailing consistency and unimaginable flexibility. 

These capabilities of computers open new approaches to problem solving and data 
processing. 

Following six characteristics of computers make them indispensable for use in 
business: 

(a) Speed: Computers speed up data processing by many orders of magnitude as 
compared to the manual system. 

(b) Data Volume: Vast amount of data can. be stored and processed vetj· quickly. 

(c) Repetitiveness: The more repetitive the task, the more profit.able it is to 
automate it 

( d) Complexity: Problems with several interacting variables can be solved quickly 
and accurately. 

(e) Accurate Output: As high accuracy can be obtained as needed; als10 accuracy is 
not affected by boredom and fatigue and is not Subjective. 

(t) Declining Costs: There has been a steady decline in the cost of pe:r unit of data 
processed. 

1.8 FACILITIES AVAILABLE IN COMPUTERIZE]) 
SYSTEM 

1.8.1 For Data Capture 
Data capture is the identification of new data to be input. It is always best to capture 
the data as soon as possible after it is originated. 

The commonly used input device is a keyboard. Mouse, joy stick, light pen, touch 
screen, and trackballs ·are some of the devices which do not require tyrping of input 
information. 

On-line Mode: Following devices are used to capture data on-line: 

Keyboard 

• A computer keyboard is a sophisticated electromechanical compone1nt designed to 
create special standardized electronic codes when a key is pressed. 

• The codes are transmitted along the cable that connects the keyboard to the 
computer system unit or terminal, where the incoming code is analyzed and 
converted into the appropriate computer usable code. 

Light Pen 

• It is a pointing device, used to select a displayed menu option on the CRT. Light 
pens are frequently used by graphics designers, illustrators, and drafting 
engineers. 

• It js capabl,e of sensing a position on the CRT screen when its ti]P touches the 
sere.ct.-

11 
Introduction to Computer 



12 
Computer Application 
for Managers 

• A user can draw directly on the CRT screen with the light pen if the computer 
system is provided with Computer Aided Design (CAD) package such as 
AutoCad 14. 

Mouse 

• A mouse is also a pointing device. 

• As the mouse is rolled across the desktop, the cursor moves across the screen. 

• The user can select menu or command by pushing a button on the mouse once or 
twice. 

Scanners 

Scanners are a kind of input device. They are capable of entering information directly 
into the computer. The main advantage of direct entry of information is that users do 
not have to key in the information. This provides faster and more accurate data entry. 

Important types of scanners are: 

(a) Optical scanners 

(b) Magnetic ink character readers 

Optical Scanners 

The following are the commonly used optical scanners: 

• Optical Character Readers (OCR) 

• Optical Mark Readers (OMR) 

• Optical Bar-Code Readers 

Terminals 

Terminals can be "dumb", "smart", or "intelligent", and are used ma.inly by those who 
do their work on mini or mainframe computers (or supercomputers). 

A variety of computer terminals are used to enter data, including the following 
popular types: 

• Point-of~Sale (POS) terminals 

• Financial transaction terminals 

• Executive workstations 

• Portable terminals 

• Microcomputers used as terminals 

Smart Cards 

• It contains a build-in microcomputer chip. 

• In case of smart cards, there are le_ss chances of fraud. 

• How much cash a customer has to his credit is stored in the chip before it is issued· 
to him. 

• When the customer uses the card to make purchases, the required amount is 
deducted from the balance by a special electronic machine used by merchants. 

• The electronic machine used by merchants communicates with the card issuing 
company's computer from time to time for money transactions. Thus, a card 
holder has the facility of keeping electronic money with him. 



• When his electronic money is used up, he can replenish electronic money by 
depositing money at automated banking machlne of card-issuing company. 

• A record of purchases made by the customer can also be stored in a smart card. 

Off-line Mode: Off-line data entry involves devices through which data ai:e recorded 
on some media and then into tbe computer later. 

In almost 90% of the applications, data entry is done off-line. This saves the precious 
computer processing time. 

The following devices are used to capture data off-line. 

Key-to-tape 

A Key-to-tape device, also known as magnetic tape encoder, is designed to record 
keyed data directly onto magnetic tape. 

Key-to-floppy 

These data entry machines are used to store data directly on flexible disks, called 
diskettes or floppies. 

Key-to-disk 

Used as data recording stations in systems where data from different points has to be 
recorded for processing at one point. 

1.8.2 For Data Validation 

The accuracy of input data should either be verified manually or by a computer 
program. Some of the techniques used for this purpose are described below: 

Using Control Totals 

In this technique, the verification program verifies the total. 

When business transaction occurs, it is noted down and calculated at tbte point of 
transaction (by clerk) and the same transaction data is entered by the computer 
operator in the computer system. 

The data entered by the operator are totalled by the computer. If the two entries do not 
match, then it is a clear indication that there is a mistake. 

In this manner only correct data will be passed to the machine before pwcessing is 
done. 

Using Built-in Cheques by the Computer Program 

There should be some control to make sure that no data are entered which is beyond a 
certain value. · 

For example, the salary cheques for a particular organization may !!lot exceed 
Rs. 20,000. 

If so, then if a cheque is made for an amount more than Rs. 20,000, then computer 
will point an error. 

l.8.3 For Storage and Retrieval 

Once the valid data has been entered in the system, it is essential that this data is 
stored securely for future use. 

Major types of extemal storage devices used in computerised systems are: 

• Magnetic tapes or cartridge 
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• Hard dfaks 

• Floppy disks 

• Compact Disk (CD) 

1.8.4 For Output 

There are two basic categories of computer-produced output: 

• Output for immecliate use by people, and 

• Output that is stored in computer-usable fonn for later use by the computer. 
Output can be in either hard copy or soft copy fonn. 

Hardcopy Output Devices 

The commonly used hardcopy output devices are: 

(a) Printers: These are the most popular conunonly used output devices. 

❖ Capable of printing characters, symbols, and sometimes graphics on paper. 

❖ Printers are categorized a:ccorcling to whether the image produced is formed 
by physical contact (impact printers) or not (non-impact printers) of the print 
mechanism with the paper. 

(b) Plotters: A plotter is a specialized output device designed to produce high-quality 
graphics in a variety of colors. · 

There are two basic types of plotters: those that use pens and those that do oot. 
Drum plotters and flatbed plotters both uses pens. Electrostatic plotters do not. 

(c) Microfilm and Microfiche: In this technique the output from the computer is 
recorded on a microfilm as microscopic .film images. The information recorded on 
the microfilm can be read with the help of a microfilm reader. 

❖ A microfiche (pronounced as fish, French· word, which means card) is a 4 x 6 
inch film sheet. 

❖ It can store up to 270 pages of information. 

❖ It is easier to read a microfiche as compared to a microfilm. 

Softcopy Output Devices 

Cathode Ray Tube (CRT) 

• Probably, the most popular softcopy output device. 

• Used with terminals connected to large computer systems and as a monitor for 
microcomputer system. 

• The CRT's screen display is made up of small picture elements, called pixels for 
short. The smaller the pixels, the better.the image clarity, or resolution. 

Voice Output Systems 

• Relatively new and can be used in some situations where traditional display 
screen softcopy output is inappropriate. 

• Two different approaches to voice output have evolved, speech coding and speech 
synthesis. 

• Used in applications sueb as automobiles, toys, and games. 



1.8.5 For Transmission 

The most exciting developments in data processing today is data communication. 

Communications, the transfer of information is the basis of office autctnation. 

Some examples of everyday data communication are: 

I. Airline Reservation: Computer is usually located far from the agent; data 
communication must be used to relay data from the terminal to the computer and 
back. 

2. Automated Banking: ATMs are now. widely used in most banks for better 
cnstomer services. The user can make deposits and withdrawals, check balanc<>-<:, 
and even pay utility bills through the ·machines. 

3. Point-of-Sale Terminals: Used in retail stores, instead of cash registers. These 
terminals send records of sales to a central computer, which maintains accounting 
and inventory records. 

Data communication takes on several forms. These are given below: 

(a) Data can be transferred between two geographically dista personal 
computers by using modems, the dial-up telephone system, and a 
communications program in each computer. 

(b) Data can be transferred between two side-by-side computers by hooking up a 
cable from one computer's serial port to the other computer's serial port. 

(c) PC can.act like a remote terminal to a mini or mainframe computer. 

(d) PC can be part of a local area .network, in .which software and hardware 
resources can be shared among many user. 

1.9 INDIAN COMPUTING ENVIRONMENT 

Office work includes many administrative and management activities. The 
preparation, distribution, processing and review of documents are the commo,1 
activities of an organization. Prior to the advent-of computers, these office activities 
were either performed manually or with the help of mechanical and electrical 
machines. During the past few decades, the basic nature of office has changed 
remarkably. Office automation deals in application of latest technologies in improving 
the overall proficiency of the office. 

1.9.1 Office Automation 

"Office automation is the application of computer and related technologies like 
communication and networking to integrate the general office tasks so that the 
efficiency of office work is improved." 

"Office automation does .not mean just to install computers and communication 
devices in an office, but it is much more than that. We will discuss in later part of th.is 
unit, how an office can be automated in a real sen.se.1' 

Needs for Office Automation 

Although all the work of a small or big office can be performed manually, but ii is 
very difficult or even impossible today for an organization to compete in the marke_l 
without office automation. There are many essential requirements of today's office 
environment, which are listed below: 

• To reduce cost of administrative overhead; 

• To increase the efficiency of office tasks; 
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• To provide better service to the customers; 

• To provide accurate infonnation to the management; 

• To provide best and fastest way of communication. 

The above requirements cannot be achieved without using latest technologies and 
therefore, office automation is needed for an organization. 

Office Functions Needed to be Automated 

Many types of functions are performed in an office. The basic functions, which are 
needed to be automated in any office are: 

l. Document Generation: In all offices, many documents are needed to be prepared, 
typed and printed. Typewriters, computers and printers are widely used in 
automating this routine task of offices. 

2. Document Processing: Documents are also needed to be processed in order to 
extract useful information required for MlS and other official purposes. Many 
office automation tools like word processing, desktop publishing etc. are used to 
perform this task. 

3. Document Distribution: AU offices require an electronic distribution system for 
transferring documents and data within and outside the organization. The main 
office automation tools for distribution of documents are Photocopiers, Teletax 
and Fax machines. 

4. Archival Storage: The office documents are also needed to be stored for a long 
period, so that they can be re.trieved when required. This task is achieved by the 
use of different storage devices like tapes, disks etc. 

Office Automation Systems 

For achieving the basic functions of an office, different types of office automation 
systems are used. These systems can be broadly classified into following four types: 

1. Document Management Systems: These systems include computerised tools for 
generation, storage, processing and distribution of documents. 

2. Communication Systems: These systems are used for sending messages, 
documents _and data within and outside the organization. 

3. Teleconferencing .systems: An electronic means of communication for 
conducting seminars and training programmes in an organization is achieved 
through various teleconferencing· systems. 

4. Support Systems: Besides the above major office automation systems, certain 
support systems for managing the activities of work groups are also used in some 
offices. 

1.10 COMPONENTS OF COMPUTER SYSTEM 
Computer components can be broadly divided into two categories - Hardware and 
Software. Hardware refers to any physical component of a computer. For example, 
CPU, Monitor, Keyboard, Hard Disk. Floppy Disk etc. are physical components and 
thus, are hardware. Software refers to the. programmes which are required to operate 
the computer. For example, DOS (Disk Operating System), BASIC, COBOL, dBASE, 
An Accounting Software etc. are all software. An analogy of hardware can be the 
book which you are reading and then software would be the text written on this book. 
Another analogy could be - 'brain' is a hardware but 'memory stored in brain' is a 
software. 



Both hardware and software are dependent on each other. CPU, Memory Unjt, Hard 
Disk etc. are useless until they are provided instructions and data for stoirage and 
processing. Similarly, BASIC or COBOL language has no use until it is stored and 
processed by hardware components of computer. 

1.10.1 Hardware Components of Micro Computer 

In today's computer industry, a wide variety of hardware components are available for 
microcomputers. Managers must be aware of the working and uses of different 
hardware components, so that they can make good decisions about pw·chase of 
computer systems. The hardware components of microcomputer can be class:ified into 
following types: 

(a) Motherboard 

(b) Input Devices 

( c) Output Devices 

(d) Storage Devices 

(e) Cards 

(f) Ports and Cords 

(g) Power Supply . 

All these hardware devices except motherboard are called peripheral devices, as they 
are connected to the motherboard. 

Motherboard 

Motherboard, a!so called as System-Board, is the most important hardware component 
of a microcomputer. Motherboard is so called as all the other boards (print<:d circuit 
boards having chips or other electronic components) of the computer are connected to 
this board, hence it is like mother of all other boards. 

Box 1.1: Components of Motherboard 

A motherboard contains the CPU chip, Memory chip (ROM and RAM chips}, VO 
interface, expansion slots and many other logic circuits. It may also contain a maths 
co-processor chip. CPU or processor chip is tbe main component of motherboard. The 
types of CPU chip (8088/80286/80386/80486 etc.) vary from one model of PC to 
another. The function of maths coprocessor chip (8088/S-0287 etc.) is to sup po.rt the 
CPU chip io processing of mathematical calculations. 

Memory chips are physically installed on the motherboard by different pac;king 
methods. There are three different types of packing of RAM chips DIP, SIMM and 
SIPP. DIP (Dual Inline Package) is the most common packing, having a small 
rectangle box with teads on both sides. SIMM (Single Inline Memory Module) 
packing contains a number of chips soldered on an expansion board having an edge 
connector. SIPP (Single Inline Pin Package) is similar to SIMM, but uses pin rather 
than an edge coI,1Dector. Expansion slots are connectors on motherboard vvbere 
expansion cards like display card, bard rusk controller card .etc. can be connected. I/0 
interface is the channel between the CPU and a peripheral devices (keyboard, monitor 
etc.}. 

Input Devices 

Input devices are used to input data, inf onnation and instructions into the RAM, The 
common input devices of a PC are described below and shown in Figure 1.4. 

• Keyboard: Keyboard (similar to a typewriter) is the main input device of 
computer. It contains three types of keys - alphanumeric keys, special keys and 
:function keys. When a key is pressed. an electronic signal is produced. Tilis signal 
is detected by a keyboard encoder that sends a binary code correspond.img to the 
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key pressed to the CPU. There are many types of keyboards but IO I Keys 
Keyboard is the most popular one. 

• Mouse: Mouse (similar to a mouse) is another important input device. It is a 
pointing device used to move cursor, draw sketches/diagrams, selecting a 
text/object/menu item etc. on monitor screen while working on windows (graphics 

-based operating environment of computer). Mouse is a small, palm size box 
containing three buttons and a ball underneath, which senses the movement of the 
mouse and sends the corresponding signals to CPU on pressing the buttons. 

• Trackball: A trackball looks like a mouse, as the roller is on the top with selection 
buttons on the side. It is again a _ pointing device used to move the cursor and 
works like a mouse. 

• Light Pen: Light pen (similar to a pen) is a pointing device which is used to select 
a displayed menu item or draw pictures on the monitor screen. It consists of a 
photocell and an optical system placed in a small tube. When its tip is moved over 
the monitor screen and pen button is pressed, its photocell sensing elemenrdetects 
the screen I ocation and sends the corresponding signal to the CPU. 

• Touch Screen: Touch screen is sensitive to human fingers. Using this device, the 
user can point to a selection on the screen instead of pressing keys. 

• Joystick: Joystick is also a pointing device which is used to move cursor position 
on a monitor screen. It is mainly used in Computer Aided Designing (CAD) and 
playing computer games. 

• Digitiser: Digitiser is used to creat.e drawings and pictures using a digitiser tablet 
by a process called digitising. Digitising is a process by which graphic 
representations are converted into digital data. The user makes contact with the 
t]at digitiser tablet with a pen-like stylus. As the stylus is cQnnected to the tablet 
by a wire, the traced image is stored in RAM and displayed on monitor. 

• Scanner: Scanner is mainly used in Desktop Publishing (DTP) applications. 
Scanner is used for djgitising images such as photographs, forms, documents etc. 
into computer· memory. Some scanners can also read text by converting them to 
digital code. These scanners are very useful for converting the typed pages into 
word-processing files. Graphics scanners convert a printed image into video 
image without converting it to digital code. 

• Optical Murk Reader (OMR): It is a special type of optical scanner used to 
recognize the type of mark made by pen or pencil. Lt is used where one. out of a 
few alternatives is to be selected and marked. It is specially used for checking the 
answer sheets o f examination having multiple choice questions. 

• Opti~al Character Reader (OCR): lt is also an optical scanner, which is capable 
of detecting alphanumeric characters typed or printed on paper using an OCR 
font. OCR devices are used for large volume applications like reading of 
passenger tickets, computer printed bills of credit card companies and reading of 
ZIP codes in postal services. 

• Bar Code Reader: This device is an optical scanner used for reading bar-coded 
data (data in form of light and dark Hnes). Bar-coded data is generally used in 
labelling goods, numbering the books or encoding ID or Ale numbers. 

• Magnetic Ink Character Recognition (MICR): MICR is used to recognize the 
magnetically-charged characters, mainly found on bank cheques. MlCR is used by 
the banking industry for the proc~ssing of cheques. A special equipment is used to 
encode, decode and process the cheques. 

• Voice-lnpuJ Devices: These devices can recognize the human voice. They seem 
to be very useful but are not popular due to storage of limited vocabularies and 
variations in way of pronouncing words by different persons. 
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Figure 1.6: Common Input Devices of a PC 
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Output devices are hardware components which are used to display or print the 
processed information. The common output devices are described below and shown in 
Figure 1.7. 

Monitor 

Visual Display Unit (VDU), commonly called as monitor is the main output device of 
computer. It consists of a Cathode Ray Tube (CR1), which displays characters as an 
output. It forms images from tiny dots, called pixels, that are arranged in a rectangular 
form. The sharpness of the image (screen resolution) depends upon the number of the 
pixels. 

Types of Monitors: There are different kinds of monitors depending upon the munber 
of pixels. Depending upon the resolution, monitors can be classified as follows: 

( a) CGA. (Color Graphics Adapter) 

(b) MDA (Monochrome Display Adapter) 

(c) HGA (Hercules Graphics Adapter) 

(d) EGA (Enhanced Graphics Adapter) 

19 
Introduction to Computer 



20 
Computer Application 
for Managers 

(e) VGA (Video Graphics Adapter) 

(f) SVGA (Super VGA) 

Control 

Drum 

20" Color Monitor 

Dot Matrix Printer 

Line Printer 

en 

Portable Printer 

Passbook Prinier 

Flatbed 
Flatbed Plotter 

Inkjet Printer · 

A3 Laser Printer 

Figure 1.7: Common Output Devices of a PC 

Depending upon color of display, monitors can be classified as Monochrome (with 
single color black/white display) and Color (with aU colors display) Monitors. 

Printer 

Printer is the most important output device, which is used to print information on 
papers. Printers are essential for getting output of any computer based application. 

Types of Printers: There are many types of printers which are classified on various 
criteria as illustrated in Figure 1.8. Printers can be broadly categorized into two types. 
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Figure 1.8: Classification of Printers 

l . Impact Printers: The printers that print the characters by striking against the 
ribbon and onto the paper, are called Impact Printers. These printers are of two 
types: 

(a) Character Printers: These printers print one character at a time. These 
printers are again of two types Daisy Wheel and Dot Matrix Print◄~rs . Daisy 
Wheel Printers these printers print the characters by a mechanism that uses a 
plastic or metal hub with spokes, caJled daisy wheel. The characters are 
embossed on the radiating spokes and printed by striking these spokes again.st 
the ribbon and paper. Daisy Wheel printers give a good quality bu1t they are 
expensive than Dot Matrix printers. Dot Matrix Printers these printers print 
the characters by putting dots onto the paper. They do not give bettm printing 
quality than daisy wheel printers, but are faster in speed. The printing speed of 
a dot matrix printer can be upto 360 cps (characters per second). They are 
widely used with microcomputers in most of the offices. 

(b) Line Printers: These printers print one line at a time. Their printin1g speed is 
much more than character printers. They are again of two types DrullD Printers 
and Chain Printers. Drum Printers these ·printers print the line by a rotating 
drum having a ring of characters for each print position. The ham.niters strike 
each character of the drum simultaneously, so that entire line is ptrinted for 
one full rotation of the drum. These printers are also called as Barre:! Printers. 
The printouts obtained from these printers, have even character spacing but 
uneven line height Chain Printers these printers print the line by a rotating 
chain having ring characters for each print position. Their printing mechanism 
is similar to drum printers. The printouts obtained from these prin1ters, have 
uneven character spacing but even line height. 

2. Non-Impact Printers: The printers that print the characters without striking 
against the ribbon and onto the paper, aJe called Non-Impact Printe:rs. These 
printers print a complete page at a time, therefore, also called as Page~ Printers. 
Page printers are of three types: 

(a) Laser Printers: These printers look and work like photocopiers. They are 
based oo laser t~hnology, which is the latest development in high 1speed and 
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best quality printing. In these printers, a laser beam is used to write the image 
on a paper. First, the image is formed by electrically charged thousands of 
dots on a paper by laser beam. Then, the paper is sprayed with a toner having 
the opposite charge and is passed over a heated roller to make the image 
permanent. Laser printers are very popular and have become an essential part 
of Desk Top Publishing (DTP), Although laser printers are costlier than dot 
matrix, they are generally preferred in all offices due to their best quality of 
printing. There are many models of laser printers depending upon the speed 
and number of dots printed. The latest model of laser printer is 1200 DPI 
(Dots Per Inch), which can print 10 pages/minute. Some high speed laser 
printers give a speed ofupto 100 pages/minute. 

(b) Inkjet Printers: These printers print the characters by spraying the paper with 
electrically charged ink. These printers give better quality than character 
printers but not better than laser printers. They are cheaper than laser printers, 
hence used widely in many offices. They also offer an option of using color 
cartridges for multi~color printing. 

(c) Them1a/ Printer:s: These printers print the characters by melting a waxbased 
ink off a ribbon onto a special heat sensitive paper. They give letter-quality 
printing but are relatively expensive in maintenance than other printers. 

Plotter 

Plotter is ah important output device, used to print high quality graphics and drawings. 
Although the graphics can be printed on printers, the resolution of such printing is 
limited on printers. Plotters are generally used for printing/drawing graphical images 
sucb as charts, drawings, maps etc. of e,.19t1eering and sc.ientific applications. Some 
important types of plotters are discussed below: 

(a) Flatbed Plotters: These plotters print the graphical images by moving the pen on 
stationary fl.at surface material They produce very accurate drawings. 

(b) Drum Plotters: These plotters print the graphical images by moving both the pen 
and the drum having paper. They do not produce as accurat~ drawings as printed 
by flat bed plotters, 

( c) Inkjet P/otte.rs: These plotters use ink jets in place of pens. They are faster than 
flatbed plotters and can print multi-colored large drawings. 

Computer Output Microfilm 

Computer Output Microfilm (COM) is a technique to produce output on a microfilm 
media (microfilm reel or microfiche card) as illustrated in Figure 1.9. A microfilm is a 
continuous film strip that can store several thousands miniaturized docwnent pages. A 
microfiche card is a 4 by 6 inch film sheet, which can store several hundred pages. 

INVNO DAT.EAMT 
lOOIOl/01/99100.00 
I 0020 I /02/99124 .50 

Figure. 1.9: Computer Output/Microfilm 



The process of producing microfilm or microfiche takes place on a special COM urut. 
The information recorded on the microfilm is read with the help of a microfilm 
viewing system. It is generally easier to read a microfiche than microfilm. Computer 
Output Microfilm is particularly useful for organizations which need to store and 
manipulate large amount of data. It helps them in tremendous savings in paper and 
document handling costs. 

Storage Devices 

Io preceding part of this unit, we have discussed about , the primary memory of 
computer. Primary memory (especially RAM) stores the data, instructions and 
informations temporarily during processing by CPU. When computer is switched off, 
this memory gets erased.. How does a computer store the data, information and 
software permanently, so that they can be retrieved whenever required? Certainly, 
there must be some storage devices in computer. Now, we will discuss about different 
Storage Devices, sometimes also called as Secondary Memory Devices. 

liud Diak Drive 

Magnetic Optical 
(MO)Dislc 

Floppy Disk Drives (3.5'' & S.2S") CDROMDrivc 

Figure 1.10: Common Storage Devices 

There are many storage devices used with microcomputers. Some of the common 
storage devices are explained below and shown in Figure 1.10. 

1. Winchester Disk (Hard Disk): Winchester Disk is the most common storage 
device of present day microcomputers. It is popularly called as Hard Disk Drive 
(HDD) or sometimes as Fixed Disk Drive. It is fixed inside the computer and is 
not easily removable. lt is used for storing the software and data inside computer. 
It is known as 'Winchester Disk', probably because this drive was first made by 
IBM at Hursley Laboratory, located near Winchester in England. 

Winchester Disk consists of one or more disk platters, an access mechanism and 
read/write heads which are sealed in a case. Hard disk size depends upon the disk 
platter!s diameter. There are many different platter sizes (such as 5½, 3½, 2½ inch 
etc.). The 3½ inch size platter is common with PCs and 2½ inch with 
l~ptop/portable computers. Read/write head is used to write any information on 
the disk surface or to read it back. 

There are different types of hard disks depending upon their storage capacities. 
Storage capacities of hard disks range from IO MB to 6.3 GB, but 4.3 GB are 
nowadays a common part of Pentium computers. 

2. Floppy Disk: Floppy Disk (FD) is another common storage device which is small,_ 
flexible and easily removable. It is made of a plastic disk coated with magnetic 
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material, which is sealed inside a square plastic jacket. It is called as 'Floppy' 
because it is soft having flexible physical property. Data can be written on or read 
from this floppy by a drive, called: Floppy Disk Drive (FDD), which is fixed 
inside the computer. 

Table 1.3: Comparison among Different Types of Floppies 

Type of Floppy Size Density Sectors Tracks Storage Capacity 

DSDD* S.25 inch Double 9 40 360K 

OSLO* 3.5 inob Low 9 80 720K 

DSHD* Big S.2S inch High IS 80 1.2MB 

DSHD Small 3.5 inch High 18 80 I .44 MB ·. -
' •os stands for Double Sided, LO fur Low Density and HD for High Density 

There are many types of floppies depending upon their sizes and storage 
capacities as illustrated in Table 1,3. The original floppy, developed by IBM, is an 
8" floppy, but the most popular sizes available for present day PCs are 5¼" and 
3½''. The storage capacity of floppies vary from 360 KB to 1.44 MB. The floppies 
can store data on both sides (Double-sided Floppies) or on single side (Single­
sided Floppies) depending upon the floppy drive. Double sided floppy drives are 
most frequently used in present day PCs. The latest floppy drive, that packs two 
high density floppy drives (5.25 & 3.5 inch) into a single package, is known as 
Combo Drive. 

3. Compact Disk: Compact Disk (CD) is the latest storage device, used to store data, 
information and software, which can be read only and not be changed or erased. It 
is an optical read only memory, made up .:>fa resin. Therefore~ it is actuaJly caUed 
as Compact Disk Read Only Memory (CD-ROM). However, the information is 
stored on CDs by using an expensive drive, called CD-ROM drive. 

Nowadays compact disks are very popular storage devices for microcomputers 
because a large number of software including multimedia, audio and graphics 
software are available only on these disks. Compact Disks can store a large 
volume of data (upto 680 MB), which is almost same a storage capacity of 630 
MB Hard Disk. 

WORM (Write Once Read Many) is a type of compact disk which can be 
recorded only once and not erased. It can store more data than CD-ROM, 
generally measured in gigabytes. 

I 

4. Magnetic Tape: Magnetic tape is the oldest storage device available for 
microcomputers. It is generally used to store a large volume of data that is needed 
to be sequentially accessed and processed. The tape is made up of a plastic ribbon 
coated with an iron-oxide material, which can be magnetized. The data stored on 
tape can be read as well as erased and written again. 

Magnetic tape is a sequential access storage device, hence it is not possible to read 
the data randomly or directly. Therefore, magnetic tapes are suitable only for 
storing data for backups and batch mode applications and not for on-line 
applications. On the other hand, magnetic disks (floppy and hard disks), which are 
discussed above, are considered best storage devices for on-line applications. 

5. Video Disk: Video disk is used to store text, video and audio data. It is widely 
used for training applications as it can be played like a phonograph record. 

6. Magneto Optical Drive: Magneto Optical {MO) drive is the latest of all storage 
devices. This drive uses both a laser and an electromagnet to record data on a 
removable cartridge. The surface of the cartridge contains tiny embedded magnets 
The unique feature of MO drive is that it has a very high storage capacity. 



Although MO drive is costlier and slower than HDD, it has a long lffe and is more 
reliable. 

7. DVD ROM/RAM Disk: DVD ROM and DVD RAM disks are optical disks 
having a storage capacity of 4.7 GB and 5.2 GB respectively. These disks are 
becoming the next generation's new standard for higher capacity removable 
media. They are ideal for storage of huge amount of information required for 
multimedia applications. One can put 133 minutes of high quality of video with 
digital sound on a DVD RAM Disk. 

Cards 

Cards are the printed circuit boards used to hold the chips (integrated circuits). There 
are many types of cards used in PC, the important ones are Video Card, Sound Card, 
I/O Card, Controller Card and Memory Card. Video card (Display Card) generates the 
text and graphic images for monitor while sound card generates the sound. Pentium 
computers, generally, use a PCI (Peripheral Component Interconnect) video card to 
speed up graphics. I/O Card provides a place for connecting mouse and printer. Cables 
of hard disk and floppy disk are connected to controller cards. Memory Card provides 
a place for memory chips. 

Ports and Cords 

Besides the important hardware discussed above, the computer has several 
components which are used as pathway for flow of data. The rear of a PC has many 
empty holes or external sockets called ports or connectors. There are many types of 
ports in a PC, the most important ones are Serial Port, Parallel Port, Game Port and 
Video Port. Serial Port is used to connect a mouse, modem or scanner. Parallel Port is 
generally used to connect a printer. Game Port is used to connect the joystick while 
Video Port is a connector for monitor. 

Cords are the cables used to plug into the ports. There are different types of cables for 
connecting different types of input, output and storage devices. The important cords 
used in a PC are keyboard cords, power cords, monitor cords and printer cords. 

Power Supply 

Power supply is considered as the 'Heart' of a Pc. Computer requires a clean and 
steady power source for working properly. Power supply is that important hardware, 
which provides the power source to a computer. It provides a voltage range of 4.95 to 
5.25 volts for the highest performance of the system. Powe.i: supplies vary in size and 
power (in watt). · 

1.10.2 Classification of Software 

Software are broadly classified into following two types: 

(a) System Software 

(b) Application Software 

System Software 

Software, which are required to control the working of hardware and aid in effective 
execution of a general user's applications are called system software. These software 
perform a variety of functions like file editing, storage management, resource 
accounting, I/O management, database management, etc. Some of the examples of 
system software are DOS (Disk Operating System), Windows, BASIC, COBOL and 
PC TOOLS·. These software are developed by System Programmers. 
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System software can be further categorized into following three types: 

(a) System Management Software 

(Operating Systems, DBMS, Operating Environments) 

(b) System Development S9ftware 

(Language Translators, Application Generators, CASE Tools) 

(c) System Software Utilities 

Application Software 

Software wbich are required for general and special purpose applications like database 
management, word processing, accounting etc. are called as application software. 
Some of the examples of application software are dBASE, Word Star, Tally etc. 
Application software are developed using system software by Application 
Programmers. 

(a) General Purpose Application Software 

(Database Management Packages, Word Processors, Spreadsheets, Office 
Automation Packages) 

(b) Special Purpose Application Software 

(Desktop Publishing, Multimedia, Business Applications) 

1.11 THE COMPUTER GENERATIONS 

In recent years, the computer industry has grown at a phenomenal pace. In a short 
time of 35 years or so., computers have improved tremendously. In the last decade the 
speed of computer has increased 200 times. Not only that the reliability curve has also 
taken a sharp increase. The cost per unit of calculating has gone down by 500 times. 
The storage capacity is increasing so fast that now it seems that nothing is impossible 
to store. Large data can be stored in very small devices. 

The term ''generations" was initially introduced to distinguish between different 
hardware technologies. Gradually it shifted to both hardware and softw;ire as the total 
systems consists of both of them. 

The computers can be divided in five past generations, i.e, depending upon the 
technologies used. The five generatfons of computer are: 

1.11. l First Generation (1942 - 1955) 

Until 1951, electronics computers were the exclusive possession of scientists and the 
military. Till then nobody tried to use them for business purpose. The idea of 
marketing them was concei"Ved by Mauchly and Eckert, creatots of ENIAC's. As US 
census bureau was already using IBCP cards, they were the pioneers in buying this 
computer for the first time in 1951. The company created by M and ETS became 
UNIV AC division of Sperry and Corporation (later known as UNISYS). 

The bringing of first UNIV AC (Universal automatic computers) general purpose 
electric cligital computer, marks the beginning of ~he first generation of electronic 
computers. 

These computers used valves and all the components were joined by copper wires. 
Due to large size of the components and due to the facts that the components had to be 
spaced apart as the valves dissipated a lot of heat, the computers were very bulky and 
required huge electric power, airconditioners, maintenance and space for their 
installation. Further, the speed of operation was very slow and had a very low 
reliability factor as vacuum tubes failed frequently. They were sti11 given the name of 
~'electronic brains" by the journalist. They also said that these electronic brains will 



change the world one-day. Later IBM corporation developed IBM 70 I, IBM 702 and 
IBM 650 and few oilier systems. These were called the first generation computers. 
The popular brand of first generation computer was IBM 650, which had a magnetic 
drum memory and utilized punch cards for input and output. This type of computer 
was of an intermediate size and was designed to meet the requirements of business 
and scientific applications. The available memories ranged from a few hundred 
thousand words of main storage. The cycle time was of the order of few milli seconds. 
It was only after 1957 that magnetic tapes were introduced as a faster and convenient 
storage medium. A single tape could bold approximately 1100 P cards (i.e. about 2 
pages of information). 

IBM made 19 IBM . 70 I computers and at that time industry felt that these 19 
computers are sufficient enough to take care of American business. These computer 
required special facilities and highly trained personnel. 

The ihStructions given to FGC were in machine language (i.e. O's and 1 's). As the 
language was tough and understood by very few people. There were very few 
personnel available for it. 

Computer belonging to this generation had the following characteristics: 

• Comparatively large in size as compared to present day computers. 

• Generated lot of 9eat, they were not consistent and reliable as the valves tended to 
fail frequently. 

• Low capacity internal storage, 

• Individual, non-related models. 

• Processors operated in the milliseconds speed range. 

• lotemal storage consisted of magnetic drum and delay lines. 

1.11.2 Second Generation (1955-1964) 

FGC were very umeliable, mainly because of vacuwn tubes which kept on burning 
out. Users had to be prepared all the time with dozen of extra tubes to replace them. 
The computers of this generation were characterized by the use of Solid State devices 
(transistors) instead of vacuum tubes. Transistorized circuits were smaJler, generated 
little heat, were less expensive and consumed less power than vacuum tube circuits 
and were much greater in processing capacity. Since transistors had a faster switching 
action, this generation computers were significantly faster and smaller and were more 
reliable too than first generation computers. The use of magnetic cores as the primary 
internal storage medium and the introduction of removable magnetic disc pack were 
other major developments of the second generation. Although magnetic tapes were 
still used commonly. These computers bad built in error detecting devices and more 
efficient means were developed to input and retrieve from the computer. They were 
easier to work with. More efficient programming methods and higher level languages 
_like FORTRAN and COBOL become available. It was easily understandable by 
people especially because no codes (like Assembly language) had to be remembered 
by the programers. Moreover unlike Assembly language the high level language were 
not machine specific i.e. same set of programs could be used on computers produced 
by different manufactures. The instruction cycle time dropped from several hundred 
microseconds of the first generation in tens of micro- seconds of the second 
generation. The main memory in these systems could store several hundred thousand 
words. 

This generation of computers could communicate with others using telephone lines. 
Transmission m 1.\ata from one computer to another was possible in this generation of 
computers. Although the processing was very slow but the idea was convenient which 
was further devekped in next generations. The problems which second-generation 
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computer faced was that input and output devices were too slow. The projects started 
in second generation to solve these problems. They used second generation 
technology_ but finally proposed results in third generation. 

Dr Daniel Slotnick worked out first solution. He was working with Burroughs 
Corporation, at that time. He designed a computer for the US department of Defence 
and tried to solve the problem of machines sitting idle waiting for input and output. 
The computer known as ILLIAC IV was developed. lt has 4 control units and thus 
was able to perform input/output and processing (mathematical operation) at the same 
time. Slotnick was granted a patent for "Parallel Processing". They were also called as 
first super computer. The second super computer was proposed by MIT 
(Massachusetts Institute of Technology) by a group of students and professors. The 
name of the project was MAC (Multiple Access Computer) and concept of 
multiprogramming was developed there. The system could process the programs 
concurrently which were TWl by different users. 

Sotne of the popular models in this generation of computer systems, we IBM-140 I, 
IBM-1620, BURROUGHS, B-200 SERIES, HONEY-WELL H-400, NATIONAL 
CASH REGISTER NCR-315, 500 AND UNTVAC-1004. Many of these computers 
were used for business applications. 

Compute.-s of this generation had the following characteristics: 

• Smaller in size compared to tne first generation computers. 

• Generated a lower level of heat, as components were much smaller. 

• Greater degree of reliability because of solid state technology. 

• Higher capacity of internal storage. 

• Use of core storage instead of magnetic drum and delay lines. 

• Related series of processors -the family concept. 

• Processor operated in the microsecond speed. 

• High cost direct accesses storage. 

1.11.3 Third Generation (1964 - 1975) 

A revolution in the computer developments took place with the · development of 
Integrated Circuits (IC) on a single silicon chip. In 1958, Jack St Clair Kelby and 
Robert Noyce invented the first IC. IC incorporated number of transistors and 

--electronic circuits on a single wafer or chip of silicon. IC is called chip because of the 
w.ay they are made. They are also called as semi conductors as combining layers of 
materials that have varying capacity to conduct electricity form tbem._Tbis ushered in 
the third generation of computer systems in 1964. The integrated circuits enhanced 
considerably the processing capability and the ~peed of the computer. During the 
period 1964 to 1970, capability of placing 12 or more logic gates on a single chip was 
developed into a well-defined techoology of Small-Scale Integration (SSI). A logic 
gate is a circuit to perform arithmetic of addition, subtraction, multiplication or 
division. In 1970 this technology was redefined to a point where hundreds or more 
gates could be placed on a chip of silicon and incorporated as functional logic block in 
an overall system. This technology was termed as Middle Scale Integration (MSI). 
There was intense pressure on the semiconductor manufacturer to provide greater 
densities of gates on a single integrated circuit chip. Consequently more complex 
chips were developed with the ultimate goal of obtaining a central processor on a 
single physical circuits element. These circuits had higher reliability and lower power 
consumption and substantially reduced size. Component densitjes of 1,000 to 10,000 
gates on a single silicon chip became possible. The technology consisting of 1,000 
gates per chip, termed Large-Scale lntegration (LSI), started to become commercially 
viable in 1975. The later technology consisting of IT'.on than I 0,000 gates per chip is 



called Very Large Scale Integration (VLSI) or Grand Scale Integration (GSI). These 
circuit became very useful in assembling computers. Some of the popular third 
generation computers are-IBM-360, series, IBM-370 series and TCL-2900 series. The 
large advanced computer systems are usually called 'Main Frame'. 

Integrated circuits technology is responsible for bringing in revolution in the computer 
industries. Scientists were aware that more powerful computers can be built by 
building more complex circuits, but as these circwts had to be wired by hand, these 
computer were too complex and expensive. IC solved this problem by introducing a 
computer that costed lower then first generation computer and offered more memory 
and faster processing. 

In 1962, a new company built a plant in "Silicon Valley", near Sanjose, California. 
DEC (Digital Equipment Corporatioaj revolutionised the total computer industry with 
this computer which used IC's. 

The first commercially available minicomputer was introduced in 1965. The PDB-8 
(Programmed Data Processor) could fit easily in the comer of a room and did not 
require any attendant to it. The computer could be accessed by number qf users from 
different locations of the building. (That was actually implementing time-sharing, 
which was developed in second generation). The price was one tenth of the traditional 
main frame, which made it possible for smaller companies to afford. 

IBM was dominant in the market by releasing 360 series of computer. They were of 
different sizes of main frame computers. The main advantage of using this computer 
was use of same machine language compatibility thus making it easy and cost 
effective specially when upgraded. 

By 1967, IBM decided to change its track as number of programming language came 
in the market. This was the beginning of software industry as the languages grew and 
people who had the skills to translate user requirements in these languages were high 
on demand now. 

One mo.re technology development which loo_k place now was the launching of first 
telecommunications satellite. The communication stations on the earth were now in a 
position to send and receive data by means of satellite enabling communications 

. between the computer systems around the world. 

Admiral Grace Nurray Hopper, also known as "the mother of COBOL" and "Amazing · 
Gi:ace'' was sent to Harvard to work on the first large scale digital computer. She 
travelled to various computer conferences and gave lectures in various colleges about 
the data processing insights. She wrote more than 50 papers and articles on software 
and programming language. 

Dr Hopper tells about the origin of Bug and Debug in her book "understanding 
computers" . It was 1945, when students were working on Mark 11 and it stopped 
working. Programmers kept trying to figure out what's wrong with the compute!, 
finally discovered that there was a moth caught .in one of the relays causing the whole 
trouble. They removed it and the computer ~tarted v.:orking fine. There the tenns 
"Bug" and "Debug" were introduced. The first bug can still be seen taped on a page in 
a logbook at the Naval Weapons Museum in Dahlgren, Virginia. 

Computers of this generation have the following characteristics: 

• Smaller in size as compared to second generation computers. 

• Higher capacity internal storage. 

• Remote communication facilities. 

• Multiprogramming facilities. 

• Reduced cost of direct access storage. 
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• Processors, which operate in nanosecond speed range. 

• Ranges of computers with a common architecture whereby models were upward 
compatible. 

• Use of high level languages such as COBOL. 

• Wide range of optional peripherals. 

1.11.4 Fourth Generation (1975- 1989) 

The 1970's marked the beginni.n,g of a new generation of computers, produced by 
computer giants like IBM, ICL, NCR and Burrought. From design viewpoint, the new 
generation provided increased input-output capability, longer component life as well 
as greater system reliability. From the functional view point, new powerful language 
were devoloped to broaden the use of multiprogramming and multiprocessing and 
major shift from batch processing to on line, remote interactive processing. 

The development of microprocessor chip, which contains an entire Central Processing 
Unit (CPU) on a single silicon chip led to the mushroom growth of inexpensive 
computers. They are not computers by themselves but they can perfonn all the 
functions of arithmetic logic unit and control units of the CPU. When these 
microprocessors are connected with memory and input-output d~vices, they become 
microcomputers. The semiconductor memories are also very small and very cheap. 
There are seveFal types of memory chips. Three of the most commonly used are: 
(a) Random Access Memory (RAM) in which data can be read or written 
corresponding to the main memory of the conventional computer, (b) Read Only 
Memory (ROM) and (c) Programmable Read Only Memory (PROM). In the ROM 
chips, the data-is 'burnt' into the chip at the manufactwing time. It cannot be changed. 
These chips are used in systems where the data need not to be changed. Even when 
power supply fails, the data remains in the memory. 1n case of PROM a user can 
program and even correct the data if necessary. The fourth generation of computers 
may be called microcomputer generation. The input-output devices used with the 
fourth generation computers are quite advanced. Among the advanced input-output 
devices employed in fourth generation computers are optical readers by which whole 
dqcuments can be led into the computer, audio response terminals by which an 
operator can vocally introduce data or instructions and graphic display terminals by 
which an operator can feed pictures into the computer. 

The use of very large integrated circujts (VLSI) has made the fourth generation 
(micro) computers very compact, much less expensive, faster, more reliable and of 
much greater data processing capacity than equalized third generation computers. 

Some computers belonging to fourth generation are DEC-10, STAR-1000, PDP-11 
and APPLE Series Personal Computers. 

1.11.5 Fiftb Generation (1989-Present) 

Till fourth generation of compute.rs, the major stress was on improving the hardware 
from valves to transistors and then to integrated circuits, which resulted in 
miniaturization and fast speed of computers. However, the lack of thinking power has 
forced the scientists to work further for fifth generation computers. The concept of 
"Artificial Intelligence" is being used in these computers and Japanese call them 
"Knowledge Processors" . Automatic programming, computational Logic, pattern 
recognition and control of robots, the processes and which need skill and intelligence 
are examples of Artificial Intelligence. These computers, when developed, will be 
able to execute billions of instructions per second and will have unimaginable storage 
capacities. The present day high level languages wiJI become obsolete on these 
machines and new computer languages and related software will be. needed. 



The fifth generation gives the highest priority to making systems that are easy and 
natural to use. Its other objective relates to the types of technological support needed 
to support ''problem solving systems" according to the fifth generation committee. "In 
these systems", the Committee adds," Intelligence will be' greatly improved to 
approach that of a human being. When compared to conventional systems, the man -
machine interface will be closer to that of human behaviour." The fifth generation has 
three functional requirements: 

• Easy to use computers with hjgb intelligence and natural hwnan input and output 
mechanism; 

• Reliable and efficient software development by new languages, new computer 
architectures and systems software which overcome previous problems; and 

• lmproved overall functions and performance aimed at making computers smaUer, 
lighter, faster, of greater capacity, more flexible and more reliable. 

Jt is these objectives which set the main themes for the future of computing, whatever 
techniques are used to achieve them. 

1.12 COMPUTER LANGUAGES 

One man communicates with another in a language, which another man can 
understand. Similarly, man communicates with computer in a language, which 
machine can understand. Th.is language which consists of a set of commands, 
understandable by computer directly or after translating, is known as Computer 
Programming Language. There are many types of computer languages, wnich can be 
categorized into following four types: 

l. Low-level Languages (First and Second Generation Languages); 

2. High-level Languages (Third Generation Languages); 

3. User-Friendly Languages (Fourth Generation Languages); 

4. Object Oriented Languages (Fifth Generation Languages). 

J. Low-level Langllages: ln early days of computers, only those languages were 
used for programming, which could be directly executed on c.omputer, Languages, 
which computer can understand directly and are machine dependent, are called 
]ow-level languages. For example, Mach.i.ne Language and Assembly Language 
are two important low-level Languages. Machine language is the oldest and most 
difficult of all the languages. lt is also known as First Generation Language. In 
machine language1 all the instructions a,re given to comp-utet in binary digits, and 1 
hence are directly understood by the computer. On the other hand, assembly 
Language is easier than machine language, and is known as Second Generation 
Language. In assembly language, instructions are given using mnemonic 
operation· codes (such as ADD, MUL etc.) instead of binary digits. 

Low-level languages are used for development of system software. As they are 
not used for applications development, managers or applicatfon programmers do 
not need to learn these languages. 

2. High-level Langllages: Development of applications using low level languages 
requires a deep understanding of the hardware. In order to facilitate the 
programmers to write programs without knowing the internal details of computer 
components, many languages were developed. These languages use common 
English word~ and are translated into low-level languages before processing by 
the computer. These languages which computer cannot understand directly and 
are · not machine dependent, are called Higb~Level Languages (HLL). These 
languages are also known as Third Generation Languages. Some of the common 
high-levei languages are: 
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(a) BASIC (Beginners AJI Purpose Symbolic Instruction Code); 

(b) COBOL (Common Business Oriented Language); 

(c) FORTRAN (Formula Translator); 

( d) PASCAL (Name of a Scien~ist); 

(e) C (it does not stand for anything). 

These languages were widely used for applications development, but most of 
them are outdated nowadays due to popularization of 40Ls. The uses of different 
30Ls are summarized in Table 1.4. 

TabJe 1.4; Uses of 3GLs (Third Generation Languages) 

Language Uses 

BASIC (Beginner's All Purpose Graphics Used for all purposes (Commercial, Scientific, 
Symbolic .Instruction. Code) .Educational, etc.) by beginners. 

COBOL (Common Busim:ss Oriented Mainly .used for development of commercial 
Language) applicatio1,1.s on all types Computers. 

FORTRAN (Formula Translator.) Used for. development of scientific (mathematical) 
applications. 

PASCAL (Name of a Scientist) Used for both commercial and scientific 
applications . 

C (No fuU fonn) Very powerful language for development of both 
system and applfoation software. 

3. User-friendly Languages: Although high-level languages are sin;tpler to codify 
than low-level languages, they still require a lot of time to learn their 
programrriing syi:itax. Hence, these languages are beyond the reach of many 
computer users (including MIS professionals), who do not want expertise in 
programming. Therefore, a new categozy of languages have been developed 
which are user-fi:iendly, very easy to codify and simplest to learn. These 
languages are called as User-fi:iendly Languages and popularly known as 4GLs 
(Fourth Generation Languages). Some of the common 4GLs are dBASE, Foxba_se, 
Foxpro, MS Access, Oracle, Sybase and [ngres. The uses of different 4GLs are 
summarized in Table 1.5. 

4. Object-oriented Languages: We have discussed that the object-oriented 
programming is the latest approach in programming. The languages which are 
based on Object-Oriented Programming (OOP) approach, are called as Object 
Oriented Languages. They may be classified into Fifth Generation Languages. 
Object Oriented Languages are specially useful for development of GUI 
(Graphical User Interface) applications. These languages also offer a unique 
feature of Reusable Code. Some of the popular obje,t-oriented languages are 
Smalltalk, C-H- and Object COBOL, Object Pascal, Simula, Eiffel, Java & Visual 
J++. C++ and Visual J++ are widely'used nowadays for development ofwindows­
based applications. The uses of different object-oriented languages are 
summarized in Table t.6. 

Table l .S: Uses of 4GLs (Fourth Generation Languages) 

Language Uses 
dBASE Used for development of mainly single user DOS based database appliactions. 

Foxbase Used for development of both single and multiuser DOS pased database applications. 

Foxpro Used for development of both DOS and Windows based database applications. 

Oracle Used for development of relational database applications on any operating enviro1)IDent. 

Sybase · Mainly used for development of on-line applications such as Decision Support Systems 
and Transaction Proce~ iog. 

Ingres Used for development of relational database applications of VAX/UNIX operating 
System. 



Table 1.6: Uses of Object Oriented Languages (Fifth Generation Languages) 

Language Uses 

Smalltalk Used for development of mainly graphical applications. 

C-++ Use.cl for development of all types of object oriented applications. 

Object COBOL Used for development of object oriented applications on mainframe computer. 

Object PASCAL Used for general object oriente.d applications. 

Simula Mainly used in resea:ch environment. 

Eiffel Used for general object oriented applications. · 

Visual J++ Very popular for development of Windows based appli1:ations. 

Nottis: There are Cllrtain languages whic.11 support most of the feature5 of object-oriented programming except 
inheritanC<?. These languages are not pure object-oriented languages and are known as object-based Jan1uages. For 
example, Ada, a higb level language designed for process coottol, is an object-based language. 

1.13 LANGUAGE TRANSLATORS 

Regardless of the programming language used (except machine language), the 
symbolic instructiods ·have to be translated into a form, that can be executed by . 
-computer. The software, which convert the codes of other languages into machine 
code, are collectively called as Language Translators. 

Types of Language Translators 

Language Translators are categorized into three types: 

(a) Assemblers: Assemblers translate the assembly language code (source program) 
into machine language code (object program). After assembling, a linker program 
is used to convert the object program into an executable program. The Microsoft 
Assembler Program (MASM) and Borland Turbo Assembler Program (T ASM) 
are two popular assemblecs. Assemblers are used mainly in development of 
system software. 

(b) Interpreters: Instructions of a high-level language are coded in many statements. 
At the time of their execution, they are converted into machine code statement by 
statement, by using system software, called Interpreters. For example, programs 
written in BASIC language are executed by using BASIC A or GWBAS[C 
interpreters. Programs written in some fourth generation languages, like d.BASE 
III plus are also executed using d.BASE. interpreter. There are certain 
disadvantages of interpreters. As instructions are translated and executed 
simultaneously using interpreters, they are very slow for executing large 
programs. Hence, interpreters are not suitable for most of applications 
development. 

(c) Compilers: In contrast to interpreters, compilers provide faster execution speed. 
Compilc;rs do not translate and el!:ecute the instructions at the same Time. They 
translate the entire program (source code) into machine code (object code). Using 
linker, the object code is converted into executable code. Compilers are widely 
used in translating_ codes of high l!=vel l!i.flguages (e.g. CO.SOL, FORTRAN, 
PASCAL, Turbo/ Quick BASIC, Turbo/Microsoft C etc.) and fourth generation 
languages (d.BASE IV, Foxpro etc.). As compared to interpreters or assemblers, 
they are preferred in development of application software: 
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Differentiate between Interpreters and Compiler 

Difference between compiler and interpreters are summarized below: 

Table 1.7 

Interpreter Compiler 

Translation into machine code One line at a time Entire program at a time 

Source tile required Yes No 

Speed of execution Slow Fast 

Linker needed No Yes 

Execution environment Operating system and Operating system only 
Interpreter 

Dependence Machine Machine dependent 

.independtnt 

Frequency of translation Each time of execution Only once -

I. UNIV AC stands for 

2. IBM Stands for 

3. VLSI stands for 

4. COBOL stands for 

1.14 LET US SUM UP 

A computer is an electronic device that can perform a variety of operations according 
to the instructions given by the programmer/user and provides the desired infonnation 
as an output. Computers are fast, accurate, diligent, having high m~mory, but no 
intelligence. 

Computer are classified as general purpose or special purpose computers according to 
the purpose of their requirement According to the technology used, computers are 
classified as analog which are used for scientific and eng1neering application, digital 
which are considered as general purpose computers or hybrid computers. Which 
incorporate the technology of both analog and digital computers. According to their 
size, computer can be classified as super computer, mainframe computer, 
minicomputer and micro computer. 

The main components of computer are input/output units central processing unit and 
memory unit. Input unit is used to enter data and instructions into a computer. CPU 
perfonns all the processing of input data: Memory is used to store the data, 
instructions and information before during and after the processing by ALU, Output 
unit makes avajlable output to the users. 



'\ 

CPU consists of ALU (Arithmetic Logic Unit) which is responsible for all arithmetic 
and logical operations, CU (Control Unit) which controls the transfer of' data and 
instructions among other units of computer Registers, which are used to s:tore data, 
instructions and memory addresses when ALU performs arithmetic arnd logical 
operations, Buses which are used to transfer data between registers and clock which 
measures · and al locates a fixed time slot for processing each . and every micro 
operation. 

Memory is the internal storage area, which holds the data and instructions during 
processing. The three types of main memory or Internal memory are RAM (Random 
Access Memory), ROM (Read Only Memory) and CMOS (Complementary Metal 
Oxide Semiconductor Memory). 

Computers are used in business for data capturing in on-Jine as well as off-l]ine mode, 
for storage and retrieval of information, for output and for transmission. Offices are 
needed to be automated to reduce cost of administrative overhead and tc:i increase 
efficiency of office tasks and staff. The hardware components of microcomputer can 
be classified into motherboard, Input devices, output devices, storage devices, cards, 
ports and cords and power supply. Various Input devices are keyboard, mouse back 
ball, light pen, touch screen, Joy stick, digitizer, Scanner, Optical Mark Reader 
(OMR), Optical Character Reader (OCR) Bar Code Reader (BCR), Magnetic Ink 
Character Recognition (MICR) and voice input devices various output devic(is include 
monitor printer plotter and computer output micro file. Storage devices include hard 
disk, floppy disk, compact disk, Magnetic tape, video disk, Magneto optical drive, 
DVD ROM/RAM disk, etc. 

1.15 KEYWORDS 

ALU: Arithmetic Logic Unit of a computer which is used to perfonn aritb.Jnetic and 
logic operations. 

Asse,nbler: A program which translates an assembly language program to its machine 
language equivalent. 

Assembly Language: A low-leveJ language for programming a computer in which 
mnemonics are used to code operations and alphanumeric symbols are used for 
addresses. 

Cache Memory: A small high speed memory which is used to temporarily store a 
portion bf a program or data from the main memory. The processor retrieves 
instructions or data from the cache memory. Instruction and data caching i;peeds up 
computation. 

Chain Printer: A printer in which the characters to be printed are embossed on a 
chain or a band. The chain is fashioned as a loop and print heads are activate:d to print 
specified characters. 

Communication Channel: A medium through which (electric) signal are transmitted 
and received. 

Compiler: A system program to translate a high level language program to, machine 
language. 

Computer: This is a machine which executes an algorithm stored in its memory to 
process data fed to it and produces the required results. 

Control Bus: A set of wires used to transmit signals to control the ope:ration of 
various units of a computer. 

CPU: Central processing unit of a computer. It consists of circuits to perform 
arithmetic and logic and aJso has circuits to control and co-o(dinate the funclcioning of 
the memory and 1/0 units of a computer. 
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1.16 QUESTIONS FOR DISCUSSION 

l. What is tbe differ:ence between minicomputer and microcomputer? 

2. Write a short note on personal computer. 

3. Describe the architectural of computer system. 

4. State the basic units of computer. Name the submits that make up the CPU, and 
give the function of each of the units. 

5. What is the function of memory? What are its measuring units? 

6. What are characteristics of second generation computer? 

7. Describe fifth generation computers. 

8. What ate computer languages? Describe its ,various types. 

Check Your Progress: Model Answer 

I. Univer:sal automatic computers 

2. International business machine 

3. Very large scale integration 

4. Common object oriented language 
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2.0 AIMS AND OBJECTIVES 

After studying this lesson, you should be able to: 

• Explain personal computers in business 

• Describe software packages 

• Explain DOS 

• Identify windows operating system 

2.1 INTRODUCTION 

In this lesson, we are discussing all the important software concepts and· providing 
you the latest knowledge of all the software available in the market. Many types of 
software are available for various applications. The software development field is so 
advanced that day by day existing software are becoming outdated and new software 
are coming in the market. So we must get aware of the latest developments in the 
software industry. 

2.2 PERSONAL COMPUTERS IN BUSINESS 

Cpmputers have become a requirement in the business industry. Computers easily 
complete duties that are tedious and timely for humans. The b.usiness uses of 

• 
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computers are extensive. Although many of the computer duties are not irreplaceable, 
business has become dependent on their accuracy and timeliness. 

• Accounting: Business success is dependent upon accu_racy, Many businesses use 
accounting software and ledgering systems to ensure the accuracy of their 
financial status. 

• Customer Interaction: Computers now assist human call centers with answering 
customer questions, taking payments and providing general assistance. The 
automated voice systems are available with unrestricted hours and are always 
friendly. 

• Scheduling: Scheduling is of great importance to many businesses, especially 
businesses involved in manufacturing and deliveries. Scheduling systems allow 
businesses to ensure they a(e meeting their goals while being efficient. 

• Communication: Communication is most important in business, Computers 
provide businesses with a wide array of communication methods that include, but 
are not limited to, email, chat, web conferencing and VOIP. 

• Websites and Advertising: The combination of websites, advertising and 
marketing provide a swift means to vast business globalization. Websites make 
the company quickly available to everyone. 

The computer technology applied to infonnation system will effect the infonnation 
system in following ways: 

• Speed of processing and retrieval of data increases: Manual systems, howsoever 
well organized, often fail to match ; 'v..•, demand for infonnation for decision­
making. Compute.rs with its unbelievably fast computational capability and 
systematic storage of infonnation with random access facility provide relevant 
infonnation with minimum loss of time. 

• Scope of use of information system has expanded: The importance and utility of 
information system in business organisations is realized by most of the concerns, 
especially after the induction of computers for MIS development. Systems experts 
in business organisations developed areas and functions, where computerised MIS 
could be used to improve the working of the concern. This type of applications 
hitherto is not feasible under the manual system. It is now possible to use an 
online real-time system to provide information to various users sitting at a remote 
distance from a centrally located computer system. 

• Scope of analysis witkned: The use of computers can provide multiple type of 
information accurately and in no time to decision makers. Information provided 
by a computer equips an executive to carry out a thorough analysis of the 
problems and to arrive at the final decision. 

• Complexity of system design and operation increased: The need for highly 
processed and sophisticated information based on multitudes of variables has 
made the designing of the system quite complex. 

• Integrates the working of different information sub-system: A suitable structure 
of management infonnation system may be a federation of information sub­
system, viz., production, material, marketing, finance, engineering and personnel. 
Each of these sub-systems is required to provide information to support 
operational control, management control and strategic planning. Such infonnation 
may be made available from a common-data-base. The common data base meets 
out the information requirements of different information subsystems by utilizing 
the services of computers for storing, analyzing and providing the infonnaticn. 

• Increase the effectiveness of information systems: Prior to the use of computer 
technology for information purposes, it was difficult to provide the relevant 



information to business executives in time even after incurring huge expenses. 
The use of computer technology has overcome this problem. It is now possible to 
provide timely, accurate and desired infonnation for the purpose of deciston 
making. 

2.3 PC SOFTWARE PACKAGES 

Software packages includes operating systems, language processors, general purpose 
packages and special purpose packages 

Systems Software: Facilitates better utilization of system resources, including 

• Operating systems (e.g., MS-DOS; Windows; OS/2; MacOS; etc.) 

• Language processors (e.g., for C++, FORTRAN, COBOL, etc.) 

• General purpose, end-user packages 

Applications Software: Developed for specific application needs, including: . 

• Financial accounting 

• Payroll 

• Personnel management 

• Inventory· control 

• Geographical information systems (GIS) 

• Computer aided design (CAD) 

• Computer aided manufacture (CAM) 

Common Software: Th<t various common software's are: 

• Electronic spreadsheets 

• Data management systems 

• Integrated packages 

• Operations research 

• Statistical analysis 

• Project management 

• CAD/CAM 

• Computer-aided software engineering 

• Presentations 

• Word processing 

• Text processing 

• Desk-top publishing 

2.4 DISK OPERA TING SYSTEM 

An Operating System (OS) is an integrated set of specialized programs thit1t is used to 
control and manage the resources and overall operation of a computer system. It is a 
clas~ of software, which controls the execution of other programs. 

DOS is the most commonly used operating system. The full form of DOS is Disk 
Operating System It is a single user operating system which means that only one 
application can be made to run at one time. DOS provides a 'Platform' or an 
'Environment' which lets the application program to interact with CPU and 1/0 
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devices. Many application software requires DOS for running. The common among 
these are word processors like Wordstar, Professional write; spreadsheet programs 
like Lotus 123, VP Planner Plus; accounting software like TalJy, EX, etc. Each 
software package bas a specific command to get itself running on DOS. For example, 
in order to run the spreadsheet program, Lotus 123, you will have to enter 123 at the 
DOS prompt, DOS wi11 run Lotus 123 for you. On any application software shuts 
down, the control again has to come back to DOS and the DOS prompt can be seen 
again on the screen. Now, DOS is ready to accept more commands from you. 

MS DOS (Microsoft Disk Operating System), a product of Microsoft Corporation of 
USA, is the most popular operating system for PCs. Another operating system 
available in the market is the PC DOS, a product of IBM, which is almost similar to 
MS DOS. Whether you use MS DOS or PC DOS, the basic commands of DOS 
remains the same. 

2.4.1 Loading DOS 

Toe booting happens automatically when the computer is switched on, provided DOS 
is available to it. DOS can be present on both hard disk as well as the floppy disk. So, 
when the system is turned on, a search for DOS is done on floppy drive first. If it is 
not present on the floppy drive, the DOS is searched for on the bard disk. Thus, for 
booting to happen, the DOS must be present either on the floppy or on the hard disk. 
So, if DOS is not present on the hard disk. insert the floppy carrying DOS software in 
the A drive before switching on the system. If the system boots from floppy, the 
following prompt comes on the screen: 

A:\> 

where underscore character '- 1 indicates the cursor (blinking mark) of the screen_ 
However, if booting bas been done from the hard disk, then the following prompt will 
come: 

C:\> 

C:\> or A :\;> is the DOS Prompt. Looking at DOS Prompt, you can easily make out 
the currently active drive. 1f you want to -switch yourself over to the another drive, 
then simply type its drive letter after the prompt and hit the ~Enter> key as shown 
below: 

C:\>A: <Enter> 

A ;\;> 

Now again if you want to go back to the C drive, then type in C: and hit the <Enter> 
key. 

2.4.2 Files and Directories in DOS 

File is a collection of related information. Any kind of text, data or program that is 
entered, is stored in a file. Now, it is very essential to organize your files in an ordered 
manner. This makes file searoh easier otherwise, it can really be a difficult and time 
consuming job to search for a particular file out of the whole lot of files stored on the 
disk. An example oflibrary can make the explanation of the concept more clear. As 
you must have already observed, the books iri a library are put in big cabinets. Each 
cabinet is divided into many shelves and sub-shelves. Each shelve or sub-shelve 
contains books on a particular subject. So, the required book on a particular subject 
can be found out very easily without wasting much time and effort. 

On similar gr~mnds, all the files that are related to each other are clubbed at one place. 
This is known as a Directory Structure or simply a Directory. A directozy structure 
resembles an inverted tree. The main directory becomes the Root directory. The 
directories and files become the brancbes of this directory tree. Any number of files 



and directories can be added to it thus, making the tree grow big downwards. Let us 
take an example: 

Suppose we wish to store two kinds of files on our disk: ACCOUNT and EXPENSE; 
Further, we wish to keep two more kinds of files (say CASHSALE and CREDSALE) 
under ACCOUJ:,lT sub-directory. DOS can very much help you in organizing your 
files through directory structure which is shown in Figure 2.1. 

ROOT DIRECTORY 

ACCOUNT EXPENSE 
DIRECTORY DI.RECTORY 

CASHSALE CREDSALE 
DIRECTORY Df.R.ECTORY 

Figure 2.1: Example of Directory Structure 

It is clear from the figure that: 

1. On the top of the directory structure, there is a Root directory. This directory is 
always present and is shown by \(backslash) for referencing, Any fifo or directory 
that is created is always under the Root directory. 

2. EXPENSE is the sub-directory of the Root Directory. 

3. ACCOUNT is the parent directory of the directories CASHSALE and 
CREDSALE. It can also be said that the CASHSALE and CREDSALE are the 
sub-directories of the ACCOUNT directory. Thus, a directory under 111. directory is 
called a sub-directory. 

It can be cleatly seen that the files relating to a particular subject can bt: put under a 
directory. For example, all the files relating to expenses can be put unde:r EXPENSE 
sub-directory whereas all the files relating to cash sales can be stored w1der the sub­
directory CASHSALE. 

Referencing Files 

It's time to learn. as to how to locate a file? The directory structure shown in Figure 
2.2 has two sub-directories under the Root directory. The sub-directory EXPENSE has 
two files under it. 

Figure 2.2: Referencing Files • 

DOS allows you to go from one directory to another by following a ceirtain path. In 
the beginning, the user is always resident in the Root directory. While tr21velling from 
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one directory to another, certain rules have to be followed. A user cannot go directly 
from ACCOUNT sub-directory to EXPENSE sub-directory. To go from one sub­
directory to another, you have to first go to its parent directory or the Root. directory. 
Thus, for going from ACCOUNT sub-directory to EXPENSE subdirectory, you first 
have to go to Root directory. Similarly, for going from the file EAST.TXT to 
WEST.TXT, you have to go to the EXPENSE sub-directory first. Thus, in other 
words, while moving from one directory to another, you have to go to its parent 
directory first. 

Now, in order to reach out to the file WEST.TXT the following path has to be 
followed: 

C:\>Expense\ West.txt 

3 4 5 y 
2 

Here, 

is tbe drive name where the file is resident in; 

2 is the path which DOS talces to reach for a file ; 

• 3 is the <lirectory under the Root; 

4 is the primary name of the file that is to be accessed; and 

5 is the extension name of the same file. 

The backslash (\) has to be used for tracing out the path. The first backslash talces you 
to the Root directory. The subsequent backslashes separate the directories, sub­
directories and the filename that are given in the whole path. 

File Naming Conventions 

There are certain rules that have to be followed while gjviog names to your files. A 
file name has two part~ Primary Name and Extension (Secondary Name). A dot (.) 
separates a primary name from an ext.ension. Let as see the two parts of the file named 
DRAGON.TXT. 

DRAGON.TXT 

I I 
Primary Extension 
Name 

A primary name cannot have more than eight characters and an extension cannot have 
more than three characters. A file name having only the primary name and no 
extension is absolutely valid because it is optional to give an extension to a file name. 
An extension is generally given by the language or software used. For example, if you 
are entering a BASIC or PASCAL program, its file name would have extension BAS 
or PAS respectively. A file name can contain the following characters: 

I. An Al;>habet (A-Z) or (a-z) 

2. A number (0-9) 

3. Special characters such as: $, #, &, @, ! , %, (, ), -, { , } , " A, etc. 

except*,?, full stop(.) and space ( ). 

http:directo.ry
http:directo.ry
http:directo.ry
http:sub-directo.ry
http:directo.ry
http:subdirecto.ry
http:directo.ry
http:directo.ry
http:directo.ry
http:sub-directo.ry
http:sub-directo.ry
http:directo.ry


It is a good practice to give meaningful names to your files. However, no two files can 
have exactly the same name on the disk. Thus, a name given to a file on a disk bas to 
be unique. 

A look at a few valid and invalid file names: 

VALID INVALID 

MYHUNT MY BOOK.DOC 

Dragon.Txt B.R. Arora 

Uphill.up S?JAIN.BAS 

VIJAYA EXCELBOOKS 

Employee.Emp ANARAG.** 

157.IN VICKY.MEHTA 

The rules for naming a directory are the same as that of naming files. 

2.4.3 DOS Commands 

DOS offers a variety of commands to perform various functions. With the help of 
DOS commands, you can display the list of files and directories that are present on the 
disk, create new files and directories, remove unwanted files and directories and much 
more. DOS commands can be entered either in uppercase or lowercase letters. The 
format of a DOS command is called syntait. All DOS commands begin with command 
name. When DOS carries out the instructions given by you, it is called the execution 
of DOS command. Let us discuss some of the DOS comm.ands in detail. 

Directory Commands of DOS: The directory commands help you to create new 
directories and remove existing ones. They also allow you to travel from one directory 
to another. You can also view the listing of files and directories that are present on the 
disk. 

I. Displaying a List of Files on the Disk: DIR Command 

Thls particular DOS command helps you in displaying a list of files or directories that 
are present on hard disk as well as floppy disk. Thus, to see the contents of your hard 
disk, issue the following command: 

C\>DIR <Enter> 

The above command displays the primary name, extension and size of files in bytes. It 
also displays the date and time when the file was created or modified last. If you wish 
to view the contents of the floppy drive, then you first switch yourself to the floppy 
drive and then issue the DIR command as shown below: 

C\> A: <Enter> 

A:\>D.IR <Enter> 

Figure 2.2 shows two sub-directories ACCOUNT and EXPENSE. lf you wish to view 
the contents of the sub-directory EXPENSE, then issue the following command: 

C\>DIR \EXPENSE <Enter> 

Let us assume bat there is one more sub-directory by the name BUSINESS existing 
under EXPENS2. To view the contents of this sub-directory, issue the following 
command: 

C:\>DIR \EXPENSE\8USINESS <Enter> 
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If you have a large number of files on the disk, then on issuing, DIR command, the 
screen scrolls up and only a few file names are shown. In such a case, issue the 
following command: 

C:\>DIR/P <Enter> 

The above command will show the contents of the disk pagewi!ie or screenwise. Now, 
if you are interested only in seeing the file names, then issue the following command: 

C:\>DIR/W <Enter> 

The above command shows the names of files· and directories widthwise. So, in one 
line only five names of files and directories are shown. The other details like the size 
of file, the date and time of each file creation are not shown. The directories are 
shown in square ([D brackets. 

2. Making a Directory: MD Command 

In the earlier part of this unit, we discussed that all the related files should be clubbed 
at one place, called a directory or sub-directory. So, to club aU the related files under 
one bead, new directories and sub-directories have to be created. Let us create a new 
sub~directory by the name INCOME under the Root directory. 

The following command can achieve this: 

C:\>MD INCOME <Enter> 

where MD stands for Make Directory. Further, let us create another sub-directory by 
the name HOSPITAL under the sub-directory Income. 

C:\>MD INCOME\ROSPITAL <Enter> 

3. &moving a Directory: RD Command 

With tio:le, certain directories grow old and are no more needed. It is better to delete 
such directories because they can save us many precious bytes on the disk. So, let us 
delete the sub-directory HOSPITAL with the following command: 

C:\>RD INCOME\HOSPITAL <Enter> 

where RD stands for Remove Directory. 

A directory or a sub-directory has to be, essentially empty before removing it. For 
example, in order to remove the sub-directory HOSPITAL, there should not .be any 
directories and files under it So, you must first delete aU the files and remove all the 
sub-directories present under the sub-directory HOSPlT AL before removing it. 

4. Changing Directory: CD Command 

Let us again refer to the Figure 2.2. Suppose you are under the EXPENSE sub­
directory and you want to access the files or directories in the ACCOUNT sub­
directory. This would involve the changing of directory from EXPENSE to 
ACCOUNT. This will make the ACCOUNT directory active. The task of changing 
directories can be accomplished with the help of CD command. 

Look at the following example: 

C:\>CD ACCOUNT <Enter> 

where CD stands for Change Directory. 

Tb,e above command will take you to the sub-directory ACCOUNT a.s shown by the 
following prompt: 

C: \ACCOUNT> 



If you want to go to the sub-directory CASHSALE straight from the sub-directory 
EXPENSE, issue the following command: 

C:\>CD ACCOUNT\CASHSALE <Enter> 

After the above command, the following prompt will come: 

C:\ACCOUNT\CASHSALE> 

The command for going to the root directory from the above prompt is: 

C:\ACCOUNT\CASHSALE>CD\ <Enter> 

But, the command for going to the parent or previous directory (whether it is n 1r 
sub-directory) is: 

C: \ACCOUNT\ CASHSALE>CD .. <Enter> 

If you are in the sub-dir:ectory CASHSALE, the above command will take you to 
ACCOUNT sub-directory as shown below: 

C: \ACCOUNT> 

File Commands of DOS: DOS offers a number of file commands for performing 
various operations on your file like copying, deleting and renaming the files. 

I . Copying Files: The COPY Command 

At rimes, you may have to work on some other machine. So, this involves copying 
. files from one disk to anothec Copying of files can happen from bard disk to floppy or 
vice-versa. Files can also be copied onto the same disk with a different niame. The 
COPY command helps us to accomplish all these tasks. 

The syntax of the copy command is: 

COPY <Source drive>: (File spec 1) <Target drive>: (File spec 2) 

Where 

Source drive refers to the drive from where the file has to be copied. It can be 
A,B orC. 

'File Spec I' refers to the path from where the file that has to be copied. 

'Target drive' refers to the drive where the file is going to be copied. 

'File Spec 2' refers to the destination where the file is going to be copied. 

(a) Copying a file to another drive under the same name: A file can have the same 
name if it is stored on different disks. Thus, to eopy a file by the name SCENE 
from hard disk to floppy disk, issue the following command: 

C: \> COPY C:SCENE A:SCENE <Enter> 

As the file is copied from the active drive, then there is no need to specify the 
source drive in the above command. On similar grounds, if the file name remains 
unchanged then there is no need specify it after the target drive. Thus, the above 
command can also be given in the following way: 

-, 

C:\>COPY SCENE, A: <Enter> ' ' 

(b) Copying a file to another disk.under a different name: The name of the file can 
be changed very easily while copying. The following command copi~:s the file 
SCENE from the hard disk onto floppy disk by the name SERENE. 

' ·d \>COPY SCENE A:SERENE <Enter> 

(c) Copying a file with a new name on the same disk: The file can be copiied witb a 
different name and stored on the same disk. Proceeding with the above example, 
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let us save the file SCENE with a new name, SERENE and copy it onto the same 
disk. 

C:\>COPY SCENE SERENE <Enter> 

Once this command is executed, we have the same file under two different names, 
stored on the same disk. 

(d) Copying files from one directory to another: Suppose you have placed all your 
files under the root directory. Now, at later point of time, you wish to club all the 
related files at one place. This can be easily done. Create a directory and copy the 
required files from the root directory to this newly created directory. DOS allows 
you to copy files from one directory to another. 

Let us :a..:;sume that you have a file by the name NORTH.TXT in the root directory 
and you wish to copy this file in the newly created Area sub-directory. The 
following command will do this: 

C:\>COPY NORTH.TXT \AR.EA <Enter> 

Similarly, you can copy files from any directory to any other directory. DOS only 
needs the specification of full path from you. Let us copy a file OLD.TXT which 
exists wnder the sub-directory DAT A to the sub-directory INFO which is resident 
in the floppy disk. 

C:\>COPY DATA \OLD.TXT A:\INFO <Enter> 

2, Deleti,:,g Files: DEL Command 

With time, certain files grow· old which are no longer required. So, it is desirable to 
delete such files because unwanted files occupy precious space on the disk. Suppose 
there is a file on the hard disk by the name TRYPRG which is no longer required. The 
following command deletes thls file: 

C:\> DEL TRYPRG <Enter> 

If the fi le SALE.PRG exists on the floppy disk, first you go to the A: prompt and then 
delete the file as shown below: 

C:\>A: <Enter> 

A:\>DELTRYPRG <Enter> 

While deleting any file of a sub-directory, its full path should be given as illustrated in 
the following example. Let us assume that the TRY.PRG file exists under a 
subdirectory MANAGE on the bard disk. To delete this fi le-issue one of the following 
commands: 

C:\>DEL C:\MANAGE\ TRYPRG <Enter> 

OR 

C:\>DEL MANAGE\TRYPRG <Enter> 

You can also delete the IMT.PRG file by first changing to that sub-directory and then 
issuing the DEL command as given below: 

C:\>CD\MANAGE <Enter> C:\MANAGE>DEL TRY.PRG <Enter> 

3. Renaming Files: REN Command 

DOS allows you to give new names to your files. Assume that there is a file by the 
name OLD.TXT and now you wish to give a new name NEW.TXT to it. Carry out 
O!le of the following commands to get your work done. 

C:\>REN OLD.TXT NEW.TXT <Enter> 



OR 

C:\>REN DATA \'OLD.TXT NEW.TXT <Enter> 

The file OLD.TXT which resides under the sub-directory DATA now has a new name 
NEW.TXT. 

Wildcards 

Often you may need to do a similar kind of job on a number of files. If these files have 
something in common, then we can save the effort of performing repetitive job. So, 
these files can be referred collectively by using the wildcard facility provided by 
DOS. The use of wildcards in a DOS command gives greater flexibility when using 
similar type of file names. DOS offers two wildcards : ? and *. Each? can be replaced 
by exactly one character or none, if it is given at the end of the filename. As and when 
the? wildcard is specified in the middle of a filename, it has to necessarily match one 
character. The * wildcard can match eight or less characters in the primary name and 
three or less characters in the extension part. 

Let us take an example to make the concept of wildcards clear. Suppose the f lowing 
files are present onto your disk: 

Old.Txt INCOME. pro Alpha Page.in 

Go.Exe OLD! Dragon.Exe KOMAL 

Expense.prg. OLD20.bas Over.prg Annual. doc 

New. doc Zee.com Old.doc Paper. c:om 

The following commands illustrate the concept of wildcards: 

(a) If you wish to see all the files that start with the letter O and any exte0tsion. then 
give the following command: 

C:\>DIR O *.* <Enter> 

The above command will list the files OLD.TXT, OLD!, OVERPRG, OLD20 
and OLD.DOC 

(b) Now, let us copy all the files with any number of characters in the primary name 
and the extension EXE with the following cornmancl 

C:\>COPY *.EXE A: <Enter> 

The above command will copy the files GO.EXE and DRAGON.EXE onto the 
floppy disk. .. . 

(c) To delete all the files beginning with OL, having two'-more characters in the 
primary name and any extension, issue the followin,g cotnmand. 

C:\>DEL OL??* <Enter> 

With this command, the files OLD.TXT, OLD.DOC and OLD! are g<)ing to be 
deleted because these are the only files present on the disk which match the given 
wildcard pattern. The above command will not delete the files OVER.PRG and 
OLD20, because the former does not start with OL and the latter has .5 characters 
primary name. 

(d) Similarly, to copy all files starting with P and an extension comprising of two 
characters ending with N issue the following command: 

C:\>DEL P*.?N <Enter> 

This will delete the file P AGE.IN because this is the only file matching the given 
wildcard pattern. 
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(e) For copying all the files having primary name OLD and any extension from 
floppy to EXPENSE sub-directory of hard disk, issue the following command: 

A:\>COPY OLD.* C:\EXPENSE <Enter> 

The above command will copy only two files OLD.DOC and OLD.TXT. 

(f) To copy all the files with primary name anything and no extension from 
EXPENSE sub-directory of hard disk to floppy, issue the following command: 

C:\>COPY \EXPENSE\*. A: <Enter> 

The above command will copy .the files ALPHA, OLDl and KOMAL. 

(g\ 1lo delete all the files of floppy, issue the following command: 

A:\'•DEL *.* <Enter> · 

After giving the above command, the following message will come on the screen: 

Are you Sure (Y /N)? _ 

Press \'Y' if you really want to delete all files otherwise press any key. Never try the 
above command on root directory of hard disk, otherwise your most important DOS 
file COMMAND. COM will also be deleted and thereafter you will not be able to 
boot the.system from the hard disk Therefore, wildcards with DEL command should 
be used ~th great caution. 

Some More DOS Commands 

You have already been introduced to the directory and file commands of-DOS. Now, 
let us make ourselves familiar with other commonly used commands. 

1. Displaying and/or changing date: The DA TE Command 

DO~ allows you to show as well as change the current date once you are on the DOS 
protppt Issue the following command to see or change the today's date: 

C\ \>DATE <Enter> 

After issuing the above command the following screen appears: 

, Current date is Thu I 1-12-

Enter new date (mm-dd-yy):_ 

So, key in the new date in 'month-date-year' format. However if you do not want to 
change this date simply hit the <Enter> key. The current date will be taken as new 
date. 

2. Displaying and/or clrp.nging the current time: The TIME Command 

The TIME command is used to display and change the current time. 

C: \>, TIME <Enter> 

On issuing this command, the following screen appears: 

Current time is 11:05: 10:01 

Enter new time: 

Enter the new time in hows: minutes: seconds format. Hit the <Enter> key if you do 
not want to change the time. The new time can also be specified along with TIME 
command. 

3. Clearing screen: The CLS Command 

In order to clear the cluttered and clumsy screen, issue the CLS command. This will 
remove the contents shown on your screen thus making it look neater and cleaner. The 
CLS command is given in the following manner. 

C:\>CLS <Enter> 



4. Creation OJ a new file: The COPY CON Command 

Tex.t files can be created by COPY CON command. Look at the following example: 

C:\>COPY CON HELLO.TXT <Enter> 

This command tells DOS to copy the infonnation from the keyboard or Console and 
put it in the file HELLO.TXT. On issuing the command the following screeri appears: 

C:\>COPY CON HELLO.TXT 

You will find a blinking cursor in the second line. Enter the text and terminate : each 
line by pressing <Enter> key as illustrated below: 

My first DOS file. The name given to this file is Hello.Txt.<Enter> 

It is v~ry easy to create files in DOS. <Enter> 

Once all the required text is entered, hit the <Ctr.l+Z> keys together to mark the end of 
Text. <Ctrl+Z> keys tell DOS that no more text is going to be entered now. Again hit 
the <Enter> key. 

5. Displaying contents of files: The TYPE Command 

The contents of any file can be viewed very easily by giving the TYPE command 
followed by the file name. Let us see the contents of file HELLO.TXT that we have 
just created by issuing the foll,owing command 

C:\>TYPE HELLO.TXT <Enter> 

You can also send the output of a file to the printer. The following command starts the 
printing job provided the printer is on. 

C:\>TYPE HELLO.TXT >PRN <Enter> 

6. Displaying a message on the screen: The-ECHO Command 

At times, you may require to display a text on the screen while executing a set of 
commands. The ECHO comm.and· helps you· to ·display a meaningful message on the 
screen. This command is issued-as illustrated below: 

C:\>ECHO Please insert floppy in drive A: <Enter> 

The ECHO command is a special DOS command used exclusively in hatch files (the 
files containing a set of DOS commands). There is one more form of ECHO command 
i.e., ECHO OFF as shown below: 

C:\:>ECHO OFF <Enter> 

The above command tells DOS not to display other commands in the batch file. 

7. Displaying the currently Jogged sub-directory: The PROMPT Command 

Users always prefer to see the prompt for currently logged sub-directory. The 
PROMPT command tells DOS to include the sub-directory, greater than (>) sign 
or any text as a part of the prompt. The various forms of PROMPT command are 
discussed as: 

(a) To display the path designation (e.g., \ACCOUNT\EXPENSE) and the greater 
than sign as a DOS prompt, issue the following command: 

C:\> PllOMPT $p$g <Enter> 

After giving the above command, if you are logged to EXPENSE sub­
directory of ACCOUNT sub-directory in the root directory, then the following 
prompt will come on the screen: 

C: \ACCOUN1\EXPENSE> _ 
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(b) To display a text " I Love India" along with path designation and greater than 
prompt, issue the following command: 

C:\>PROMPT l Love India $p$g <Enter> 

The above command will display the following prompt: 

I Love India C: \> 

(c) To display just greater than sign without path designation, you can give the 
following command: 

C:\>PROMPT <Enter> 

The command will display the following prompt: 

C > 

8. Specifying a sub-directory PATH: The PATH Command 

By this time, you must be familiar with the directory structure of DOS. Suppose your 
program (say PRJNCE.COM file) lies on the GAME sub-d.iJectory of the root 
directory and you want to ex.ecute it from any other sub-directory (say WINDOWS). 
To execute PRINCE.COM file, first you will have to make GAME as the currently 
active sub-directory and then issue the following command: 

C:\GAME>PRINCE <Enter> 

DOS provides a shortcut way to locate and run the above program from any other sub­
directory by specifying the path as illustrated below: 

C:\ WINDOWS> PATH C:\GAME <Enter> 

The above command tells DOS that GAME svb-directory is in the current search path 
of DOS. DOS will first search the required program £le in the currently logged drive 
and then GAME .sub-directory. Thus, the PRINCE.COM file can be executed directly 
from WINDOWS or any sub-directory as $own below: 

C:\WINDOWS>PRINCE <Enter> 

The PATH command is generally used in batch files. 

2.4.4 Internal and External Commands 

Every computer has a set of predefined instructions that its CPU can execute. These 
instructions are knows as machine instructions. Machine instructions perfonn very 
elementary operations - called micro-operations - such as 'ENABLE THE BUS', 
'LOAD THE REGISTER', 'ADD' etc. a machine instruction needs to be loaded into 
the CPU's Instruction register for the execution to proceed. 

No machme instruction exists for carrying out users' operations like 'COPY' A FILE', 
'RENAME A FILE' etc. these operations correspond to a sequence of large number of 
micro-uperations. However, users do not have to write all those instructions 
themselves. Operating system pro'Yides these macro-instructions which are called 
commands. 

A command is a sequence of a combination of micro and macro operations that 
accomplishes some pre-defined task of the user. These commands must be loaded into 
the RAM when one wishes to execute them otherwise they keep lying in the form of 
fries on the secondary storage device. 

Some commands are used more frequently than others. For example, DIR command 
of DOS is heavily used by the users while FORMAT command is used very seldom. 
If all the command are loaded into the RAM at the time of booting there will not be 
mucb space left for the users' programs in the RAM. On the other hand if no 
command is loaded into the memory, it must be loaded before one may execute it. 
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This requires many read-write operations to and from secondary storage and RAM 
slowing the operation. 

To avoid the above two extreme situatiQns operating systems load only frequently 
used commands into the RAM at the time of booting. Other commands are loaded into 
RAM from the disk as and when needed. Moreover, when a recently loaded command 
has fin.ished execution the memory is reclaimed by the operating system. 

The commands which are part of DOS system files - MSDOS.SYS and IO.SYS or 
Kernel of Unix - and which get loaded into the memory along with the operating 
system at the time of booting are called Internal Commands. On the other hand, the 
commands that reside on the disk as executable files - EXE, .COM or .BAT in DOS, 
.sh or .bin in Unix - and enter the memory when needed are called External 
Commands. 

If search your disk for DIR.EXE or DIR.COM or DIR.BAT you will not find them 
unless, of course you have created them yourself. Still you can execute the command 
DIR. This is because DIR is an internal command and is available in the memory. It 
got loaded into the memory at the time of booting along with rest of DOS. 

However, you will find FORMAT.COM, XCOPY.EXE etc. on the disk. These are 
external commands. When you issue one of these commands, DOS loads it from the 
disk to the memory, executes the same, and removes it from the memory once tpe 
execution is over. 

Note that while looking for the external command file, DOS searches the current 
directory first, then each of the directories listed in the PATH envfronment variable in 
that order. If the command file is found in any of these locations, it is loaded and 
executed otherwise an error message - "Bad command or filename" is issued to the 
user and the command terminates. 

Some of the often used DOS internal commands are - CD, DIR, RD, MD, DEL, 
COPY, CLS, REN, TYPE, DATE, TIME, ECHO, VOL, PROMPT, PATH etc. while 
external commands are - FORMAT (FORMAT.COM), XCOPY (){COPY.EXE), 
FDISK (FDfSK.EXE), CHK.DSK (CHKDSK.EXE) ETC. 

The differences between the internal and external DOS commands are tabulated 
hereunder. 

DOS Commands 

Internal External 

a. Loaded into RAM at the time of booting Loaded into RAM when executed by the user 

b. Reside on the disk as a part of system Reside on the disk as separate ex.eoutable files -
files - MSDOS.SYS and IO.SYS .COM, .EXE or .BAT in DOS and as .sh or .bin in 

UN,IX 

C. Execution speed is fast because it does Execution speed is slow because it needs to be 
not need to be loaded when called loaded and removed when called 

d. Always work May not work if the command file is not found by 
the operating system 

e. These commands are memory resident These commands live into the memory as long as 
they execute then are removed and the space is 
reclaimed for other programs 

f. Size of these commands is rather small These commands can be very large 

g . These are most often used commands These are less often used commands 

l. Making the disk usable: FORMAT Command 

Before discussing the fonnat oommand in detail, let us first see what is meant by the 
term 'Fonnatting'. Generally when you purchase a diskette from the market, it is 
unfonnatted. It can be compared with a notebook which has blank pages without any 
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ruler lines. Y 04 would prefer to put lines, write page numbers and categories the 
pages into equal P,arts so that an index can be made and the required topic can be 
searched very easily, Similarly, DOS organizes the disk into concentric circles which 
are called tracks. Tracks are further divided into triangular regions. Each such region. 
is called a sector. The organization of disk into tracks and sectors is called Formatting. 
The Figure 2.3 makes the formatting concept more clear. 

FORMAT command is used for fonnatting a hard disk or floppy disk. As FORMAT 
is an external command, a file by the name FORMAT. COM should be present on 
your disk. In order to format the floppy disk, issue the following command: 

C: \> FORMAT A: <Enter> 

Formatting done by DOS 

0 
Unformatted Disk Fonnaltcd Disk 

Figure 2.3: Process of Formatting 

Once the above command is executed, the following message appears: 

Insert new diskette in drive A: 

and strike ENTER when ready 

Insert a floppy disk in drive A and hit the <Enter> key. When the formaning of the 
disk is done, the following message appears on the screen. 

Enter Volume Label (upto 11 characters):_ 

Here, you can give a name to the disk for its easy identification. A label upto 11 
characters can br:- given to the disk after it is fonnatted. If you don't want that your 
disk should carry any label, simply press <Enter> key. Now, the following message 
will come: 

Format Another (YIN)?_ 

Now, if you want to format another disk, then hit 'Y' (for Yes) and insert that disk in 
the drive otherwise type in 'N' (for No) or press any key to end the fonnat program. 

New disks should always be formatted for using them. But old disks can also be 
formatted. Fonnatting will make the disk blank by erasing all its data. You may 
require to format an old disk if it has bad sectors and is needed again for usage. 
However, the FORMAT command should be used with extreme caution. Any disk 
whether hard disk or floppy disk will lose aJI data stored on it once the formatting 
operation is done. Therefore, you should not try the FORMAT command for 
formatting the bard disk .. I(iyou format the hard disk, all the contents stored on it are 
going to be removed permanently and new tracks and sectors will be created 

FORMAT command also provides a method for making your disk bootable. The 
following command is used for this purpose: 

C:\>FORMAT .A;/S <Bnter> 

With the help of thls cqrnmaod, all the operating system files (COMMAND. COM 
and two hidden files) are copied from tlle hard disk to the floppy disk. This floppy can 
now be used to load DOS in the computer's memory if you are unable to boot the 



system from the hard disk. The COPY command cannot serve the above purpose 
because it cannot copy the two hidden files of DOS in the- boot sector. 

.. I 

2. Checking a disif.: The CHKDSK Command 

The command CHKDSK helps to check the status of the disk. After checking the disk, 
CHKDSK displays several items of information. However to get executed, this 
command needs the program file CHKDSK.COM. Let's check the status of the disk in 
drive A through the following command: 

C:\>CHKDSK A:. <Enter> 

On successful!y checking the disk, the following status is shown on the screen: 

If no drive letter is specified with CHKDSK command, then the currently active ruive 
is checked for. 

3. Giving volume label to disk: The LABEL CQmmand 

Although, you have seen that a volume label to the disk is given at the time of 
formatting the disk, DOS also provides LABEL command to change, delete or give 
new label. This command needs a program file LABEL.COM. Let us give a label to 
the floppy disk by the following 90Il\Jlland: 

C:\>LABEL A: <Enter> 

Once the above command is executed the following screen appears: 

Volwne label in drive A has no label 

Volume label !11 characters, ENTER for none)_ 

So hit the <Enter>key if you want to delete the volume label without typing in 
anything. You can also provide volume label directly with the following command. 

C:\>LABEL A:MANOJ <Enter> 

4. Copying contents of one the floppy disk to another: The DISKCOP.Y Command 

The DISKCOPY command helps you to copy all the contents of one disk onto the 
other in such a way that both disks become identical. lt copies the contents of the 
floppy disk present in source drive onto the disk present in the destination drive. If 
you have a single drive on your computer, then the same drive can act as source as 
well as the destination drive. The command to copy the contents of one floppy onto 
the other is given here: 

C:\>DISKCOPY A: A: <Enter> 

When you issue the given command a screen lik-e the one shown below appears: 

Insert SOURCE diskette in Drive A 

Press any key to continue 
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At this point, insert the diskette whose contents are to be copied and then hit·any key. 
Another message appears on the screen as shown below: 

Insert TAR GET Qiskette in drive A 

Press any key to continue 

So, after this message appears, insert the diskette into which the files are to be copied. 
TI1ereafter, press any key to continue the process. Once the process of copying is 
completed, the following screen appears: 

\ 

Copy Complete 

Copy Another (Y n-f)? _ 

Press the 'Y' (for Yes) key if you want to copy the contents of some other diskette. 
DOS will again prompt you to enter the source diskette. However, if you want to stop 
the DISKCOPY process, press 'N' (for No). DISKCOPY command first formats the 
target diskette if it is unformatted and then copies files onto it. So, if any contents 
exist on the target diskette, they are all going to be removed. The DISKCOPY 
command needs the program file DTSKCOPY .COM for execution. 

5. Copying files and directories: XCOPY Command 

The XCOPY command is used to copy the files present in sub-directories. The 
command 'Copy •. •• copies the files of the currently working directory and 
DISKCOPY command copjes the entire contents from one floppy to another. So, they 
are not helpful in copying files selectively. The XCOPY command offers three special 
advantages: 

(a) It prompts you to specify the files that you want to copy. 

(b) It can also copy directories and other lower level directories. 

(c) It €an be used to copy files from the bard disk to the floppy disk. 

Now, let us explore the XCOPY command. If you wish that DOS should ask for your 
confirmation for copying a file, then use the IP option alo11g with the XCOPY 
command. Consider the following example: 

C:\> XCOPY C:ACCOUNT A:ACCOUNT IP <Enter> 

If you want to copy the di.rectories and lower level directories, then use the /S option 
alongwith the XCOPY command. Look at ,the following example: 

C:\> XCOPY C: ACCOUNT A:ACCOUNT IS <Enter> 

This ·command will copy the directory and all the sub-directories onto the A disk 
However, if the /S option is not specified, then the XCOPY command works within 
the single directory. You can also use IP and /S option simultaneously with the 
XCOPY command as shown below: 

C:\> XCOPY C:ACOOUNT A:ACCOUNT /P/S <Enter> 

The whole path can be specified with the XCOPY command. This command again 
needs the program file XCOPY.EXE in order to get executed. 

BATCH Files 

Very often, you keep keying in the same sequence of commands to do a repetitive job. 
For example, everyday, when you start your work on the computer, you first see the 
listing of tiles present on the hard disk. Then, you copy all the files with extension 
EXE and TXT from the floppy disk to hard disk. Thus, for achieving your task, you 
have to issue the following commands everyday. 

C:\>DIR/P <Enter> 
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~ :\>COPY A: *.EXEC: <Enter> 

C:\>COPY A: *.TXT C: <Enter> 

DOS can really simplify your task. All the sequence of commands can be put in a file 
which is calJed a batch file. This file offers a great advantage. Any number of 
commands gjverl in a batch file can be executed by just giving a single command at 
the DOS prompt. DOS executes alJ these commands one by one. All the batch files 
can have any primary name but the extension given to these kinds of files is BAT. The 
method of creating a batch file is exactly similar to that of creating any other fil e on 
DOS. Let us see it, through an example: 

C: \>COPY CON MY. BAT <Enter> 

DIR/P <Enter> 

COPY A: * .EXE C: <Enter> 

COPY A: * .TXT C: <Enter> 

<CTRL+Z> <Enter> 

ln the above example, a batch file by the name MY .BAT has been c:reated. If you 
want to execute this file, simplify type in the name of the file at the DOS prompt as 
shown below: 

C:\>MY.BAT <Enter> 

or C:\>MY<Enter> 

The commands given in this batch file are going to be executed one by one in the 
sequence specified. 

TheAUTOEXEC. BAT File 

The AUTOEXEC.BAT is an autoexecutable batch file. It is a special kind of a batch 
file. This file is executed as soon as the operating system is loaded in ~he computer's 
memory. The AUTOEXEC.BAT file is needed when you want it to1 be executed 
automatically each time the system is switched on. Now, as soon as th.e computer is 
switched on, DOS searches for the AUTOEXEC.BAT file in the Root dlirectory of the 
bootable disk. If the system finds this file, then all the commands given in i~ are 
executed one by one instantly without even asking for date and time. The 
AUTOEXEC.BA T file is created like any other batch file. Look at the following 
example: 

A:\>COPY CON AUTOEXEC.BAT <Enter> 

ECHO OFF <Enter> 

CLS <Enter> 

ECHO My frrst Autoexec.bat file successfully executed <Enter> 

PROMPT $P$G <Enter> 

PATH C:\DOS;C:\ WINDOWS <Enter> 

<CTRL+Z> <Enter> 

Enter the above commands on the root directory of bootable floppy disk. Reset your 
system. You will notice the above created batch file being executed automatically. 
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2.5 WINDOWS OPERATING SYSTEM 

Windows Basics 

Because there are many ways to set up Windows and do basic tasks, it's important to 
know your options and to choose those that best fit your needs. In this chapter, you 
learn about basic features that help you get your work done, as well as how to explore 
and customize Windows 2000. You also learn about the Internet and how to get 
connected by using the Internet Connection wizard. 

What is th! Desktop? 

The desktop is the area that first appears on the screen after you start Windows XP. 
The desktop is your workspace. On the left side of your desktop are icons, small 
pictures that represent files such as documents, folders, or programs. When you want 
to open ~ file, double--click its icon. 

· Nore: The procedures in this book describe the double-click method of browsing. Your computer manufacturer 
may have selected a desktop style that uses the single-click option. If so, point to an icon lO select a file, and 

·, . single-click the icon to open the file. 

Depending on how your computer is set up, your icons might be different from those 
in the illustration. 

Getting Help 

Windows XP Help is your principal source of infonnation for learning bow to use 
Windows XP. Always available from the Start menu, Help describes bow to perform a 
wide variety of tasks-from setting up a printer to connecting to the Internet. Help 
also contains a glossary, keyboard shortcuts, troubleshooters, an onLine version of this 
book, and links to Web-based resources. 

To Open Windows XP Help 

1. Click the Start button. 



2. On the Start menu, click Help. 

Windows XP Help appears. You can find topics listed on the Contents tab, look 
up keywords on the Index tab, and search for text by using the Search tab. 

You can also get infonnation about a dialog box by clicking the question mark button 
on the title 6ar and then clicking the dialog box area in question. 

'· 
Exploring your Computer 

You can navigate in Windows XP by using the taskbar (including the Start button), 
My Computer, Windows Explorer, or My Network Places. In some c~es, one way is 
more efficieht than another. For example, 'it's faster to start programs from the Start 
button than from Windows Explorer, but Windows Explorer gives you a more 
complete picture of all of the files on. yout computer. In other cases, the choice is 
personal preference. When browsing through folders (containers for documents and 
programs), f~r instance, you can use either My Computer or Windows Explorer- it's 
a matter of how you prefer to display the contents of your computer. The following 
sections familiarize you with some of your choices. 

The Taskbar and the Start Button 

You can use the taskbar and the Start butt_on, which usually appear at the bottom of 
your screen, to navigate in Windows XP. Both features are always available on your 
desktop, regardless of how many windows ypu have oren. 

. . . 
s tart • •·~•-•I :,•, ~,... • •• -~·-""',. • , .,. 

-- -- --~-~ - --- -

Buttons on the taskbar show you which windows and programs are open, even when 
some are minimized or hidden beneath another window. You can easily switch to a 

I 

different window or program by clicking its' taskbar button. 
: \ 

If you're upgrading from Window~NT ~ertion 3.51, you'll notice that your program 
groups now appear on the Start menu. ·' 

The Start buhs,o displays a list of commands and shortcuts (pointers to files) that you 
can use to ~omnlish almost anv Lisk. You can start programs, open documents, 
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custemize your system, get Help, search for items on your computer, and more. Some 
items on the Start menu have a right-facing arrow, which means that additional 
choices are available on a secondary menu, called a submenu. When you place your 
pointer over an item with an arrow, a submenu appears. 

My Computer 

Use My Computer when you want to view the contents of a single folder or disk. A 
disk is a device, such as a hard disk or floppy disk, on which you can store files. When 
you double-click My Computer on your desktop, icons representing the available 
drives appear in a new window. When you double-click a drive •icon, a window 
displays the folders contained on that drive. You can then double-click an icon to open 
the folder or file. 

Sotne of the following icons may appear in the My Computer window. 

D011ble-click 

lJ 

To 

View the contents of the floppy disk, which is usually designated as A. 

View the contents of the hard disk, which is usually designated as C. 

View the contents of a network drive, if your computer is connected to one. 

View the contents of a compact disc in the CD-ROM drive, ify_our computer has 
one. 

View features you can use to modify your computer settings. 

Set up a printer and view information about avaiJable printers and print job status. 

Schedule or view tasks for computer maintenance. 

View the contents of a folder. 

View files and folders on a Web server, if your computer is connected to one. 

Windows Explorer 

If you prefer to see files in a hierarchical structure (similar to a family tree), you'll like 
using Windows Explorer. Instead of opening disks and folders in separate windows, 



you can browse through them in a single window. The left pane of the Windows 
Explo~er window contains a list of your disks and folders, and the right pane displays 
the contents of the selected folder. You can use the View menu to change how _the 
icons in the right pane appear. 

To use Windows Explorer to view the contents of your local (hard) disk: 

I. Click the Start button, point to Programs, point to Accessories, and then click 
Windows Explorer. 

2. In the left pane, click the plus sign next to My Computer, then the plus sign next 
to your local disk. 

The contents of your bard disk appear in the right pane. 
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My Network Places 

A network is a group of computers connected to one another so that they can share 
resources such as files and printers. If your computer is connected to a network. you 
can use My Network Places to browse network resources the ·same way you browse 
the contents of your own computer. When you double-click My Network Places on 
your desktop, icons representing network resources appear in a window. 

Some of the following icons may appear in My Network Places. 

Double-click To 

iJ Create a short.cut to a specific network location. Runs the Add Network Place 
wizard, which helps you to create a connection to a .shared folder, a Web 
folder on the Internet, or a FTP site. 

I Display all of the computers, printers, flk:s•ed fbk!ers and people available 
on your organization's network. 

A Display only those comp~ers in your doff\ain or workpmp,. 
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To open network resources 

1. On the desktop, double-click My Network Places. 

2. If you want to browse shared resources in your workgroup, double-click 
Computers Near Me. The computers and resources in your workgroup appear. 

lf you want to view all of the resources available on the network, double-click 
Entire Network. Depending on how your network is set up, you may see 
computers arranged by domain or by workgroup. 

3. Double-click the item you want to open, just as you would open drives and folders 
on your own computer. 

Getting your Work Done 

Now that you're familiar with the desktop_ and the different methods of navigating, 
you ' re ready to learn how to perform everyday tasks, such as starting programs and 
managing your files. 

Working with Programs 

Windows 2000 makes it easy for you to add, remove, start, and quit your favorite 
programs. 

Adding and Removing Programs 

You can quickly add programs, such as a word processing program or game, by using 
Add/Remove Programs in Control Panel. 

To add or remove a program 

I . Click the Start button, point to Settings, and then click Control Panel. 

2. Double-click Add/Remove Programs. 

Add/Remove Programs opens. 

3. Click Change or Remove Programs or Add New Programs, and then follow the 
instructions that appear. 

Noui: You can also add and mnove Windows comp<>ncnl6 by clicking Add/Remove Windows 
Compooe111S in Add/Remove Programs and then following the instructions that appear. 

Starting and .Quitting Programs 

Most of the programs installed on your computer are available from one convenient 
Location-the Programs section of the Start menu. Depending on how your computer 
is set up, what you see on the Start menu varies. 

To start a program 

I. Click the Start button, and tben point to Programs. 

The Programs menu appears. 
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2. Point to tpe group (such as Accessories) that cont,ains 

start, and then click the program name. 

To quit a progr""f 

· Click the Close button in the upper-right corner of the prograµi window. 

Managing Files and Folders 

File names in Windows 2000 can be up to 255 characters, including spaces, but can't 
contain any of the foHowmg characters: \ / : * ? "< > I 
When you add a program or use a program and save your work, you create a file. For 
example, the Microsoft Word program is a file, and every document you create with 
Word is also a file. You can better organize your files by storing them in folders. For 
example, you may want to create a folder for each of your projects and keep files 
associated with the projects, such as documents and saved e-mails, in those folders. 
You can also move, rename, and delete files and folders. 

Working with Frequently Used Files 

For easy access to files and folders that you use frequently, you can create shortcuts to 
them. A shortcut doesn' t change the location of a file or folder, nor is it a copy- it's a 
pointer you use to open the file ~r folder quickly. Deleting, moving, or renaming the 
shortcut doesn't affect the original item. 
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In Microsoft Windows XP Professional, you will find one of three different accounts 
in use on any given system. 

(a) Local user accounts: Local user accounts allow you to log oo to the local system 
and access resources there. 

(b) Domain users: Domain user accounts allow you to log on to the domain the user 
account belongs to in order to access network resources. You may be able to 
access resources in other domains depending on how the trust relationships are 
defined or if any modifications have been made to them. 

(c) Built-in user: Built-in user accounts allow you to perform administrative tasks on 
the local system and sometimes they can access local or network resources, 
depending on their configuration on the network. 

Using the Local Users and Groups Snap-_in 

You would nonnally need to be a local administrator to perform most system 
configuration functions ( even just taking a look at the current configuration settings) 
on a Windows XP Professional system, and in some cases, there may be a local policy 
set by some other administrator or if your system is in a Domain, a Domain policy 
setting, which may prevent you from performing some actions. 

To manage local users and groups you can use the Local Users and Groups MMC and 
you can access this tool a number of different ways. 

One way is to select Start, right-click My Computer, and then click Manage, which 
will open the Computer Management MMC. Under the System tools icon, click Local 
Users and Groups to open the Local Users and Groups MMC. 

E-mail 
Microsoft Office Outtooi.: 

Paint 

~ l'llicrQSoft Office Word 2003 

Calculator 

Visual studio .!\ET Cornman 
Prompt 

Microsoft Vtsual studo .NET 

All Programs ► 



You can also type compmgmt.msc in the RUN box or from a command line to launch 
the Computer Management MMC. 

:~ T)Pettle'nameofaprQ11'.vn, foldet ~ or 
-,;;,J Ire.met resQJ'I%, «id Whdows ;;{ open t fo, you. 

Open: 

1. FORTRAN stands for 

2. VOIP Stands for 

3. DOS stands for 

4. CAD stands for 

2.6 LET US SUM UP 

An operating system is an integrated set of specialized programs that is used 'to control 
and manage the resources and overall operation of a computer system. 

Dos is the most commonly used operating system. Loading of DOS into the main 
memory is known as booting. DOS commands are of mainly two types: internal and 
external. Internal commands are directly interpreted by the command processor, 
command.com. External commands are interpreted with help of external t1iles (with 
extensions.com or .Exe). 

Storage areas on a disk are known as directories. A directory may contain fiJles and/or 
sub-directories inside it. The full name of a file or a directory (including path) is 
called pathname. 

Wildcards special characters carrying special meaning. Two MS-DOS wildcards 
are'?' and'*·' The'?' can replace exactly one-orb.one characters in a name. The'*' can 
replace number of characters in a bame. 

Some Dos internal commands are copy, DEUERASE, REN, TYP'E, DIR, 
CHOIR/CD, MK, DIR/MD, RMDIR/RD, BREAK,CLS, DA TE, PATH, TIME, 
PROMPT, etc. Some external commands are DISK COMP, DISKCOPY, FORMAT, 
LABEL, PRINT, XCOPY, etc. 

Batches of MS-DOS command stored under a filename with extension. BAT are 
known as Batch files. The batch files with the name AUTOEXEC.BAT is 
automatically executed by MS-DOS at the time of booting. 
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MS-windows is a GUI based operating system. lo windows operating system, multiple 
applications can be simultaneously run in different windows. In MS-windows, the 
screen upon which icons, windows, etc., are displayed is known as desktop. 

2.7 KEYWORDS 

CAD: Programs that are used to create engineering drawings. CAD programs make it 
easy to modify drawin,g_s. They also make it easier to keep track of material 
specificati9ns. They can perfonn spatiru and engineering estimates on the designs, 
such as sw-face or volume calculations. 

Desktop Publishing (DTP): The art of creating professional docwnents with personal 
computers and small laser printers. Beyond basic word processing, DTP software 
provides controls to standardize pages, improve the page layout, and establish styles. 

Geographic Information System (GIS): Designed to identify and display 
relationships among business data and locations. Used to display geographical 
relationships. Also used to plot delivery routes and create maps. 

COBOL: An early program.ming language designed to handle typical transaction­
processing tasks. Its death has been predicted for years, but it is hard to throw away 
billions of lines of code. 

2.8 QUESTIONS FOR DISCUSSION 

1. Describe various uses of computer in btisiness. 

2. Explain various functions of disk operating system. 

3. \Yhrt is the pu, ose of copy command? 

4. Whrt is windows explorer and give some of its functions? 

Ch~ck Your Progress: Model Answer 

i. Formula Translation 

2. Voice over Inter- ! "rotocol 

3. Disk Operating System 

4. Computer Aided Design 
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3.0 AIMS AND OBJECTIVES 

After studying this lesson, you should be able to: 

• Explain word processor 

• Describe MS-Word 

• Describe working with manus 

3.1 INTRODUCTION 

For most people, writing is an everyday occurrence. When computers hav1e affected 
our life styles and work patte~s, ,this activity is also not left out. Many ajpplication 
programs have been developed to make, writing easier and smooth operation. One 
such most popular program is word processor. A word processing software provides a 
general set of tools for entering, editing and formatting text. This unit introdluces MS­
word as a word processing software. It focuses, on the methods for creating a word 
document and its various formatting features. 
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3.2 WORD PROCESSOR 

Word processing includes typing in text and manipulating it so as to give a very 
systematic and organized look to your document, which enables easy reading. The 
application software or program wh.ich helps us in processing the text is called a 
'Word Processing Software, or simply a 'Word Processor'. So, you can say that a word 
processor is nothing but a computer program that helps you to: 

• type your text 

• correct spe!Hng mistakes and grammatical errors 

• align text within margins 

• offer a variety of font styles and font sizes 

• see a preview of the text that you have fyped in. 

Popular Word Processing Packages 

The commonly used word processing packages are: 

• MS-WORD 

• Word Star 

• Word Perfect 

• Professional Write 

Uses of Word Processing 

Normally, a word processor can accomplish the following tasks: 

• Brochures 

• Newsletters 

• Reports 

• Advertisement 

• Resumes and Cover letters 

• Books 

• Directories 

• World Wide Web Pages 

There is absolutely no end to what a word processor can do. By now you must have 
realized that the word processing applications have become much more sophisticated 
than before. 

Tabular differentiation between DOS and Windows: 

DOS WINDOWS 

User interface Character based GUl (Graphical User interface) 

Number of users Single user Multi-user 

Programming environmmt Single program Multiprogramming 

Network support Limited Fully functional 

Process management Uniprocessing Multiprocessi.Qg, Thread processing 

Device inslallation Manual Autodetect 

Systom security Limited or nil Tight 



3.3 MS WORD 2003 

There are many word processing softwares available in the market. The one, perhaps 
most popular is Microsoft Word. 

Microsoft Word 2003 is a highly sophisticated word-processing member application 
software included in Microsoft's Office 2003 suite. It is one of the latest version of the 

MS-Word available at this time apart from MS-Word 2007. MS-Office 2003 suite bas 
been designed to run of Windows XP. 

MS-Word can be used to: 

• Write letters 

• Theses 

• Newsletters 

• Resumes 

• Applications 

• Books 

• World Wide Web Pages 

• Fax 

• Envelope 

3.4 STARTING MS-WORD 

Microsoft word is a Windows based word processing application. To s:tart Word 
session: 

• Click on the start button on the Taskbar 

• Then Click on the Program sub-menu in start menu. 

• Click on the Microsoft Word command identified bylil icon 

Execution of this command will launch Microsoft Word 2003 on your computer. As a 
result, MS Word window appears on the screen. The look and · size of a window 
application can be customized and therefore may vary from one installation to 
another. A typical Word window looks like the one shown below: 

Ope,,od Scn,Ubon Scokall.wtr Sla!Wlbor 
Do<llmool (8) (S) (7) 

(l) 
Ccalrolbuaoo, 

Navipdout,uao,,a 
(9) 
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MS-Word Window 

The Word window is the rectangular box in which the Microsoft program interacts 
with the users. The walls of the window are resizeable. When you place the mouse 
pointer at a window wall it changes from a single arrow to double arrow. You can 
now click and drag the mouse and the wall moves with it. Release the mouse button 
when you have sized the window as you wanted. The visible e;:lements of the 
Microsoft Word window are listed below: 

J. Title (or Caption) Bar: Title bar shows the name of the window application 
(Microsoft Word in this case) that owns the window and the name of currently 
opened document (Document! in this case). Whenever you open a new document. 
by default Word attaches the names like Document!, Document2, etc. You can of 
course change the name of the documents by giving the names while saving the 
documents. 

2. Control Box: Title bar also has a control box and a few control buttons. When 
you click at the control box a menu of items appears as shown below: 

f9 ~Ota 

Move 

Size 

- Mlnlmlz.6 
□ Maximize 

)( Close M+F4 

(a) Restore: It restores the windows to previous size. 

(b) Move: You can move the window on your screen. 

(c) Size: You can s ize the windows of your size. 

(d) II button minimizes the window. Clicking at this bunon will reduce the 
window to a small rectangular bar placed on the Windows task bar. 

(e) II button maximizes the window t~ cover entire area of the desktop. 

(f) Im button closes the Word window and tenninates the Word program. 

3. Menu Bar: Menu bar displays menus available to the users of Word. A menu is a 
group of various logically connected commands. Menu bar is located under the 
title bar. 

Menu handle 

File, Edit, V iew, Insert, Fonnat, Tools, Table, Window and Help are nine menus 
in the menu bar. Clicking at these menus displays the menu items which can be 
commands or sub-menus. 

Menu handle lets you move the menu to a desired location. If you place the mouse 
pointer at the menu handle the pointer changes to double cross pointer. You can 
click and drag the menu to place it at the desired place. 



4. Tool Bars: A Toolbar is a group of iconic buttons (referred to as tool buttons) 
each representing a menu command. By clicking these buttons respective 
commands can be executed. Clearly, this is much easier and faster way of 
command execution. 

Toolbars appear generally below the menu bar but can be placed anywhere by 
clicking and dragging them using tool handle. You can also specify which 
toolbars would be displayed and which not. Moreover, you can also create your 
own toolbar containing desired tool buttons. When the mouse pointer is placed 
over a tool button a brief message is displayed for a short while. This message is 
known as tool tip. 

5. Ruler: The Word window is supplied with one horizontal and a vertical ruler 
displayed along the left and top edges of the current document. Rulers can be used 
to set margins and indents in easy manner and they also provide measurement 
while formatting the page. ' 

6. Cursor: Cursor is MS-Word pointer, which tells whete on the document the 
action (that you choose to apply) will take place. The cursor can be moved and 
placed anywhere on the written part of document using a pointing device like 
mouse or keyboard arrow buttons. 

7. Status Bar: This bar displays the current position of the cursor, status of some 
important keys of keyboard (whether the Caps key is on or off, for instance) and 
other relevant information. It is located at the bottom of the window. 

8. Scroll Bars: Scroll bars are sliders that can be moved using mouse. AB the scroll 
bar is moved, the window pans through the document exposing different regions 
of the document. There are two types of scroll bars: 

(a) Horizontal Scrollbar 

(b) Vertical Scrollbar 

Horizontal Scrollbar is placed at the bottom while vertical scroll bar at the right of 
the document. 

9. Navigator Button: 

Document Navigator allows navigating the document by hoping from object to 
object of selected type. It is activated when the ball type button on the vertical 
scroll bar is clicked. When you click at the ball a list of object types is displayed 
as shown below: 

[g]~~[@J~~ 
~~[§[2]~E] 

<::ancel 

You select an object type and then you can browse next object by clicking 

I and to previous by clicking • I. 
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10. View Button: 

A document can be viewed in many different ways highlighting different aspects 
of the documents. View buttons are shortcuts to various view commands in the 
View Menu, placed adjacent to the horizontal scroll bar. Different views available 
are - Normal view, Web layout view, Print layout view and outline view. 

Start Working with Word Document 

When you open the word a blank document opens. You can start typing on it directly. 
But for various other activities, you need to learn about the commands in different 
menus present in the menu bar. You can select different menus with click of the 
mouse and through hotkeys also. Hotkeys are displayed underlined. Just press the 
underlined combination of keys (usually, Alt, unless specified otherwise) to get the 
action performed. For example if you wish to select the File menu you have to press 
the Alt+F keys to open the menu or Alt+V to select the view menu. 

A list of keys or key combinations for cursor movements is given below: 

Movement of the Cursor using Keyboard 

Movement of the cursor Keys 

Left of Right one character +-Or-+ 

Left or Right one-word I .~.:-!+ +-or Ctrl+ -+ 

Up or Down one line ~ Tor + 
Up or Down one paragraph Ctrl+Tor Ctrl+ i 
To the start or end of a line Home or End 

Up or Down one screen Page up or Page Down 

To the top or bottom of the current screen Ctrl+Page up or Ctrl+P11ge Down 

To the start or end of the document Ctrl+Home or Ctrl+End 

To the top or end of the window Alt+Ctrl+Page Up or Alt+Ctrl+Page Down 

To the location of the insertion point when the Shift+ F5 
dor,ument was last closed 

3.5 WORKING WITH MENUS 

A user can initiate an action either by clicking (with left button of the mouse mostly) 
at a command option in a menu or at a tool button. Sometimes you may find some of 
the commands and/or buttons disabled (inactive in gray color). Word (and other 
window based packages) disables those commands and buttons which are not 
applicable or relevant to the current selection. 

Commands that let you perfonn desired actions are grouped into logical groups called 
menus. You will now learn what all menu commands are available in Word 2003. The 
menus are: 

These menus provide groups of related commands. Thus, File menu contains aU the 
commands related to file or workbook manipulation, 



These menus can be opened by clicking at them. Another way to open these menus is 
to press Alt+(Undelined letter of the menu name). Thus Alt+F will open File menu 
and Alt+o will open Format menu. 

Most ·of the commands are also represented by their respective icons. Another way of 
executing a command is to click at the tool button of that command usually 
represented by its icon. 

3.5.1 File Menu 
File menu contains commands related to file operations. Different file>-operations are: 

• Opening a new document: New command 

• Opening an existing file: Open command 

• Saving an opened file: Save command 

• Closing an opened file: Close command 

• Examining the print preview of an open file: Print preview command 

• Printing an opened file: Print command 

• Setting the page setup of the file: Page setup command 

• Saving different copy of a file: Save As command 

• Sending a file to other location: Send to command 

• Checking the properties of the file: Properties command 

• Exiting from word: Exit command 

File menu is shown in the following MS-Word window. 

~ Qpen .. , 

Iii siwe 
S-65 ... 

• Save as Web Page ... 

~ --
Pago Sety, . .. 

• l?ttt·· · 
l'ropertles 

1 C:\ .. . llllt\Word2000_MAN 

Otl+O 

arl+s 

Z c.:\l)oanlerts and Seltt)gs\,., \WonfZoooJ 

1 C:\l)oanlerts and Se'ttwlQs\ ... \Wotd2000J 

tC:\ ... \Powerpott\f!lan'_Qiac,ts I 

File ➔ New Command 

I. Click on the File menu. 

.:.l 
• 
• 

2. Click on the Ne~tion or press Ctrl+N through the keyboard or click at the 

Blank DocumentU icon at the standard teolbar. 
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Note that there are many types of pre-design~d documents available in the task pane. 
shown above. 

• Blank Document: Start with a blanW document when you want to create a 
traditional printed document. / 

• Blank Web Page: Use a Web Document when you want to display the 
document•~ contents on an intranet or the Internet in a Web browser. A Web page 
opens in Web layout view. Web pages are saved in HTML format i.e. a file with 
.html extension. 

• Blank E-mail Message: If you use Outlook 2000 or Outlook Express, use an 
e-mail message when you want to compose and send a message or a document to 
others directly from Word. An e-mail message includes an e-mail envelope 
toolbar so that you can fill in the recipient names and subject of the message, set 
message properties, and then send the message. 

File ➔ Save and Save As commands 

For saving the current document: 

1. Click at Save command in File menu. 

OR 

Press Ctrl+S 

OR 

Press the Save tool from standard toolbar 

If you are saving the file ,for the first time the Save as window will appear 

2. Choose the appropriate folder from Save in combo box where you want to save 
the document. 

3. Write a file name in the File name text box. 
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4. And then press the Save button. 

Note that if you close an open document without saving its latest content, MS-Word 
duly prompts you with options for saving and not saving the document. You can select 
the appropriate action from these options as well. 

Save and Save as commands both save a document. However, the difference between 
both commands is that the Save as command allows the user to save a file by a 
different name and format also. The Save option will save the document by the same 
name and format as it was saved for very first time. 

File ➔ Open Command 

To open an existing document: 

I. Select tqe Open option from the File menu 

. OR 

Press Ctrl+o 

OR 

Click on the Open·■ tool from the standard toolbar 

The Open dialog box will appear as shown below: 

M\IDlittSawaos 
Myl"ISlc 

~Pk!Ules 
"'tt(hlp I 
Chip I 
Chip~ 
Ollpe 
Ollp,l0 
Chip II 

O'IIPl1 
Chop i6 
0.16 

73 
Word Processing Softwares 



74 
Compurer Application 
for Managers 

2. Select the appropriate folder from look-in combo box. 

3. Select the required file from the file window 

OR 

Write the required file's name in the file name window 

4. Click Open button on the right hand side 

OR 

Press Enter. 

File ➔ Close Command 

To close the current document, click at the close command in the file menu. Note that 
only current window or document will be closed since the Microsoft Word works in 
MDI (Multi Document Interface) environment unlike notepad which works in SDI 
(Single Document Interface). 

File ➔Save as Web Page Command 

Save as Web Page option will save the word document in the web page format i.e. in 
the html format with file extension .htm. You can view it then in the web browser. 

s... ;i: If> My Oorunents 

'Pt1J1Utie: a.er•• ~ntit •• J 

FIi ~ lword2000_1 .~ !:::J 1e'fe 
SIM• type; !Web Page E1 C«al 

File ➔ Page Sefllp 

The Page setup command you can set the page layout (margins etc.). To invoke page 
setup: 

1. Click at the Page setup command in the file menu. The page setup window will 
appear. 

2. Adjust margins or apply different options in the margin tab where, 

(a) In top margin enter the distance you want between the top of the page and the 
top of the first line on the page. 

(b) In Bottom margin enter the distance you want between the bottom of the page 
and the bottom of the last line on the page. 

(c) In Left option, enter the distance you want between the left edge of the page 
and the left edge of unindented lines. 



( d) In Right option enter the distance you want between the right edge of the page 
and the right end of a line with no right indent. 

(e) In Gutter option enter the amount of extra space you want to add to the 
margin for binding. Word adds the extra space to the left margin of all pages 
if you clear the Mirror margins check box, or to the inside margin of all pages 
if you select the Mirror margins check box. 

(t) In Gutter Position option enter the side on which you want to add the margin 
for binding. 

(g) Select the orientation of the paper from Landscape or Portrait orientation 
frame. Portrait orientation is lengthwise while Landscape orientation is width­
wise on the page. 

Margins Paper I layout I 
MarQlns 

I-OP: 111 ~ a.ottom: I 1" 

Left: 11.25" :ti B,ight~ I 1. 2s" 

~er: Jo" -fl G!,ttter position: lleft 

orientation ------------------~----

~~· 
eortrait Landtcape 

Poges -----------p-_-_-_-_-,:_-_-_-_-_-_-_-_-,:_-_-_-_-_-_-_-.::;-
Mult!Ple pages: INormal -~-[El 

Preview ----------------------
APt,l~to: 

lwbole-document 

~ault ... .__Ok __ .. 1 __ ~ __ _. 
3. Select the different options of paper from the paper tab. 

(a) From Pape.r size list · box you can select the predefined Paper sizes like A4, 
legal etc. 

(b) From Width and Height text boxes the custom Paper size can be defined by 
adjusting the Height and width of the paper. 

(c) Frorp the Paper ,ource option you can select the source of paper that from 
where you are goMg to in~ert the paper in the printer. 
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(d~ t ,the A~ply t9 list box click the portion of the document you want to apply 
1 · t curre~t settipgs to iqjhe Pa~e Setup dialog box. Th~ default o~tion is 

bole document, you can selectlatcotdin~ to the situation. 

4. You can se you click on the 
layout tab, 

' 
(a) In the S~ ection frame select the portion from where you want the gµ:ren( 

fayout to be applied. · 

(b) In Header option under From edge frame enter the distance you want from the 
top edge of the paper to the top edae of the header. If the Header setting is 
larger than the Top setting, Word ,prints the body text below the header. 



( c) In Footer option under From edge enter the distance you want firom the 
bottom edge of the paper to the bottom edge of the footer. If the Foote:r setting 
is larger than the Bottom setting, Word stops printing the body text above the 
footer. 

(d) In Page frame select the vertical alignment of the text. 

(e) In the Apply to list box click the portion of the document you want to apply 
the current settings to in the Page Setup dialog box. The default option is 
whole document, you can select according to the situation. 

File ➔ Pri11t Optio11 

Click at the print command, for taking the printout in the file menu. The print diaJog 
box appears: 
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You can set various options before taking printout. 

I. From the Name combo box in the Printer frame you can select the priinter on 
which to print if there is more than one printer installed. You can also set the 
printer properties by clicking at the Properties button. 

You can also save the document in print fonnat in a file in case you do not need 
the printout at once. For this click on the Print to file option. 

2. You can select the range of pages i.e. all pages or current page or number 
of pages you wish to print - from Page range frame. Click at All (default) 
for all the pages of the document; Current page for the current page; and p,age for 
the specified pages only: 3-6 for pages from 3 to 6, 3-3 for page number 3 only, 
3,6-7 for page number 3 and all the pages from page number 3 to 7. 

3. From the. Print what option you can choose which part of a document you want to 
print i.e. the whole document or comments or anything else. 

4. From Print option the pages to be printed can be selected i.e. aU pages or even 
numbered pages or odd numbered pages. 

5. Yo~ can specify number of copies of the docwnent in Number of copies option 
under C_opies frame. 

6. In Pages per sheet option under Zoom frame you can specify the number of pages 
in the document that you want to print on each sheet of paper. 
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7. From Scale to paper size option you can select the paper size on which you want 
to print the document. For example, you can specify that a B4-size document will 
be printed on A4-size paper by decreasing the size of the font and the graphics. 
ThJs feature is similar to the reduce/enlarge feature on a photocopy machine. 

8. The collate check box can prints the copies of the document in proper binding 
order. 

File ➔ Send to Option 

From Send to command you can send the document to various recipients (another 
application or otherwise) through various technologies like e-mail, fax etc. 

File ➔ Properties Option 

The Properties command in the file menu lets you set various properties of 
the document. 

When you click on the properties option you will see the following window: 

Word2000_ 1 Properties I? II XI 

General 5'.fnlnary I Statistics I Conteots I CUstom I 

liitM• 

!Anshu 
[!l.Ylaoer: 

Cgftipany: jPersonal 

Category: 

~~words: 

,ormierts: 

ljyperhnk 
base: 
Template, Normal 

I Cancel ----- ··-----OK 

From this window you can set or see the various properties of the document. You can 
set the author name, company name, title of the document and various other 
properties. And from the other tabs you can see the various properties of the document 
like the ones described below: 

1. In General tab you can see the type of document, the path of the file: where it is 
saved, the file size, date of creation of the document, date when last modified and 
accessed, etc. 



Word}000_ 1 Properties rfl /'X I 

~aJ.,q SUnmary I statlstks I eonteots I (;ustom I 

~ Wotd2000_1 

Type1 Microsoft Word 97·2002 Ooc'61l«lt 
Location: C:\Ooct.ments and SettlnQs\Aooraot \Desktop\11,.,noj-
Size: 1,39'6 (1,fi7,216 bytes) 

MS-DOS name: WQR02(),., 1,DOC 
Created: 
Modified: 
Accessed: 

Wedoescf.w, ~ary 02, 2002 10:47:31 AM 
Monday, January07, 20022:25:0S PM 
Monday, January 07; 2002"2;2S:08PM 

AttrW.es: r: a"a:'J onl 

f.:; A, 4Jt1Y1: 

r I Jt,11 

r s,. tem 

__ ~ __ I _Cancel __ .... 

2. In Statistics tab you can see various statistics related to the document like number 
of pages, number of paragraphs, number of words, number of characters and 
number of lines in the document. 

General l SUrvnarv [siat~JI eonterts I eustom I 
Created: saturday, December 27, 2003 2:44 :00 PM 
Modfled: Monday, .Jaroary 07, 2002 2:25:0ff PM 
Acc;essed: Ml)nday, .Jaroary 07, 2002 2:25:08 PM 
Pitted: 

Last saved by: Anutagl 
Re-.;sion runber: 12 
Total editlno time: 156 Minutes 
-- ----------------
~atlstlcs: name 

Paoes: 52 
Paragraphs: 579 
Lines: 1494 
Words: 8723 
Characl:ers: ·40916 
Characters (with spaces): 49249 

OK Cancel 
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3.5.2 Edit Menu 

All the necessary editing commands have been grouped into. the Edit menu or toolbar. 
See the edit menu given below . 

.. Office Clip!loard .. , 

ft e.Mte Ctrl+\/ 

Paste p,dai .. , 

~ 

Select A!I ctrl+A -
"' find .. . Ctrl+F ;J 

Rm>lace .. . Ctrl+H • 
~To ... Ctrl+G 

0 . 

• Cl 

P9 t· Ln 1 Col I 

Block Operations 

There may be a situation when you have to perform a task on a single character. 
Doing that is very simple. Just put the cursor on the character and perform the task. 
But in situations when you have to perform the same action with a group of words this 
may not be the preferred way. Let us take an example of deleting a whole paragraph. 
To delete a paragraph you can press the <Del> key repeatedly until the entire 
paragraph is deleted. However, as you would realize that this is very tedious way of 
deleting multiple characters. 

A better solution is to make a block of all the characters of the paragraph by selecting 
it and then deleting it in one go. Any general method of text selection may be 
employed to select the text block. The selection appears in reverse background (white 
foreground and black background). While selected, if a key is pressed the enti.re 
selection is replaced by just the character keyed in. If instead the <de!> key is pressed, 
the selected block is deleted without being replaced by any character. 

To select a word you: 

1. Place the mouse pointer on the word. 

2. Double click the word. 

OR 

1. Place the cursor before the word. 

2. Press the left button of mouse and drag it till the end of the word. 

OR 

I. Place the cursor before the word and then press ctrl+shift+right arrow keys. 



__l, I,.,,, I "'' , "-II• ,. :'.: . X 

tw CM _... ,.._ •,w. 10• 

Q,i '1 ~ •..1 •l'l: ' 
'i) Cl 

·--- .... Ill• Sfi!□ b 

• 4t1 · .. . I . , . ' ' •·• •. .t-•lii•Gll 
$uppci,• lnlo"""""' ~ tobo-d {o,m~ 3t., 1, l wWu• ~A .c,d. U 

To select a line: 

• '"!'lJ'lwtabo..,. bckt{!,gml tn3) lwlllu,. l!lull. 

WI 12..,£ , A , R l A... N IT W O o ( S ( W A " ) 

A wide a.m.a nt-twork CQ[\na:;t:S' computt-n Which .t.rt wry can:nt¥ p!A..~cl n rmy 
CClt\J"ICt .oos lh• countrits or cmtiMN:1 or tN ~uU'I. gbbt. Wide Ar1-a NtMorkil .atl!. 

a,Jo, "'"'mtd to .. t.o.,,g H,,,Jl Notwarb (I.mis). 

Wl<la ama ,,-,,lb can , _, bo pa',\t (c paint type er b'°"dc,ut typo. !n a pant 
10 polt\t rype MtWo.rk. th, 10\l~ and the ._tna.k:n m.tehlnes ..ue <Cf\N(Ud ,o ud'i 
otN!-1 ,..,. NWral iote.l'tmdi.an rcurem. A pcnnl to pokit typ: t.\QIWcrk. may be ~d 
Into 'n'l'O ~«M hostur1c:i 1tl.e aJbn1L ihl mM:hlnes b,tw-, whi:'h ~i:'&ioo 
II to boe,tobn.ti.d a« callod.hcu Tiv hosts MO _.,....d 10 ,a:il c11,," by wl\al Is 
lo!own u ~ ll.lbaat. Tho ,ubl\11<:c,nasua!tbc""".cmlulor> !l,,1t<(....,...\olcablu. £»,,. 
cptlc Clbloottc.) .md ti,• lnllONdla• ""'1tdlkl311ffl-e,,11 ilbo caU.d ',wten'.To. main 
&mctm al a IOllter ls t.o -=:e~ the 1lll'\5llUlled dau c,d th.Ir\ •iict C'.' ~mprYl.e 
channel to Jorwud it UJ the. d.Hliri•ion tlD'JI or ~ ·a"\OtNr a.it•r• Whft\ a ciita ptebt 
miws& a routot t la stored. Tn the routfr Ul'\tilthaoutput tr~n-smsm. lina is; UH ~d 
\s ct,.., --arlotward.d to dootlnallon bc,t. 

ll\O b-ic... tYI"' wldo .... nr.worl<s (WAN) u• a -llit• Qr ground Clldlo 
'Y'f"11L Alla,.,.,., iout•rot,avv ..,,_,.. tli-gj, .-hlch di.y c,,n -iv, di,, r_,-,3 
"19"1 fiam IN ... u. •. Whon ~ - CldiD ~ !s bm& u...t tlul mu..., can 
conwwnu,-, NCh olller, b may.i.o bo pasllilJto th.c"' •-rJ,, wbilt"""" 
-t•a m,ri,otheirau1puutluo,ljjhthtirmt......,od1ers.,. polo! tnpcmt t,YPO, 

..J 

1. Point the mouse pointer on the left margin of the document. The mouse pointer 
will change to an arrow pointing opposite to usual direction. 

2. Click the left mouse button only once. 

OR 

1. Place the cursor in front of the first character of the line. 

2, Press shift+end key. 

~Olt'l!9-,_ ~u,,.•---c.-, 
0 ~ Q ~ 6 tl. ~ Ill tl .-, t, C e 
Q c 

. , 
SUppo• in!oanah:m ha• !o be ~d from tetmloal 3 to 1, li wlll u_ .. Bu• A and ii 

a,ieply h.u to b, ~ ba<l<(.lmm 1 to 3) it w-lllu"' lil• B. 

W .I.. D E A,Jl E ,t... . N E T W O R ~ S ( w A II l 

A wide am, netwon< eonna::t• c,,mput•rs which are w i:y n!mD!.tly p~d. It may 
coru'l«::t &."TOfS'thi! (!otlnftiu or ca'ltlrtmrs or the m.itire. gk)be. Wide Area l\letworks are 
Alm ,,..,,red to as Long Haul Networks (LHNs), 

Wu!£ aru nerwot:ks 01D eltbet bo point to point t)'Pi or broadcast t~. 1h a poi\t 
to point type m,t,,orlc, the ,oua:,e and. the destinotlcn ma,h "'"' Ate """""'ted. tD ec 
other via .... ,.1 in._nnedlate noute~ A point to point type Ntwork may be teparated 
into two palls-Iha ho,ts md the '"1bnet. The machi<I•• betw""' whd\ cominunll.Uon 
1s to be e,rab~ an, c..U.d hoJt• The host.• a.re cau,ocu,d to aadi other by what is 
mown as the subnet- The -Subnet oonmts 0£ !he tainmuss!on lines (,;,oaxl.,l cab Ii!~ Dbre 
optic cab Its etc.) .1nd the lntermedlate awlldiing elom,ntsai,o c:aU..d 'routtr:s'. The mat\ 
luC><.'tlct\ o! a rou,or is <o rec-ivt! tl\e tran,milted d.al.! 1'1'td thm •loct .1n appropriate 
cham,el lo iocward it to the ds,tlNlion host or to aoo<hu router. W..C.. a eula pacbet 
~s at a rout~t It is •ottd U'\ the min~r: until the output trat'llrl"Jaio:'i tine- lS free and 
is then ttanrnilted or io"'l'ard.d to d.estihatloo hoot. 

The br31d.c•• w wide area network,; 5AM u ... sm,llile or r=d mdio 

"9181 lrom the S11•llit~. When a i;;round radio •y,i,,m Is beil>g WIid th• rourecs can 
conyn lcale belwam s.;ach other. n may .aJ.o be pout>!. th.al In a notwo<k. whU. """"' 
routers rceM! their outputs lb rough their ant~ othera al!t poht lo point type. 

D ~ .ii ,f ,~ Ii:! ,. - .t . A. • = 
-ftj< ~ 

. " 

.:J 

• 
.11 
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fo select a paragraph: 

I. Place the mouse pointer to left margin of the document and double click. The 
entire paragraph will be selected. 

OR 

1. Place the cursor on the first character of the paragraph. 

2. Press ctrl + shift + down-arrow keys. 

W • 0 L A L LA N C T W 0 t l S ( W A N ) 

A 'flf\df - ~ rk OIJMilCU CUftXllt" Wb¥h llN ""f(Y mrv:,t.,t, p\o.d. ll trwy 
~ ,<ltfO• tt..a:::l!WlbWt or am.ur ... • or d)f l'fl.l'bit g\obl, Widt. A.._ Niltwo.rb ani 

• _ ,.,._,. .. I.Dng,Ka,l,.,_ .... (l.f!N,i 

"-\At &IN Ntwo'.mtwi ubar bl~ to poku t,-pi, 11,11r ~ t)'F& fn • _port, 
to pdartype nitnr,od:; lN IOUD and the diHtin.111.s\ l'NChNf - ~ 1Q tlllldl 
Ofbt-t 'hl .,.,.tilll~f-~ m1.-ten. A polQI t0 (Xl,S'lt l)'pl' MtW4'k..,,_, t)ll, ~ 
t\10 tw..J puD- It»..,.. _,4 Iha! Albn«,. 1bt ~--~ W~ ~ C,,lt#II 
ll CD N ~ wd. U! ~d boas TM~ a. o:xina;ti1d to .t:. ~ ~ wtw, \f 
~ .. th,~ 1'.he a)br-.et dal\lUh ottht omlfl\&al»Cl im.. (c,Mlf.1111~ £&,a 

Of>'~Clib\n«c,) andtbt 111~•1W111zd1Yt.afltmn!ts,.:., ~ 'mu...-. 1'1W-l'Niln 
ft.11,CO:a:a oJ • m1uu. • t0 ~ lh• traillldttd ~ an.! thlr\ ltilct o ~ ,.. 
~ 1!0 b.Matd It Co dwda•tWa:i boaocw..,atl,,a•u Mtm • daAp,w.mt 

.. ~ ••• • r i:il~V\ IM'mt.t11r~ntil.t.M~tt~h•t.au1 
illtt\d~~OS~b~...._ 

ti •t!l--.tI 
,1,o, ,:. -· -..o~a4o .Ii;: ,.· -'·4· • e••. 

Edit ➔ Undo/Redo Command 

Sometimes, after making certain changes, it is desired to annul those changes made. 
MS-Word provides a command for undoing whatever was done in the previous step. 

Undo 

1. Click on the Undo option under Edit menu 

OR 

Click on the Undo button on Standard toolbar 

OR 

Press Ctrl+z. 

The undo option displays all the recent actions, which MS-Word can undo. You can 
select from this list the appropriate actioh to be undone. 

Similarly, sometimes, after undoing certain changes, it is desired to reapply the action 
undone. MS-Word provides a command for redoing whatever was undone in the 
previous step. 

Redo 

If an undo'has to perform on the last reversed action that is known as Redo. 

To perform }edo you can: 

I. Click on the Redo option under Edit Menu 

OR · 

http:Irt.--.ui


Click on the Undo button on Standard toolbar 

OR 

Press Ctrl+y 

Edit ➔ Cut and Paste 

Cut operation removes the selected object or objects from the present document 
and puts these into a memory area calted clipboard. The objects may be text or picture 
or table or virtually anything tbat is available in the document. Paste means 
copying the content(s) of the clipboard at tbe specified location in the present 
docwnent. 

To cut text or an object: 

I. Select the text(s) or object(s). Text/Object can be selected in various ways. 

Any amount of text <Drag over the teit> 

A word Double-click the word. 

A graphic Click the graphic. 

A line of text Move the pointer to the left of the line until it changes to a right-
pointi.ng arrow, and then click. 

Multiple lines of text Move the pointer to the left of the lines until it changes to a right-
pointing arrow, and then drag up or down. 

A sentence Hold down CTRL, and then click anywhere in the sentence. 

A paragraph Move the pointer to the left of the paragraph until it changes to a 
right-pointing arrow, and then double-click, or triple-click 
anywhere in the paragraph. 

Multiple paragraphs Move the pointer to the left of the paragraphs until it changes to a 
right-pointing arrow, and then double-click and drag up or down. 

A large block of text Click at the start of the selection, scroll to the end of the selection, 
and then hold down SHIFT and click. 

An entire document Move the pointer to the left of any document text until it changes to 
a right-pointing arrow, and then triple-click. 

Headers and footers In nonnal view, click Header and Footer on the View menu, in print 
layout view, double--click the dim.med header or footer text. Move 
the pointer to the left of the header or footer until it ch~ges to a 
right-pointing arrow, and then triple-click. 

Comments, footnotes, and Click lo the pane, move the pointer to the left of the text until it 
endnotes changes to a right-pointing arrow, and then triple-click. 

A vertical block of text Hold down ALT, and then drag over the text. 
(except within a table cell) 

I. Select cut from Edit menu 

OR 

Click on the cut fil button of standard tool bar 

OR 

Press the ctrl+x button 

OR 
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Move the mouse pointer on the selected text and right click and select cut as 
shown below: 

--~-- ...... • ,,. • .,. "& 'll ::!li.a•.ar • -

. . 
!app...- 1:i»-....hailta _,.~_...._.,,IIO L ew&... ...... .._ 

•-ea,t .... soi..-...-0-z .. )it..Oua~,1 

,. o.1g .. . .... ,1,. ... . ., . ... -. 
To paste from the clipboard: 

l. Move the cursor at the location where the text/object is to be pasted. 

2. Select Paste from Edit menu. 

OR 

Click paste 

OR 

Press Ctrl + v 

OR 

button on the standard toolbar 

Click the right mouse button and select paste from the context menu as shown in 
the Figure. 

Edit ➔ Copy and Paste 

WI Ol ..,\11! .l.A ~- •* O t , r {...- .... , 

w.-----~----,-.•pdlri~-......_~,.,... •. ,.._, .,....,.._._.., __ _. .... ...__.........,.....,.. _ _. 
............. ~~"-~•P=*'""~"' ....... 
..., .... ~ ....... Q ..... ,.,.,Mdi ..... ,_....~~ •'-'"'....._. ....... .._. .. _______ ........ -, ... . ......,., ...... ,,.. ......... ~ ... .....,., .... .. 
~ .... &,\ ..... ~ . ..................... _ 

~~ • .., ......... *~'-'-... ..,--~ 
...., ........ , ........... Gl ..... l ......... ,f ....... _,. ..... ., .. ~-'-.. ....,~~--........ ·------.. ~ ....... .,..._ 

,..,...._.,,,..-"'-.-.... 
;::..:~-==--~.-;::::: .... ::::,•~==:..::..==::i: 
::::':,--=.=:,n=: :,__ ., __ 

·­-

Copying is duplicating the selected text/object of a document at some other desired 
place in the same or different document. The procedure for copying text is almost the 
same as that of moving text with the only difference that cutting removes the object(s) 
cut from its original place whereas copying leaves it as it is. 



To copy a particular text/object: 

1. Select the text or make the block of the text. 

2. Select copy from Edit menu 

OR 

Click on the copy 

OR 

button of standard toolbar 

Press the ctrl + c button 

OR 

Move the mouse pointer on the selected text and right click and select copy as 
shown in the Figure. 

,.. i- .. - - ,.. ,,... - ... .,..._ • " 

0.1 11 ,i '!:I • llv:, -.. ,.,. •' •" · a 110:.a ■'.4lm" , .... . -r. - . .. . ■ , o • •~E 

•a •• -----' . 

s.._.. b6,_lwt<>bopaoodmnt<imw!St<>l, l.,1lluaa..A .. dU 
•~l)'l'-..tat»-.r.b«k(.!Gmt to,) itwUluclu•B. 

W I O f A. 1 ..,:1 A H I T 'W O a. IC; S ( W ,- N ) 

Widl ... Mtwarb(Ml 1.11\trbe poatt topo!r\ttype Or~ t)'pl. rn •FObt 
t.o ~t n.tworlf. tN «a.JO 

,t.mol10 ~--· - -""""' """ i.-... ....... _ 
~A~o~ ~ -

lfg,lalflCffi l -
:omntu'I .... ,..,. 

- I""""' co1,.., ltul --..-.Tho ..... 
awldwl •l,c:t---­

au.ar.Nml•dm~ 
- ._,...-,11no1,,-a,d 

... Ute Of gl'Qlll\d r.tlo 
d'-.-ycan caQli:w the~ 

• ll btq uttd. tti. 11JU1t:r.CW\ 
INllr>•-1!<. wllillllDltlt 
-----"'~ • ••'-~"'"P'!• 

Paste operation is the same as descn'bed in the cut and paste section. 

Edit ➔ Find, Replace and Go to Options 

Sometimes, while working with a document you need to find a particular text or some 
fomiat or a special character or a page number, section number, comments etc. Find 
and its associated commands allow you to do just the same. 

To find a particular text/object: 

(a) On the Edit menu, click Find 

OR 

Press Ctrl+F 

OR 

Click at Find button in the toolbar. 

Find and Replace window pops-up. 
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r ~ att.nsf<U1d 1n: 

I ::J 

(b) In the Find what box, enter the text that you want to search for. 

(c) Select any other options that you want. To select all instances of a specific word 
or phrase at once, select the Highlight all items found in check box, and then 
select the portion of the document you want to search in by clicking in the 
Highlight all items found in list. 

(d) Click Find Next or Find All. 

To cancel a search in progress, press ESC. 

If you have to replace a word in the document with another word you can 
automatically carry out the replacement. For example, you can replace all 'Acme' 
appearing in the document with 'Apex.' 

To replace existing text/object with another text/object: 

1. On the Edit menu, click Replace. Thr. . !"J.d and Replace dialog box appears. 

fi'4 ROQUKe I i:) To I 

II 

2. In the Find what box, enter the text that. you want to search for. 

3. In the Replace with box., enter the replacement text. 

4. Select any other options that you want. 

5. Click Find Next and Replace repeatedly to replace interactively, or Replace All to 
replace all the intended objects automatically. 

6. To cancel a search in progress, press ESC. 

In a similar manner you can find and replace text fonnatting, objects, spaces -and 
anything that is listed in the Format and Special sub-menus. 

Edit ➔ Use Wildcards To Find and Repi'ace 

You can also specify a pattern using wild card (* or ?) in the search string. For 
example, use the asterisk (*) wildcard to search for a string of characters ("s*d" finds 
"sad" and "startea''). 



r111rJ dr,d Hepl,H f.: 

Find. IR~ l it)To I 
F,adwbat1 $"' 

OptJons: use ~ds 

W ~ al terns fOUld rn: 
IMaln Docllllefit El 

SNrchOptb,s 

[:i M.!t(il 

r r j 

wu-'llllclcards 
r ~.,. CEncillsh> 
r Find a1 pd f01'1'115 <EnoWi> 

l] 

I.es& • 11 find"' 1 _ ,_ance1 _ _, 

Find --------------,-------------

~- 5'>ll(WII. 1 , • ..,..r-;,n,/1,atlir. 

1. On the Edit menu, click Find or Replace. 

2. If you don't see the Use wildcards check box, click More. 

3. Select the Use wildcards check box. 

4. Enter a wildcard character in the Find What box. Do one of the following: 

(a) To choose a wildcard character from a list, click Special, click a wildcard 
character, and then type any additional text in the Find what box. 

(b) Type a wildcard character directly in the Find what box. 

5. If you want to replace the item, enter what you want to use as a replacement in the 
Replace with hox. · 

6. Click Find Next, Replace, or Replace All. 

7. To cancel a search in progress, press ESC. 

When the Use wildcards check box is selected, Word finds only the exaict text you 
specify. (Notice that the Match case and Find whole words only check boxes are 
unavailable - dimmed - to indicate that these options are automatically on; you can't 
tum off these options.) 

To search for a character that's defined as a wildcard, type a backslash (\) before the 
character. For example, type \? to find a question mark. 

3.5.3 View Menu 

MS-Word provides a wide variety of views for seeing your docwnent in different 
ways. Various commands under View menu facilitate this action. To access the view 
menu click on the view menu of press alt+ v from keyboard. 
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MS-Word 2003 provides the following options to view a document in different styles. 

1. Normal 

2. Web Layout 

3. Print Layout 

4. Outline 

5. Full Screen 

View ➔ Normal View 

In the Normal view you can only view the Horizontal ruler instead of both horizontal 
and vertical ruler. It does not display the margin areas of the page that's why you can't 
see the headers and footers. 
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aa<:h ,u: p"ri"ten, rnott..rn.tl!tc:.. 'Thia cuts down a~ on t.ha hard.w&m •qulpf"rent cc•. 

S..i&to eoaxial oabliaa, a plug-in ¢ .rd ia abo mquired a::lr tYC:.h contpu.teri TI\e: 
COID(\al cab•• c:or.nect th\11 ptug,-~ card,• of U\e oct.r'\PU'~" tO -'onn. l'l~WO(-k; ~\ti 
-,&ware ia.alao r.qµI..N!d iar the ~Ork.to op•r.irte-

AU looalaur.a n•r,.,.otks ttw\at.r dat.a la dig\t.al 6olTl'\• a t\f&t\ ~d .m,d have ._~.., 
b'nplen-wr,t'.'atlDn oo_.. 
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~ 

The advantage of the Normal view is that you differentiate between the Soft page 
break (one that MS-Word gives you when the text flows out of one page), which will 
appear as horizontal line running across the page; or a hard page break (one which you 
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insert to end the page before it goes full) which will appears as dotted horizontal line 
with the MS-Word's Page Break as shown below: 

J,11,,,, .,.,.., ........ ,. .... ,., _, - ·x 
c;o llOt - ,_ - - - ~-~ . ,. 
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~ dual bus Mlps tho tran~ ol dffll II' both d.l.m:tions "'""-'~--,u•ly. 
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also lWkmld to•• Lang Raul Nalwod<s ~-

Hard Pa.lS'---½---t~ --------------- •-'"""'-----------------· 
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i&- t Q ba- ~lished. ate c:alli!:d hQ«.s.. ibe ho«& a re. connac:t.d to «ch other by wb.at la· • .. • ~, J . - . . . . . . .. . . . . . -

View ➔ Web Layout Jliew 

•J 

.. . 

With the help of Web Layout view one can view the document in the way it will 
appear when opened with the web browser. Clicking on Web Layout under View 
menu sets the Web layout view as shown below: 

~ t 1, • I' 1', , .. , ,, ,,11 \Y~ ,I _ - ')( _«- __ _ 

Cl ..w: W id ti • I> Cl' 
',) C, ..... ---------~ ·..J•• -~ · · ·.:.· .... . . . , .. . .. .. -

I. ,0 c;- A l. 6.-. R, LA .N E -r W O R fr:' S ( L A N_ _ ) 
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Tola cut;.• down• lot on ¢ ff Nu1d'l_f.-ra equ,prcwnt c o•. 
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toop.-
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In this layout also the horizontal ruler is shown instead of both the rulers as in case of 
Normal view. But there will no page break displayed on the page in the Web layout 
view. The whole document looks as if it were a single page. 
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View ➔ Print Layout 

This layout is the default view layout. Print layout view gives you the view that will 
appear on the hard copy when printed. It includes both horizontal as well vertical 
rulers to tell you exact position of your text or picture in the document. It also shows 
you all the four, i.e., top, bottom, left, and right margins as well as the text you have 
typed in the header or the footer section of the document with light gray color. To 
change the view to Print layout, click on the Print Layout option under View menu. 

I 

To• li8U,.ta be.k:iw ct.pi?t:a th• two bu .. cantla:;I: ~A t:h.m. QO~~ 
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1
• e. 

s·Lt>po• ln6oanat:Jor,, h••O be p,a.._cl (n:>m.tean!ne1 ~to 1, ii: wllluN But A etd tl 
Aftipb,h.ule~--~•t.a!l);t'wllluaBua!I. 

ll<-l. .. O .. f. •. ,.__IL_(_,. N • T w b • "' • 
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( w "- .. l 

A wida ame necwork i:onnct9 C'Ol"Ppuc...-. whlcti am. very ~aly placed. It m,ay 
conn«'t' actoH th•c:ouaftl6• ot'02\tin.arc OT ttl.a cntlm g.k,be. Wida Am.a Natworb &l'!I 
aloo ..-...d.to aa Long Kaul Notwodao (Wit!jO. 

Wida aru """"orb cail dhar be point to point type or ba,ad<:a• t~. Iii • -poi:lt 
to poil::lt tYPJ, rwn.-ork th.a c,1,u1oe c:ad tM ~•Uticm rNtCh~u &ce CO'\nct:•d. t ... o aadl 

N QtM! Via •ve.m.l ir\t•trnR.dl.al• mutara. A point i.o. paint typei 'OCWOl'k m.a.y ba ~d 
kl:to bw'o pan ... tb.• hoc• a,d. the ..._bn.r~ TI'Wl nwcl:llne• ~ whk:h ~km ..... ~ .. . 

As you can see in the Print Layout view each and every page looks like a separate 
page of the notebook. 

View ~ Outline View 

Outline view displays the contents of your document in a traditional outline format, 
with text indented beneath beadings in a hierarchical structure. In this view. you can 
display headings, or any level of detail beneath the headings that you wish. Notice that 
when you are in this view there is an additional toolbar that enables you to open and 
close headings to reveal mo.re or le_ss detail and to promote or demote headings to 
change their position in the outline hierarchy. 

1. To change to outline view Select Outline from the view menu. 

2. Move your mouse pointer to the plus symbol to the left of the main beading. The 
pointer changes to a four-way arrow. 

3. Click the arrow symbol to select this heading and all of its subheadings. 

4 , Choose the Collapse button from the Outline toolbar. The entire subheading 
disappears. They have temporarily been collapsed of hidden from view. 
The wavy line under the heading indicates there are collapsed heading 
widemeath it. 

5. Choose the Expand button. The subheading will appear again. 

6. To restyle a heading to demote it one level or promote it one level, select it and 
then click the Promote or Demote buttons in the Outlining toolbar. Then click the 
appropriate heading style. For example, if you demote a heading formatted with 
the Heading 2 style, Word refonnats it with the Heading 3 style. 

7. To move·a heading (along with all the subheadings and body text it contains) to a 
new location in the document, drag its plus sign. As you drag, a horizontal line 



indicates where the heading will . appear. When the line 1s in the right place, 
release the mouse button. 
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If you like working in a completely spick and span environment, you'll like the Full 
Screen view. To switch to this view, choose Full screen option from view menu. Your 
document enlarges to cover the entire desktop. The title bar. menu bar, and toolbars in 
the MS-Word window are temporarily hidden to give you as much room as possible to 
see your text. If you want to issue a menu command, point to the thin gray Line 
running across the top of your screen to slide the menu bar into v iew. To view your 
document in full-screen click the Full Screen in View menu. Full screen view of a 
document is given below: 
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3.5.4 Insert Menu 

Insert menu helps you to insert various word objects and components in between the 
word document. Insert menu bas following options. 

Insert ➔Break Option 

,.io.-.. .. 
tlole-#'Odr,,e ... 

$Qf"" 
l)lkl. .• 

~ --· 
o,,;p,tt 

~ 

Om« 

Break option enables you to insert a break in between the page. This break can be of 
many kinds - page break, column break etc. To insert a break choose the Break option 
from Insert menu, which will give you the following dialog box. 

ll1e,1k l?~I; X J 

B'eaktypes --------
<♦'£iiJe&~ 
r-~brealt 
f' Text t,'applng break 

Sectlor'l~types 

("' ~tpaoe 

r~ 
('" ,venpage 
( Qddpage 

OK cancel 

Break dialog box has various choices. 

1. Page Break: It inserts a manual page break at the insertion point. At this point 
another page begins. 

2. Column Break: Inserts a manual column break at the insertion point. The text 
from this point becomes part of another column. 

3. Text Wrapping Break: Ends the current line and forces the text to continue below 
a picture, table, or other item. (The text will continue on the next blank line that 
doesn't contain a picture or table aligned with the left or right margin.) 

4. Next Page: Inserts a section break and breaks the page so that the next section 
starts at the top of the next page. 

5. Continuous Page: Inserts a section break and starts the new section immediately, 
without inserting a page break. 

6. Even Page.: Inserts a section break and starts the next section on the next even­
numbered page. If the section break falls on an even-numbered page, Word leaves 
the next odd-numbered page blank. 



7. Odd Page: .Inserts a section break and starts the next section on the next odd­
numbered page. If the section break falls on an odd-numbered page, Word leaves 
the next even-numbered page blank. 

Insert ➔ Page Number Option 

This option is available on the Header and Footer toolbar. It inserts the page number 
of the document in the header or footer, as required. The page number is automatically 
updated with the increment of pages in the document. 

You can display or hide the page number on the first page of the document. To do so: 

I. If your document is divided into sections, click in a section or select multiple 
sections in which you want to display or hide the page number on the first 
page. 

2. On the Insert menu, click Page Numbers. 

3. Select or clear the Show number on first page check box. 

Insert ➔Date and Time Option 

To insert the current date and time: 

l . Click where you want to insert the date or time. 

2. On the Insert menu, click Date and Time. 

3. If you want to insert the dale or time in a different language form.at, then click the 
language in the Language box. The Language box includes a list of the enabled 
editing languages. Additional date and time options may also be available, 
depending on the language that you selected. 

4. In the Available fonnats box, click a date or time fonnat. 

5. Select whether you want the date to automatically update or to remain as 
originally inserted. Do one of the following: 

❖ To insert the date and time as a field that's automatically updated when you 
open or print the document, select the Update automatically check 
box. 

❖ To maintain the original date and time as static text, clear the Update 
automatically check box. 

Insert ➔ Inserting Pictures 

You can insert into your document pictures, graphics etc. called clips. Word provides 
an in-built ClipArt gallery that contains many pre-designed clips. To find a clip: 

I . On the Insert menu, point to Picture, and then click Clip Art. 

2. In the Insert Clip Art task pane, in the Search text box, type a word or 
phrase that describes the clip you want or type in all or some of the file name of 
the clip. 
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3. To narrow your search, do one or both of the following: 

❖ To limit search results to a specific collection of clips, in the Search in box, 
click the arrow and select the collections you want to search. 

❖ To limit search results to a specific type of media file, in the Results should be 
box., click the arrow and select the check box next to the types of clips you 
want to find. 

4. Click Search . 

........... i.- ... ....... ...... . 
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To clear the search criteria fields and begin a new search, below the Results box, click 
Modify. 

This will insert the selected clipart in your document at the specified place. 

Insert ➔ Inserting a Clip from the Clip Organizer 

You can insert clips from the cUp organizer. First you have to find the media clip you 
want to insert. To do so: 

1. On the Insert menur,poin.t to Picture, and then click Clip Art. -....._ 



2. In the Insert Clip Art task pane, in the Search text box, type a word or 
phrase that describes the clip you want or type in all or some of the file name of 
the clip. 

3. To narrow your search, do one or both of the following: 

❖ To limit search results to a specific collection of clips, in the Search in box, 
click the arrow and select the collections you want to search. 

❖ To limit search results to a specific type of media file, in the Results should be 
box, click the arrow and select the check box next to the types of clips you 
want to find. 

4. Click Search. 

S. Now, in the Results box, click the clip to insert it. 

Insert ➔Inserting Image from A Desired Location 

I. Place the cursor where you want to insert the image. 

2. Choose From file option from Insert->Picture menu. The insert picture diaJog box 
pops-up. 

3. Select the desired folder. 

4. Select the desired picture. 

S. Click on the insert button. 

Inser t Pic ture 171rx I 
Lookri: lo ~Pich.res 

~ 
Hstory 

~ 
Favorles 

~ 
My Net.wont 

Places 

Blue hills 

Winter 

Ffe[l11111e: 

Fies of~- jAI Plct\J'es 

Insert ➔ Drawing Shapes 

Sunset 

You can draw various types of shapes in a word document with the help of drawing 
toolbar or from the option Auto shapes from Insert->Auto shapes. These shapes can 
be rectangle, oval, arrows, callouts etc. To draw an auto shape: 

1. Click the Auto shapes button on the Drawing toolbar. You will see the pop up 
menu shown on the next page. 
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2. Select the auto shape you want to insert your document. 

3. The selection will change the mouse pointer to plus shape. 

4. Place it and drag it according to the size of auto shape you want. 

5. Release the mouse button. 

Word Art 

WordArt lets you add fancy style to the fonts of your text. It provides a different 
look to your text as we!J document. It's perfect for creating flashy headings and 
titles. 

To insert a word art in your document: 

t. Click the place on the document where you want the WordArt image to be placed. 

2. Choose Insert, Picture, WordArt or click on 4 
W ordArt Gallery dialog box. 

icon. This will open the 

Y"11<IAr1 l,dlle, y .. I? rx 



3. Choose the desired format and press Ok button. 

4. Edit WordArt dialog box opens. 

5. Write the desired text in place of Write your Text Here. 

6. Select the desired Foot and Font size. 

7. Press Ok button. 

You can always double click at the wordart and modify its properties. 

Insert ➔ Inserting a Bookmark 

A bookmark is an item or location in a -document that you identify by a. name for 
future reference. You can use bookmarks to quickly jump to a specific location, create 
crqss-references, mark page ranges for index entries, and so on. 

To add a bookmark: 

l. Select an item you want a bookmark assigned to, or click where you wa;ot to insert 
a bookmark. 

2. On the Insert menu, click Bookmark. 

Bookmark I ? II X I 
eookmark namei 

Sort by: r. Name r Location 

r !jidden bool<rnaf ks 

I iJd I [ti~ 

Cancel 

3. Under Bookmark name, type or select a name. 

4. Click Add. 

Bookmark names must begin with a letter and can contain numbers. You can't include 
spaces in a bookmark name. However, you can use the underscore character to 
separate words- for example, "My_heading." You can use bookmark witlll the go to 
command in edit menu. 
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3.5.5 Format Menu 

Once the text of a document has been typed, you would like to give it the looks and 
layout suitable to your needs. This is referred to as formatting. Formatting affects the 
appearance of the document rather than its textual/graphical contents. MS-Word 
provide format menu to give a meaningful format of your document, so that a user can 
read and understand the document in an easy manner. Following are the options 
available in format menu. 

ui:;::=--.;.,c:::;_,,~:.:.., t,ilp 

• & fi □ Gil D ~ 6'J 1r 100% • fJJ • 
g. e•~ ... 

. ~== 1Uetsandlf..rl!betno .. , 
o--------- llol°'1sft!5hocln;. .• 

• !:<lbms .. , 

Cho,,Qo~ .. 

~ 

U;iome ... 

FIJ,nos 

&l.domwit ... 

~ ar-dR,m~ .. 

l<l'iJ>II~ ... 

Format➔ Formatting Font 

4 

, rovides you a w;ry to store and quicl<ty insert te 

~

tc (that you use frequently) fn the document. Mi 
It-in AutoText entries that are divided into diffe 
Mr\9 on a tetrer, MS.Word can offer letter-spec 

d closings. 

Font means the design/looks of characters. They are the character sets that you used to 
type the text in your document. As each and every human being has a unique writing 
style, they may be thought of as using different fonts. All the font characteristics i.e. 
the font type, font size, font style, font color, character spacing etc. can be modified 
through the Font command of Format menu. 

Changing offonl using the font list 

This is a quicker way of changing a font as compared of using the font dialog box. To 
change the font using the Font list: 

I: Select the text. It can be a page, a paragraph, a line, a word or a character. 

2. Drop down the Font list box sitting in the Format toolbar. It wilJ show you all the 
fonts available on the computer. Scroll down the list to find out more fonts. 

'.3. Click on the desired fonl 

Word places the fonts you use frequently above the double line in the Font list box. 

Changing of font using Font dialog box 

Changing the font-using Font dialog box gives you the opportunity to see the result 
within the dialog box before applying it on the text. Other benefit of using the font 
dialog b0x is that you can apply several effects within at the same time affecting 
various characteristics of the font. 
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l . Select the desired text to change the font. 

2. Select the Font option from Fonnat menu. 

FOQt I Chatacter SpacrlQ I Teg,t Effects I 
fort! Font stx;le: ~ : 
ni, • ..-------- lRegular ..,..111--

. !Nack 
Narrow 

· Rotrded MT Bold 
lal Lncode MS 

~ ~e!. Ro 
Bokl nalic 

~ ~ . 
~g,10,1 i.r,dethstyla: 
1---~-omatlc---..3........ l<none) .J 

Effects ----------------------
r ~OU!ti 
r ooutite ~~ 
r~ 
r~ 

r- Arial 

OK CMlcel 

3. Scroll through the Font list and click the font that you want. 

4. Select the color; underline style and other effects of your choice. 

5. Select the font style according to the text. 

6. Click on Ok button when done. 
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You can use fonnatting toolbar for all these operations to make your task much easier 
and faster. You can change the following from this toolbar: 

• Font 

• FontType 

• Bold, Italic, Underline 

• Make bulleted list 

• lndentatiori of paragraph 

• Border 

• Text Color 

• BackColor 

TecTriting 

Style 

Alignment 

I 
Font 

• 11 

l 
Font size 

Bold 

.,.A.] 

Hil T 
Foot Color 

Border and 
shading 

Besides, you can also use key combinations for some of the formatting actions. 

Bold: 

Underline: 

Italic: 

Increase font size: 

Decrease font size: 
,· 

Ctrl+B 

Ctrl+U 

Ctrl+I 

Ctrl+Shift+> 

Ctrl+Shift+< 

Format ➔Paragraph Formatting 

Fonnatting of paragraph includes the following: 

1. Indentalion of paragraph 

2. Alignment of the paragraph 

3. Changing Line spacing 

4. Tabs 

To do the above you need to choose the Paragraph option under the Fonnat menu. 

When you click on the Paragraph option you will be able to see the following dialog 
box. 



lnderQllan -

I.Ill: jo.s- :5 
~ jO" :S 

Speci,Q -
&,lore: ... ,o pt--:S .... 
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r 

Indentation of Paragraph 

Indent is the space left blank within the page margin. You can indent your paragraph 
from the left and right margins. You can also create first-line indent, which indents 
only the first line of a paragraph, or a hanging indent, which indents all of the lines in 
a paragraph except the first. Indentation can be set in various ways: 

Indentation through Paragraph Dialog Box 

Indentation through Paragraph dialog box is probably best method for yon. To indent 
a paragraph: 

1. Click in the paragraph which you want to indent. 

2. Select Paragraph option under Format menu. This will brings up the above dialog 
box. 

3. Click the Indent and spacing tab. 

4. Under Indentation, type the measurement tba~ you want to indent the paragraph in 
the Left or Right text boxes. 

5. Click OK button. 

Indentation through Increase Indent and Decrease Indent Button 

If you want to set a left indent at a half-inch increment on the ruler, yo1u can do it 
through the increase indent and decrease indent buttons on the formatting tool.bar. 

1. Click in the paragraph you want to indent. 

2. Click the Increase indent button to increase indent and Decrease· Indent button to 
decrease the indent. 

Set an Indent with Indent Marker 

Follow these steps to set an indent by dragging the indent markers: 

1. Click in the paragraph that you want to indent. 

2. Point to the indent marker that you want to use. 

3. Drag the indent marker to the right spot on the ruler, and release the mouse 
button. 
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Paragraph Alignment 

Alignment refers to the way the right and left edges of a paragraph line up along the 
right and left margins of your document. Word gives you four alignment choices -
left, centered, right and justified as shown in the below: 

By default, word keeps left alignment. To change the alignment of the paragraph: 

1. Click on the paragraph in which you want to change the alignment. 

2. Bring up the Paragraph dialog box as stated above. 

3. Choose the alignment from alignment drop down list. 

4. Press the Ok button. 

Alternatively, you can align paragraph wi ,~ the alignment button in format toolbar. 

Left align Center align Right align Justified 

Changing Line Spacing 

Line space is the space between two lines in a paragrapb. By defauJt it is single­
spaced. To change the line space: 

1. Click the paragraph in which you want to change line spacing. 

2. Bring up the Paragraph dialog box. 

3. In the line spacing list box select the space you want in between the lines or write 
the number in the text box if you want to choose the last three options under the 
Line spacing list box. 

4. Click the Ok button. 

Alternatively, you can use line spacing tool button in the format toolbar. 

t~ · l= := •: 
E] 1.0 

1.5 

2,0 

2.5 

3.0 



Format ➔ Tabs 

Tab is a position you set for placing and aligning text on a page. You can move on a 
line from one tab position to another by pressing Tab key. This approach does not 
require manual spacing that you would do otheiwise to align lines in a column. 
Microsoft Word has a variety of tab stops, as shown below: 

I 

Left text extends to the right from the tab stop. 

Center text is centered at the tab stop. 

Right text extends to the left from the tab stop until the tab's space is filled, 
and then the text extends to the right. 

Decimal text before the decimal point extends to the left, and text after the 
decimal point extends to the right. 

Bar tabs generates a bar. 

To set tabs: 

1. On the Fonnat menu, Click Tabs option. 

lab stop postion: De[d tab stops: 
------- la.s~ 

~ ----------~--
(.' Left 
f"'QecJMI 

LMder 

(' ~er 
r aar 

r. !None r i, ....... r 1---­
l"" f _ 

.__OK __ I _canr.e1 __ ,J 

2. In the Tab stop position box, type the posit ion for a new tab, or select an existing 
tab stop. 

3. Under Alignment section, select the alignment for text typed at the tab stop. 

4. Under Leader, click the leader option you want, and then click set. 

Leader is a character that fills the spaces between one tab position to another. 

Leader 

1. • • • •• .• •• •• •.• •• •• l ... ..... ............ Chapter ! 
2. • •• • ••• • ••.••••• - •• •• •• •• •• • - • - - •• • - • • - , Chapter 2 
3. • • • ••. . • •••• • •• . . • ••••.•. - • •• •• . •..• - . - . Chapter 3 
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Format ➔ Bullets and Numbering 

Word's bulleted and numbered list features add the bullets or numbers for you, and 
they create hanging indents so that when text in an item wraps to the next line, it 
doesn't wrap underneath the number of bullet. 

Word enables you to create single level lists as well as multilevel lists. 

Single Level Lists 

Single level lists are shown below: 

a,.- .... ~- .. --,. 
¥ • C • • • t. ::,rg '""" • (fl ! ;.-.,.._,. 

11 • 11 • ■ ~ II 

Input and 
Ou ut Devices 

1, .,., .... ....,__ 
------ •li.,..g(!IM !IN~"'" 

ob~ • o,,.i -...,._,_ 
• ~fild lllllft 

•W11"'"91..,0.U. 
•llotaJC.a 
• lbn1 
...... 0.. 
~ 

To create a single-I.eve! bulleted or numbered list: 

I . Click where you want to start a list. 

.. _ ·-
2. Click the Bullets == or Numbering 1= button on the Formatting toolbar. 

3. Type the first item in the list and press Enter. Word automatically inserts a bullet 
or number on the next line for you. 

4. After the last item press Enter twice to turn off the bullets or numbers. 

Instead of turning on the bulleted or numbered list feature and then typing the list, you 
can also type the list first, select it, and then cli_ck the Bullets or Numbering toolbar 
button. 

Changing the Appearance of Bullets and Number 

To change the appearance of the bulleted list: 

1. Click where you want the bulleted list to start. 

2. Click on the Bullets and Numbering option in Format menu to display the Bullets 
and Numbering dialog box. 



~ulleted I tpnbered I cytb Nunbered I list styles I 

• 0 

None • 0 

• 0 ■ 

•!· ► ✓ 

... ·• ► ✓ 

♦:♦ ► ✓ 

OK CancEW 
3. If you don't want to use a bullet given in the dialog box, click any of the seven 

gallery positions (Other than None), and click the Customize button t,o display the 
Customize Bulleted list dialog box. 

Customize Bulleted List I? II XI 

Qlaracter, .. I fictlze .. , J 
Bullet position --------=------

Indent !t: IO, 75" 

Text position ------------­
T aQ space

1
after: 

11" .±1 Inderita:: f 1" ffi 
~evlew -------------=--=---

•--­
♦----

♦----

---------
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4. Click the Characters button to display the Symbol Dialog box. Select the desired 
symbol or choose the others from the font list. 

Symhol [?-1IX 

fffll: I .... .=:J 

/X <L .;"/ ~ W B • a> l2I ~~d)l..<4~ ,-, 

CJ ~ I I i ffi ~ ~ -leJ ~ Q Ii!!!] ~ ii @ ..s 
~ ~ ~ ~ ~ 1:1 (Ir ~ ~ ~ © G ® ~ :l Fb 
~ ~ 0 • * 1I' 'Ga ♦- ~ I) Q. \;) ~ • ~ t5 
IL ® di_ nt> .n m. x' Y}, .,...... ¾ er I& • 0 ■ □ """"" 
C □ □ • ♦ ♦ .... ♦ 00 l2Sl X .@ • " ,,. a ..:J •·' 

B.IICerdy used symbols: 

l€ 1£1¥1Cl® l™l±l#ls l~l+l~ l~lµlal~I 
WlnlldnQ$; 32 Q,-acter code: 132 from· !symbol (decmal) .:1 

5. Click the OK button. 

Change the Appearance of Numbering in Number list 

I . Click where you want the numbered list to start. 

I OI( 

2. Choose Bullets and Numbering option from the Format Menu. 

I Cancel I 

Bullets dnd Nurnhering I? II XI 

~ed ~ ~JI O\ib Nurbered I USt Styles I 

None t 

1. ---

2. ---

3. - --

a) - - ­

b) - --

c) ---

r 

1) ---

2) ---

3) ---

a.---

b. ---

c. ---

OK 

1. - - --

11.---

111.---

(ustomu:: ..... 

I Cancel --------
3. If you don't see the Numbering that you want to use, click any of the gallery 

positions other than None, and click the customize button to display the 
Customize Numbered List dialog box. 
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1 font, •. 

. ~5t';le: 

Ii, 2, ~, ... .:.J 
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Te)ltposilon ----------
TIIQ 1'MICe after: 
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Pre\'lew - ,---- ------. 

1.---
2. ---

3.---

II OIC I a.al 

4. If you want to revise the format of the numbers, type the change in the Number 
Format text box. Choose the Number style from Number Style list box etc. when 
you finished click OK button. 

Creating Multilevel List 

A list created by using the Bullets and Numbering command (Format menu) to apply 
a hierarchlcal structure to any list or document, including a legal or technical 
document. A document can have up to nine levels, and Microsoft Word does not 
apply built-in heading styles to the items in the list. 

Outline numbered lists can have up to nine levels. 

I. On the Format menu, click Bullets and Numbering, and then click the Outline 
Numbered tab. 

2. Click a list fonnat that does not contain the text "Heading l ", and then click OK. 

3. Type the list, pressing ENTER after each item. 

4. To move an outline numbered item to the appropriate numbering level, do one of 
the following on the Formatting toolbar: 

l~ulle1s ,1nt.l flumlu•rlfl~ -;, X 

~ I ~ ~..,,_::::::Rll UatSt'tlls f 

B~J ~ · ~ a)-- 1,~ ►-==: • 
l)-- 1;1. 1.- •--

r------_-_-_ __ -_ -_ -_ ....-:_-_-_-_ 

Section 1.01 ll 1.1 /1,-J;nQ 1- A. IOI~ 1 
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To denote the item to a lower numbering level, click anywhere in the item and click 
Increase Indent. 

To promote the item to a higher numbering level, click anywhere in the item, and 
click Decrease Indent. 

Format ➔ Borders and Shading 

When you draw an object, it automatically appears with a border around it- a thin line 
that defines its shape. You can also add borders to text boxes, pictures, and important 
art. You can change or format a border in the same way you change or format a line. 

Follow these steps to add borders and shading to your text: 

k •'lf' •d ,npul 
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1. Click on the paragraph or text around which you want border. 

2. Click the Border and Shading option of Format menu. You will find the following 
dialog box. 

r.;: -
Borders <111d Sh,.11hnf! '? ,' X 
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If 
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rm- I Automatic 3 
~ 

~; mJ E]j 

~ 
I .•hpt 3 ~to} 

t:ystom 
jParagaph 

Showtoot,o, tfo,1zontal l.nl... I Ole 

3. Select Setting, style, color and width of the border. 

4. For shading click the Shading tab. 



1101 ders ,rntl \hd,llne f?1rx1 

llorders l e.&ltder ~ I 
fir--- -_-____ __, 
I Nofl 

rrrrrrc-
■--■■■1111 •••••••• ........ ........ ......... 
■rr r■■o 
isrrrrn■□ 

Patterns -­
Sttle: o Clear iJ 

..J 

Mge Cokirs .. , I 

Sl',Oll/ l oobar ~lft. .. 

5. Choose the desired shade. 

6. Press the OK button. 

You can also do it with the help of format toolbar. 

Format ➔ Working with Columns 

.J l. 

7 r 

Cancel 

You can use columns to create documents such as newsletters or book pages. The 
column option controls the width and number of columns. Narrower column widths 
make your text easier to read. Often, creating columns enables you to fit more text on 
a single page. Columns work particularly well where you have several shorter topics 
making up a larger document, as with a newspaper . 
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To create columns: 
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1. Select the text which you want to convert in column. 

2. Click on the column button in the Standard toolbar. 
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3. A drop-down list appears with four columns across it. Click on the first 
column in the drop-down List and drag across to highlight desired number of 
columns. 

4. Leave the mouse button. 

Adjust Column Width and Add a Vertical Line between Columns 

I. Click anywhere in the column-text. 

2. Choose Column option from Format menu to display the column dialog box. 

Columns ~~ 

Cancel 

Number of columns: 111 ffi (J 

Width and spacing 1-Preview 

~ol #: W{dth: ~acing: -
16" :fJ I ~ 1: 

I I ::::i I ~ 

I :3 1 ~ 

8i)pJy to: !whole d,ocument 3 r 
3. Click on the format that you want for the colwnn. 

4. If you have specific requirements for column widths fill it into the Width and 
spacing and fill the Number of column box. 

5. For line check the Line between check box. 

6. Press Ok Button. 

3.5.6 Tools Menu 

MS-Word is equipped with a number of software tools and utilities that enhance the 
user's work and provides extra word-processing power to the user. They help users 
make their work accurate and faster. These tools and utilities are grouped into Tools 
menu bar of the Ms-Word as shown in the Figure. 
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Spel/i11g a11d Grammar 

This utility, as the name suggests, helps users identify spelling and grammatical 
mistakes in the docwnent. Moreover, it offers suggestion(s) for possibk -:orrections, · 
from which users may choose the right one. For this MS-Word maintains internal 
dictionaries. At one time one dictionary is active. 

Online Spelling and Grammar Checking 

As you type, Word automatically checks your document and underline possible 
spelling and grammatical errors. Spelling errors by default are underli:ned in RED 
color and grammatical errors are underlined in GREEN. Note that the inc,orrectness of 
a word only means that the particular word is not available in the active dictionary. 

To correct the Spelling of words and Grammar: 

1. Right click at the word to check. A context menu will appear with a list of 
suggested correct spellings nearest to the word concerned. It also Jbas a list of 
command options. 

2. Select the best suitable spelling or grammar. The misspelt word is rep1laced by the 
word you chose. 

3. If you think that the word you typed is correct then you would like to add it in the 
active dictionary so that Word will treat it as correct word thereafter. You can add 
that word in the active dictionary using Add option . 
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4. If you don't want to add the word and yet you want Word not to treat it as 
incorrect, you can ignore it. 
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Using the Spelling and Grammar Checker 

The spell checker lets you check the spelling and grammar of an entire document all at 
once. You won't really need to use it if you use automatic spelling checking to fix 
your spellings. However, if you are worldng on a rather larger document, the spelling 
and grammar checker comes handy. 

To check your document with spelling and Grammar checker: 

1. Click on the Spelling and Gram.mar button of Fonnat toolbar, or Spelling and 
Grammar option on Tools menu, or press F7 key. 

Spelling and Grammar 

aom•;;e1 
2. MS-Word will bring you the following dialog box with the first error it encounters 

with.in the red color text and the suggestions in the next window. 

3. Sometimes, Word doesn't offer the correct spelling or the grammar for a misspelt 
word. If this happens, select the word in the top half of the dialog box and type the 
correct grammar or the word there. 

4. If the word is rightly spelled, then click the Add button to add it to the dictionary. 

The con 
develop 
an old o 
arter sp of cutling dl!l'm developmen 
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OLE and o,-nDoc 

5. To leave the word as it is, click the Ignore button. 

6. After finishing spell and grammar check click on the Ok button. 

3.S.7 Table Menu 

A table is made up of rows and columns of cells which can be filled with text and 
graphics. 

• Borders and Gridlines: By default, tables have a black ½-pt, single-line, and 
solid-line border. If you remove th.is border, you will still see the gridlines that 
form the cell boundaries. Gridlines, however, are not printed. 

• End Marks: End-of-cell and end-of-row marks are nonprinting characters. Like 
gridbnes, they appear only on the screen. 

• Cell Spacing and Margins: If you are using a table to arrange text and graphics -
for example, on a Web page - you can add spacing between table ceHs. You can 
also add cell 'padding' (spacing between the boundary of the ceU and the text 
inside the cell) by changing the cell margin. 



• Nested Tables: If you use a table to layout a page, and you want to use another • 
. table to present information inside the first one, you can insert a nested table - a 
table within a table. 

• Table Move Handle and Resize Handle: Use the table move handle to move the 
table to another place on a page, and use the table resize handle to change the size 
of a table. 

Table ➔ Creating a Table 

Word provides three methods for creating tables: 

1. Create table using Insert Table button in Standard toolbar. 

2. Create table using Insert Table option From Table Menu. 

3. By Drawing Method. 

Creating a Table with the Standard Method 

I . Place the cursor where you want to create the table. 

2. CLick on the Insert Table button on Standard toolbar. 

3 . Drag the mouse over the grid that appears while holding down the mouse button 
and highlight 4 x 2 table to create a table having four columns and two rows. 

Jllutur11fr111 Muro~td! Worn 
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4. Word will insert an empty table when you release the mouse button at the cursor 
point. 

Create Table using Insert Table Option From Table Menu 

1. Place the cursor where you want to place the table. 

2. Choose Table option from Insert option of Table menu. 
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3. Enter the desired number of columns and rows for table in the dialog box that 
appears. 

lnse,1 f11hle [?l/5c1 
Tablest2e 

Numberof~: 

~behevior 
t. Axed column rtldth: 

r- AIJ:of_lt to ccntents 

r Autofit to qow 

:B 

!Auto 

Table style: Table Grid Al,ltoFormat... I 

r Remember dmeMions for newt.ables 

4. Press the OK button. 

Table ➔ Drawing a Table 

OK Cancel J 

I. Make sure that you are in print layout view, (Taules and Borders menu is 
available only in Print Layout view) and then click the Tables and Borders button 
on standard toolbar to display the Tables and Borders toolbar. 

2. Click the Draw Table button. Your mouse pointer will look like a small pencil. 

3. Choose the Line Style and Line weight as desired. 

Draw 
Table 

Eraser 

Linc Style Line Weight 

Border Color 



4. Choose the Border Color as desired. 

5. Starting from the upper-left corner, drag dia~uu, llv down "l'lti to the right, 
releasing the mouse button when the outline is of the right size . 

• ,,., ..,... IJIIIU t, ...... 
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6. Now draw the inside lines for rows and columns . 
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7. Use eraser to delete any unwanted Lines. 

Entering and Editing Text in a Table 

l. Enter text in table just as it is entered in the MS-Word document. Use mouse or 
arrow keys to position the insertion point in a cell and then type the text. 

MS-Word will automatically wrap the text -within the cell as you reach the right 
edge. 
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2. To move from cell to cell within the table, use mouse or the Tab or Shift + Tab 
keys to move to the next or previous cell. If Tab is pressed in the last cell of the 
last row, MS-Word creates a new row. 

3. Since we use the tab key to navigate within a Table, we cannot use Tab to enter 
tab characters in the cell, use Ctr! + Tab keys instead. 

4. When a table is inserted, tbe insertion point is positioned in the first cell. You can 
start typing right away. 

Chl'l'k , our Progn.•" 

1. Define spell checker . 

. . . ~ .... .. .......................................... ................................... . 

2. Define alignment of paragraph. 

3. Define toolbar 

3.6 LET US SUM UP 

Microsoft word is a windows based word processing application. It supports vari,ous 
formatting features. Once started the application from the programs menu, you can 
create a new word document or open a pre-existing one. You can save your created 
documents as and when required. Before taking the printout of your document, you 
can examine its print preview and make the changes in page setup, if required. You 
can easily exit from MS-Word by clicking on exit button in file Menu. In MS-Word, 
Margins refers to the distance from text to the paper edge. It can be of four types viz. 
left, right, top and bottom. The distance between text boundaries and page margins is 
called indent. The indent can be positive, negative or banging indent. The text layout 
within a paragraph with respe-et to document margins is called text alignment. It can 
be horizontal or vertical. The total height of a line including extra spacing is known as 
line spacing. The standard line spacing is single, one-and-one half and doubJe. 

3.7 KEYWORDS 

Microsoft word: Windows based word processing application. 

Toolhar(s): A group of graphical shortcut buttons for executing menu options/ 
commands in easier and faster way. 

Cursor: MS-word printer, which tells where are the document the action will appear 
or affect. 

Scroll Bats: Sliders tbat can be moved using mouse to scroll through the document, 
exposing, different regions of the document. · 

Indent: The space left blank within the page margin. 

Alignment: The way the right and left edges of a paragraph line up along the right and 
left margin of the document. 

Tab: A position set for placing and aligning text on a page. 

Style: A set of t.bimatting characteristics that can be applied to text in a document 
quickly change its aJ)peaJ:Utt<c ·, 



3.8 QUESTIONS FOR DISCUSSION 

1. Differentiate between -"save" and "Save as•• file menu options. 

2. How is page margin affected by Gutter Setting? 

3. What is the use of various print options in word 2000? 

4. How different margins are numerically related to each other and to the page size? 

5. Write a short note about paragraph formatting. 

6. How to set tabs? 

7. What are column and where are they used? 

Check Your Progress: Model Answer 

1. The spell checker lets you check the spelling and gram.mer of an entire 
document all at once. 

2. Alignment refers to the way the right and left edges of a paragraph line up 
along the right and left margins of your document. 

3. A group of graphical shortcut buttons for ex.ecuting menu options/ 
commands in easier and faster way. 

3.9 SUGGESTED READINGS 
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Tools), Excel Books. 

Manoj Kumar, M. Shamir Bhudookan, Information Technology for 'O' Level, Editions De 
L'Ocean Indien. 

Joseph W. Habrak.en, Microsoft Office 2003 A/I-In-One, Que Publishing. 

Jennifer Ackennan Kettell, Guy Hart-Davis, Curt Simmons, Microsoft Office 2003: The 
Complete Reference, McGraw-Hill Professional. · 

Laurie Ann Ulrich, How to do Everything with Microsoft Office 2003, McGraw-Hill 
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4.0 AIMS AND OBJECTIVES 

After studying this lesson, you should be able to: 

• Explain MS-Excel 2003 

• Describe how to start excel 2003 

• Describe range operations in excel 

• Explain working with worksheet 

4.1 INTRODUCTION 

In the today's information age, no one can deny the role and importance of computers 
in everyone's Life. Behind this importance of computers, there li~s an important role 
played by various computer software. Spreadsheets are one of them. In this lesson, we 
are going to discuss one very popular spread sheet MS-Excel. 

4.2 MICROSOFT EXCEL 2003 

MS-EXCEL is a very powerful and easy-to-use spreadsheet package; perhaps 
the most commonly used these days. It is a member-application included in MS Office 
suite. It works very well with numbers and their complex calculations. 

Excel helps prepare yoW' data in an organized, orderly and meaningful fashion. Excel 
finds its major application in creating reports, using formulas and performing 



calculations. It is best sujted for scientific and statistical analysis. Excel can also be 
used to prepare Profit and Loss accounts, Balance sheet, and other Tax statements. It 
works well for both simple and complicated numbers. It can be used for preparing 
analytical reports including statistical analysis, forecasting and regression analysis. 
Good looking and attractive charts can be created which depict data in• clear and 
meaningful fashion. Excel can also be used to create relationships betweein different 
types of data. 

Excel can do all the work of a full-fledged word-processor but it lacks the advanced 
features of desktop publishing. It also supports high level features of object linking 
and embedding, which means in simple terms, that data from Word (so·also from any 
other program of Office 2003 suite), can be safely and easily put and linked with data 
in Excel and vice versa. 

4.2.1 Data Entry in MS"EXCEL 

The smallest unit of addressable data container in Excel is a cell. A c;ell is the 
room created by the intersection of a row and a column. Each row has a unique row 
number in a worksheet - 1, 2, 3, . , ... 65536; each column has a unique column name in 
a worksheet - A, B, C ..... z, AA, AB, AC .. ... N; and therefore each cell has a unique 
cell address in a worksheet - D 13, etc. 

A worksheet is rectangular collection of many cells. A single Excel 
worksheet contains as many as 65536 rows, 256 columns and therefore l 6777216 
(65536 x 256) cells. Each worksheet in a workbook has a unique name - Sheet!, 
Sheet2 etc. 

A workbook is a collection of one or more worksheets. Tt is a workbook that is saved 
as a file on the secondary storage. Each workbook is stored in a file having unique 
name - sales.xJs. Note that xls is the default file name extension of the Excel 
workbook files. Each Excel workbook can have maximum 255 worksheets. 

The relationship is shown below: 

Columns 

C E 
1 
2 
3 
4 
5 
6 )~ 7 
8 
9 I 

10 i 
11 
12 
13 

Jl 131 14 
12 141 ,sr 
13 15 I 
14 -l I . +--15 

Cell 
Workbook 
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4.3 HOW TO START MICROSOFT EXCEL 2003? 

To start Excel: 

I . Click on the Start button at windows taskbar. 

2. Select Program option. 

3. Click at Microsoft Excel option as shown below;; 
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Components of Excel Window 

A typical Excel 2003 window is displayed below. It may seem different in a different 
installation because the components of Excel window are customizable. 

The Excel window has the following parts: 

1. Title bar: Title bar shows the name of the application (Excel) and the name of 
workbook and situated in the top of the window application. 

2. Menu bar: Menu bar contains the various commands under the various topics to 
perform some special tasks. Menu bar is located under the title bar. 

3. Tool bar: Toolbar is collection of shortcut buttons to the Menu options 
represented by icons. 

4. Status bar: Displays current status of the application. 

5. Formula bar: Displays and allows editing of formula in the current cell. 

6. Name box: Displays the row number and colwnn name of the active cell. 

7. Help box: Allows you to type a topic and searches for help. 

8. Scroll bars: Allow moving the worksheet in and out of the window view. 

9. Worksheet tabs: Allow making the desired worksheet active. 

I 0. Task pane: Displays various commands l\vailable currently. 
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4.4 A SAMPLE SESSION w1m EXCEL 2003 

k 

• X 

Before we deal with the details of El{cel, let us have a short session with it so that you 
get a hang of what a session with Excel looks like. 

Creating a Workbook 

Let us start our session with creating a simple workbook. Note that when Excel starts 
a blank workbook opens its name by default being - Bookl . It has three worksheets­
Sheetl , Sheet2 and Sheet3. If you end the Excel session without entering anything in 
these sheets, Excel ends without prompting any message. However, whe1J1 you enter 
any data in the worksheet and then end the session, Excel prompts you with an option 
for saving the changes. Here you can provide th~ name of the workbook fifo. 

Let us enter some data in the cells of the worksheet- Sbeetl. Click at the ce:11 and type 
the data value as shown below: 
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If you want to modify the data entered into a cell, double click it and type the value 
again or press F2 function key on your keyboard. Once modified click the mouse 
elsewhere in the worksheet to update the value in the cell. 

You have thus created a workbook. Whenever you enter some data into a workbook. 
the workbook is created. However, it has not been saved. 

Saving a Workbook 

You can save a workbook in many ways. 

Close the Excel window by clicking at close button iii of the window. If the 
workbook has anything unsaved, Excel will prompt for the same: 

M1r10~-0fl [xccl ~I 

Oo you want to S8Y8 tho changes Yoll made to 'Bookt'? 

If you want to save the workbook, click Yes; if you do not want to save the workbook, 
click No; if you want to abandon the action and return to the Excel window, click 
Cancel. Since we would like to save the workbook, click at Yes. In response, Excel 
presents you the following dialog window: 

'-,111e A~ i'? ,rx: 
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listGry My Pictu'es 

' I~ 

! M'fOoa,netu 
I II 
I ~ 
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I 
Favortes 

j ~~ I I I I 
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Save as b'Pe' jMlcrosott Excel Workbook .:J l I flletw c-el 
-

Enter the file name - Myworkbook - in the File name box. Also choose appropriate 
folder name where you want the file saved in Save in box. Let us save the workbook 
file Myworkbook in the current folder My Documents. To do so, click at Save. Excel 
saves this workbook as the file Myworkbook.xls in My Documents folder. After the 
file has been saved, Excel application will end. 

Working with Menus 

Commands that let you perform desired actions are grouped into logical groups called 
menus. You will now learn what all menu commands are available in Excel 2003. The 
menus are: 

I Eile ~dit: ~iew insert FQ.rmat Iools Qata W,indow tfefp 



These menus provide groups of related commands. Thus, File menu contains all the 
commands related to file or workbook manipulation. 

These menus can be opened by clicking at them. Another way to .open these menus is 
to press Alt+(Undelined letter of the menu name). Thus, Alt+F will open File menu 
and Alt+o will open Fonnat menu. 

File Menu 

The Excel file menu has following options: 
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P~Al'ca 
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.Send, To 
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Working with menus is actually very easy. All you have to learn is meaning of each of 
the menu options. Observe the description of the menu commands. Generally this is 
how menu commands look like in all the Microsoft application packages. The 
symbols have specific meaning, as described: 

Command name The name of the command (usually self-explanatory) is 
given in words. Thus, New command opens a new 
workbook, Open command opens an existing workbook, 
Print command initiates printing, etc. 

Option shortcut 

Icons 

Ellipses 

Keyboard shortcut 

Notice . that a letter in each menu commands a name 
which is wider lined - like O in Open. You can, thus, 
open a file by pressing F+o while Alt key pressed. This 
is particularly convenient for users who prefer to work 
with keyboards instead of mouse. 

Some commands are preceded by icons that represent 
the respective commands. These commands can also be 
executed by clicking at tool buttons identified by the 
icon. 

Some commands are followed by ellipses ( ... ). By 
clicking at these commands dialog boxes will appear 
where you may choose options. 

Some commands are followed by key combinations 
like. Ctrl+O for Open. These are called keyboard 
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Sub-menu 

shortcuts. You can directly execute a command by 
pressing the keyboard shortcut, if any. 

Some commands are followed by the symbol ►. It 
means that this word is not a command but is a sub­
menu of commands instead. By clicking it, the sub­
menu opens up. 

You can apply various methods of invocation of the commands. Wi:. will now study 
• various frequently used commands in more detail. 

File ➔New 

Keyboard shortcut: Ctrl+N :: Tool icon: J Cl 
This command is used to create a new workbook. Click at it and the task pane will 
show the types of workbook you can open as shown below: 

New Wlll'lcboak 

QPef!awodcbook 
~ 
proposed books 
~ 
salary bre.,k up sales wise 

~More~ ... 

~ Add Network Place ... 

ij) Microsoft Excel He\:! 
~ Show¥. statup 

Click at Blank workbook option. A blank workbook opens in the Excel window. 

File ➔Open 

Keyboard shortcu t: Ctrl+O · · Tool icon: I~ 

..- X 

This command is used to open an existing workbook. Execute it and Excel prompts 
you to specify the workbook Y.OU wish to open. Navigate through the folders and 
select the workbook you want to open. Then click OK. Excel opens the specified 
workbook. You can open as many workbooks at a lime as you want. 

Let us open the workbook - Myworkbook. Press Ctrl+O to open the Open dialog 
box. 



~ My Data Sol.rces 

~ ~ MyMltslc 
ttstory ~,My Plcttxes 

-----~ l!]r-,yworl<book 

~ 
My Documents 

De5l¢op 

fl 
My Network 

Places !'Ms of bi>e jAI Microsoft Excel Files .:.l 
Select the file - Myworkbook. Click Open. The workbook will open. 

File ➔Close 

Keyboard shortcut: None Tool icon: None 

This command closes the active wor:kbook. If any data is unsaved since last save, 
Excel prompts you with saving options. Excel session does 'not end, it is only the 
workbook that closes. 

File ➔Save 

Keyboard shortcut: Ctrl+S .. Tool icon: llil 
This command saves the active workbook. If you are saving the workbook for the first 
time, you wiU have to specify the name and location where you want to sav<: the file. 
Excel appends .xls extension to name you specify. 

If on the other hand, this is not the first time you are saving the workbook, it will 
simply save the unsaved portion into the already named workbook. 

While saving a workbook you can also specify in what format your workboa,k should 
be saved. The various formats make the workbook compatible to other spreadsheet 
packages. For instance, you can save the workbook as HTML Web page that can later 
be open,d in a web browser. 

File ➔ Save As 

Keyboard shortcut: None Tool icon: None 

This command serves all the purposes of save command. Besides, it also lets you save 
the workbook by another name that you specify. 

While saving using either command, you can protect your workbook with a password 
by clicking at the General options in Tool menu of the Save As dialog box as shown: 
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This command will open another dialog box as shown below: 
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Enter a password to open the workbook and a password for modifying the workbook. 
The password is encrypted and is not displayed in readable form. Click OK to enable 
the protection. 

File ➔ Page Setup 

Keyboard shortcut: None Tool icon: None 

Page setup command allows you to setup -the page layout as you would like the 
worksheet to be printed. It is actually preparation of the worksheet for printing. On 
executing this command, the Page Setup dialog box appears. 
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Notice various options ~nat you can set. These options are presented in logi:cal groups 
on four tabs. A brief overview of these options is detailed below: 

File ➔ Page Tab 

l. Orientation: Whether you would like to print the worksheets in Portrait (top to 
bottom of the page) or in Landscape (left to right) fashion, 

2. Adjust to: This setting will reduce or enlarge the printed worksheet. Select the 
Adjust to check box, and then enter a percentage value in the% normal size box. 
You can reduce the worksheet to 10 percent of normal size or enlarge it to 400 
percent of normal size. 

3. Fit to: This setting reduces the worksheet or selected part when you pr:int, so t.1at 
it fits on the specified number of pages. Select the Fit to check bo,x, enter a 
number in the page(s) wide by box, and enter a number in the tall box. TL' fill the 
paper width and use as many pages as necessary, type 1 in the page(s) wide by 
box and leave the tall box blank. 

4. Paper size: You can select the paper size that you are using for pri11ting such 
as - A4, legal etc. -in this option. 

5. Print quality: You can select the desired print quality through this optio,n. The dpi 
(dots per inch) is the measurement of print quality. The higher the dpi, the better 
the print quality, while the more the consumption of ink. 

Margins Tab 

These options allow you to adjust different margins to the worksheets when printed. 

P11ge Setup • · 

Page [.~iji·j I Header/Footer I 
fop: 

ft ~ 
- r 

jo.75 :¼) -

ctottom: 

11 33 

Sl'leet] 
He§der: 

fo.s :S 

[iloht: 

jo.75 :fil 

E,ooter: 

10.s :ii 

Qptlon LJ 

Center on page - ---- - - - --- ----~ 

r Horptally r Y.ertlcally 

.__OK ___ I ___sa,,icel 

I. Top: Enter the distance you want between the top of the page and the top of the 
first line on the page in this box. 

2. .Bottom: Enter the distance yo- want between the bottom of the page and the 
bottom of the last line on the page in this box. 

127 
Word Spr<Jadsheet Software 



128 
Computer Application 
for Managers 

3. Left: Enter the distance you want between the left edge of the page and the left 
edge of unindented lines in this box. 

4. Right: Enter the distance you want between the right edge of the page and the 
right end of a line with no right indent in this box. 

5. Header: Enter the distance you want from the top edge of the paper to the top 
edge of the header. If the Header setting is larger than the Top setting, Excel 
prints the body text below the header. 

6. Footer: Enter the distance you want from the bottom edge of the paper to the 
bottom edge of the footer. If the Footer setting is larger than the Bottom setting, 
Excel stops printing the body text above the footer. 

7. Center on page: Select whether the worksheet will be centered horizontally, 
vertir.~iiy or both, on the page. 

Header/Footer Tab 

These options let you set the header and footer to your worksheet. A header and footer 
appear on the pages being printed even if you type them in a single page. There are 
many designs of headers and footers available in-built. You can also design your own 
headers and footers by clicking at Custom Header/Footer. 

PcJge Setup !"'? l!XI 

Page I Margins Header /Footer J Sheet I 

He~er; 

!Page 1 of ? 

Page 1of 1 e,int ... 

d Qptlons ... 

~ustom Header .. , Cy_stom Footer... j 

(none) 
(none) 
Page 1 
Pa 1 of? 

Excel Books Pvt Ltd Confidential, 1/14/2002, Page l 
M workbook 

OK Cancel 

Sheet Tab 

These options let you specify how the worksiets will be printed in case there are 
more than one. 



Page Setu1> 

Page I Margins I Header /Footer L. Sheet .. I I 
Print !ll'ea: 

Print titles ----­

B.ows to repeat at top: 

~olumns to repeat at left: 

Print ---- ---

r ~ tines r Row and column headings 

r e_tack and white 

r Dr aft guaftty 

ll 

3J 

Comments: l<None) EJ 
Cell ~rors as: !displayed E] 

Page order ------------------

r. Qown, then over 

r Oyer, then down . II ---
--

_ er_mt~ 
Print Prnvie~ I 

Qptlon~ 

.__o_K _ _.I - ~~el I 
The options are self explanatory. You should try them on your own. 

Whatever page setup option you apply, you can see its effect using Print P1review. 

File ➔Print 

Keyboard shortcut: Ctrl+P · · Tool icon: , ~ 
This command lets you set the printer options just as Page setup did for setting page 
options. 

I 

Print 

inter----------------

Name: 

Status: 

Type: 

Where: 

Comment: 

j~ Microsoft Office Document Image Writer 

Idle 

Microsoft Office Document Image Writer Driver 

Mlcroso~ Docum~ Imaging Writer Port: 

'-------~------- - - -- -- -
Print range- ---------- fCopies 

r. All ---.·d Number of topies: 
r Page(sf' from: I :B Io: I :B 
-------

r Entire workbook ..... 1 _ ~_,_

2

_

3 

__ ~ _

12

_

3 

____ ..,,.__ _ _, rintwhat 

r selection 

r. Actiy_e sfieet(s) 

Previe~ OK 
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The various print options are summarized below: 

I. Name: You can select the printer you want to print on if there is more than one 
printer is installed and set its properties by clicking at the Properties button. 

2. Print range: You can select the range of pages to be printed i.e. all pages or 
current page or number of pages you require. 

3. Print what: You can choose the part of the worksheet you want to print i.e. some 
selection or entire workbook or active sheet only. 

4. Number of copies: You can specify number of copies to be printed. 

5. Collate: You can specify whether all the pages of a copy be printed as one set or 
each page is printed together as many times as the number of copies specified. 

4.5 DATA ENTRY AND EDITING 

A cell contains data that you enter. At any time, one cell is always highlighted which 
is called the currently active cell. The address of this currently active cell is shown in 
the 'Name' box, which lies in the upper left comer of the screen, exactly above the 
column letter A. 

You can place your data in any portion of the worksheet. Take your cell pointer to the 
place where you want to put your data in (any portion) of the worksheet with the help 
of either the mouse or the arrow keys. · 

You can enter a variety of values in a cell such as: 

l. Numeric value: To enter a number just make the cell active and type the value. 

2. Text: To enter text value, make the cell active and type the 1cxt. Even if the text 
goes beyond the confines of the cell it remains in that cell only. 

3, Formula: You can enter a formula in a cell in the same way. A fonnula is an 
expression that evaluates to some value. Excel calculates the value of the formula 
and inserts the same in the cell, · 

4 . Comment: You can enter a comment in a cell to remind you some important fact 
about ilie cell. 

4.6 RANGE OPERATIONS 

There may be any situation when you have to perform a task on a single cell. This 
action is very simple just put the cursor on the cell and perform the task. But 
consider the situation when you have to perform the same action with a group of cells. 

For example let us consider deleting data in a group of cells. To delete such a group of 
cells you can go to each cell and press the <Del> key until the text in all the cells are 
deleted. This is a very tedious and time-conswning exercise. A better solution is to 
group the cells into a unit called range and then perform a task onto the range with one 
command, i.e. if you have to delete then make the range of the cells and press <del> 
key. A range may be of any type including: 

I . Group of cells 

2. Rows 

3. Columns 

4. Whole worksheet 



To Select a Group of Cells 

1. Place the mouse pointer on the first cell from where you want to start the 
range. 

2. Press the left button of mouse and drag it till the last cell up to which you want the 
range and then release the button. 

OR 

Place the cursor on the first cell from where you want to start the selection 
and then press shift+arrow key till the last cell up to which you want the 
range. 

To Select a Row 

1. Point the mouse pointer on the row number. 

2. Click the left mouse button only once. 

To Select a Column 

l. Point the mouse pointer on the column Name. 

2. Click the left mouse button only once. 

To Select Whole Worksheet 

I. Point the mouse pointer on the common point of row and coh.1mn, i.e., before 
starting of rows and before starting of columns. 

2. Click the left mouse button only once. 

A 
4 Vibhor 
5 Ahil 
6 RaE!n _ 
7 Vibhor 
a 
9 
10 
11 

C 

1D 
11 

4.7 WORKING WITH WORKSHEETS 

B C 
4000 
3500 
9Dl 
5670 

By default, Excel inserts three worksheets in the workbook you create: Sheet! , 
Sheet2 and Sheet3. You can, however change this default as you desire. 

Only one of the worksheets remains active at a time. To make any other sheet active 
just click at the sheet in the sheet tab. 
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The commands to manipulate sheets as a unit are grouped into a pop-up menu which 
you can invoke by right clicking at the sheet tab as shown below: 

:.:_, M1crosoll I reel MyworkbQOk • ,' C , X 

'!) Ek tdlt y_lew i,,sert FQrmat Ioo1$ 12«4 Window ~ 
89 ... Ii, 

A 8 C ·-=D ____ Ecc.--+--...F_J __ G 1r~ -f~ HRA ---~ 
3 Suman I i--------i----t----+----3CXX) 

4 Vibhor 
"5 Anl!__ 
6 R1f 

-Y Vi 
8 Vinod 
9 ~-

,o 
11 12---
13 
1'4 --
15 -

400J 
3500 
500) 

l,nsert, .. 

Q.elete 

&ename 

Move or COPY, .. 

s.eiect.Alsi-ts 

!ab Color., , 

i6 . 
I◄ ◄ • ~~~;.;;;~--!IT _ ___,_ __ _ 
Ready 

The actions you can perform with sheets are: 

t- 1--

t l r -

~ 
1. Inserting a sheet: You can insert a sheet in your workbook. Right click at the 

sheet tab before which you want to insert a new worksheet Click at the Insert 
option in the pop-up menu. The Insert dialog box appears as shown below: 

lnserr 'f IX 

Genet al I Spreadsheet 5ok.tlions I 

~ ~ A 
jw~ ~ Ch~t MS Excel 4.0 

Macro 

II 
MS Excel 5.0 

Oialoo 

~nl~I 
Pr~ 

Sel&ct anican to 
see a preview, 

cancel 

Note all that you can insert in a sheet. Select Worksheet to insert a blank 
worksheet; Chart to insert a worksheet with chart; and so on. Some built-in sheets 
are ·also available from which you can select. To view these sheets, click at the 
Spreadsheet solution tab. 

After you have made your choice, click at OK. The selected sheet will be inserted 
before the sheet at which you right clicked. 

Let us insert a blank worksheet before Sheet2. 

(a) Right click at Sheet2. 



(b) Click at the Insert option in the pop-up menu. 

(c) Select the Worksheet option in the Insert dialog box. 

(d) Click at OK. A blank sheet (with name Sheet4) is inserted before Sheet2 as 
shown below: 

A1 
A B C D E F G H 

2 
3 
-4 
5 ---+-------------------------

i. ◄ ► ►I I stlaeU Sheet4 Sheet2 Sheet3 
RMdv 

The cell A 1 in the newly inserted sheet (Sheet4) will become active. 

2. Deleting a sheet: To delete a sheet from the workbook: 

(a) Right click at the sheet you want to delete. 

(b) Click at Delete option in the pop-up menu. 

The. sheet will be deleted. 

Let us delete Sheet2 from our workbook. 

(a) Right click at Sheet2. 

(b) Click at Delete option in the pop-up menu. 

Sheet2 is deleted as shown below: 

~ ~ insert l'g1Mt tleta 
A1 • ,, 

A B C D E f G H 
1 
2 

-------..---=-~......=c-+-......::.-+---='--+---=--+-_z- +-....;..;-+---:..-~ ~----.-----+----+-_____J 
3 
4 
5 
6 
7 I , .. . ~ Sheetl S'heet4_ Sheet3 

Ready J. 

3. Renaming a sheet: You can change the name of a worksheet whenever you want. 
To do so: 

(a) Right click at the sheet which you want to rename. 

(b) Click at Rename option in the pop-up menu. 

(c) The name of the sheet will be highlighted. 

(d) Type the name you want to give to the sheet, say salary. 
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(e) Click anywhere at the worksheet. The new name will be assigned to the 
worksheet as shown below: 

A1 • 
8 C D E F G H ~ a-:1-1-.....::~~-!=-....... __:'---+.-..:.:~-+-~,._-+---!-+-~~+-__.:,.!,._-!-~'-~ 

2--t-_________ __._----!-----J 
3 

i ----------+---------+-----+------'-------1-----''----'> 
6 -=,~ ---t---~----;,---------,1--

14 ◄ ► .. , -==..n.:=-4"'-""Sheet=c,.:;:1" W, _______ _ 
lwdy 

4. Move or copy a worksheet: You can reposition a worksheet or make its copy as 
follows: 

(a) Right click at the worksheet you want to move or copy. 

(b) Click at Move or Copy option in the pop-up menu. The Move and Copy 
dialog _box appears as shown below: 

Move or Copy 1?11 XI 
Move selected 5heE,__. 

Io book: 

jMyworkbook.·xls 

ltefore sheet: 

r ~acopy 

3 

OK Cancel 

(c) Select the workbook in which you want to move/copy this worksheet in the 
To book drop down combo box. After this selection all the worksheets of the 
selected workbook will be displayed. 

(d) Select the worksheet before which you :want to place the worksheet or its 
copy. 

( e) If want a copy to placed at the destination·, click on the Create a copy option 
box. 

(f) Click OK. The intended action will take place. 

Let us move Sheet I to the end of all the sheets in the current workbook. 

(a) Right click at Sheet 1. 

(b) Click at Move or Copy option in the pop-up menu. 

(c) In the Move or Copy dialog box select (move to end) option. 



( d) Click OK. Sheet 1 will be moved to the end of all the sheets as shown below: 

L' /.111:10,ofl Excel Myworkbook 

1@2Eilt ~~ ~ Insert ~ !ocis Qata ~ ljelp r y;:,e ~ ~¢/On '°' ti-~, • ~ I! X ·-89 .. -Ii, 

A B I C 0 E F G f1 ,, l -,..1 Name Salary HRA I ~ 
2 I u 1'" Suman 3000! 
4 ½bhor - 75:o ; 

6 Anil 3500 
; ~ 

-6 -- • ..c: 
B!j_!n _ 5000, -·---7 Vibha scm, 

~ 14 ◄ ► Mi\ Si ~ 'Sheet3 \. Sheetl / I~ I II . 
RMdi, - II - I, 

A still easier way of moving a sheet to a desired location is to drag and drop. Just 
move the sheet to the location by dragging while holding down the left mouse 
button. 

5. Changing the color of a worksheet tab: You can change the color of a worksheet 
tab. Let us change the color of workshee.t Sheet3. To do so: 

(a) Right click at Sheet3. 

(b) Click at Tab color option in the _pop-up menu. The Format tab color dialog 
box appears. 

( c) Select the color. 

(d) Click OK. The tab color changes to the selected one as shown below: 

600J I 
Sheetl 

View Menu 

View menu commands allow users to choose what components of the E"cel window 
should be visible and what should not be. We wiU discuss only important commands 
of this menu. Rest, you can experiment on your own. 

View ➔ Working with Too/bar 

Toolbars are a quicker way to issue a command. Excel comes with many in-built 
toolbars. By default it displays only two toolbars, i.e. standard toolbar and formatting 
toolbar. One can display or hide toolbars to suit the need. 

To display or to hide a toolbar: 

1. Click on the View menu. 

2. Select the Toolbar option. 
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3. This will display all the toolbar names. Toolbars that are currently displayed have 
check marks in front of them and those, which are hidden; they don't have any 
check mark. 

4. ~beck mark the toolbar name which you want to use. 

5. Remove the check mark name, which you want to hide. 

Insert Menu 

Fonnattr,g 

llor<!o,• 

Control T oobox 

llr!IM'Q 

Extel'nelo«a 

FoNM 

Fornua Auditno 
Plct<N 

l'MltTable 

Protection 

~ 

Task Pane 

ToxtToSpei,ch 

\'lsual~-

Excel lets you enter a variety of objects in a worksheet. All the required commands 
are grouped in the Insert menu. 

Insert ➔Inserting a Cell 

You can insert a cell or a number of cells in your worksheet. For inserting cell(s) you 
have to follow these steps. 

1. Click on the cell where you want to insert a new cell or select group of cell where 
you want to insert the cells but keep in mind that you can insert those many cells 
equal to selected cell numbers. 

2. From the insert menu, choose the option cell. 

l)Ot (dt ... ~ flr1Nt n,.- ~ .... -
□ r.: Iii d !2 • I}. ':t ~ <' • .., • ~ 1: • tl D 1._ 

>6 " At,ij 
I C I 

1 Name SalatX • RA----r 
2 

r ~ L"'" 
,i-='-=------.-------'=---=+---H1 f' fnth ;oblri 

9 oo: a,,c,,I I 
,ai.-_ _J_ _ _t __ u.::===-===::J 
11 12- -~--

- ti. JC 

• G) .. . 
G 

l -:' 

--+ 

--+-

3. Click shift Cells right or Shift cells down according to your requirement. 

4. Click the Ok button. 



Similarly you can insert a row and a column too. Just select the Rows or Colwnns 
option from the Insert menu. 

Insert ➔Inserting Formulae 

A formula is an expression that performs operations on worksheet data. Formulae can 
perform mathematical operations, such as addition and multiplication, or they can 
compare worksheet values or join text. Formulae can refer to other cells on the same 
worksheet1 cells on other sheets in the same workbook, or cells on sheets in other 
workbooks. 

The following example adds 25 to the value in cell B4 and then divides the result by 
the sum of the values in cells D5, ES. and F5. 

Cell reference 

I 
Numeric constant 

1 
I Work~heet function 

=(B4+25)/SUM(D5:F5) 

I 
I 

I Ra~ge reference 
Division operator 

Addition operator 

To enter a formula in a cell, begin it with an equal sign('==). The equal sign tells Excel 
that the succeeding characters constitute a formula. Following the equal sign are the 
elements to be calculated (th'! operands), which are separated by calculation operators. 
Excel calculates the fonnula from left to right, according to a specific order for each 
operator in the formula. You can change the order of operations by using parentheses. 

In the example given below, the parentheses around the first part of the formulae force 
Excel to calculate B4+25 first and then divide the result by the sum of the values in 
cells D5, ES, and F5. 

"=(B4+25)/(D5+E5+F5) 

Toe structure or order of the elements in a formulae determines the final result of the 
calculation. Formulae in Microsoft Excel follow a specific syntax or order, that 
includes an equal sign(=) followed by the elements to be calculated (the operands), 
which are separated by calculation-operators. Each operand can be a value that does 
not change (a constant value). a cell or range-reference, a label, a name, or a 
worksheet function. 

Excel performs the operations- from left to right - according to the order of operator­
precedence - starting with the equal sign(=). You can control the order of caJculation 
by using parentheses to group-operations that should be performed first. For example, 
the following formula produces 11 because Excel calculates multiplication before 
addition. 

=5+2*3 

The formula multiplies 2 by 3 and then adds 5 to the result. 

In contrast, if you use parentheses to change the syntax, Excel adds 5 and 2 together 
and then muJtipLies the result by 3 to produce 21. 

=(5+2)*3 

Insert ➔ Order of Evaluation of Operators 

Excel evaluates a fonnula in a particular order determined by the precedence number 
of the operators being used and the parentheses placed in tbe formula. 
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Table 4.1 

Precedence Operator Description 

I : Range of cells 

2 Space Intersection of cells 

3 , Union of cells 

4 - Negation 

5 % Percentage 

6 I\ Exponentiation 

7 • Multiplication 

7 i Division 

8 + Addition 

8 - Subtraction 

9 & Concatenation 

10 = Equal to 

10 < Lesser than 

10 > Greater tban 

IO <= Lesser than or equal to 

10 >= i Greater tbao or equal to 
~ 

10 <> Not equal to 

A formula can refer to constant values and to other cells. The cell that contains the 
formula is known as a dependent cell when its value depends on tbe 
values in other cells. For example, cell B2 is a dependent cell if it contains the 
formula =C2. 

A constant is a numeric or text value that you type directly into a cell or formula, or 
that is represented by a name. For example, the date l 0/9/96, the number 210, and the 
text "Yearly Profit" are all constants. A formula or a value that results from a formula 
is not a constant. 

Whenever a cell referenced by a formula changes the dependent cell also changes 
automatically, For example, if a value in any of the following cells changes, the result 
of the formula ::B2+C2+D2 also ob,anges. 

If you use constant values in the formula instead of references to the cells 
(for example, =30+70+110), the result changes only if you modify the formula 
yourself. · 

Formulae can also refer to ranges of cells or to names or labels that represent cells or 
ranges. 

lmierl ~ Cell and Range Referenc.es 

A reference identifies a ceU or a range of cells on a worksheet and tells Microsoft 
Excel, where to look for the values or data you want to use in a formula. 
With references, you can use data contained in different parts of a worksheet 
in one fommla or use the value from one cell in several formulae. You can also 
refer to cells on other sheets in the same workbook, to other workbooks, and to data in 
other programs. References to cells in other workbooks are called external references. 

Insert ➔ Reference Styles 

The A I Reference Style 

By default, Excel uses the Al reference style, which refers to columns with letters 
(A through IV, for a total of256 columns) and refers to rows with numbers ( l through 



65536). These letters and numbers are called row and column headings. To refer to a 
cell, enter the column letter followed by the row number. For example, F4 ·refers to 
the cell at the intersection of column F and row 4. To refer to a range of cells, enter 
the reference for the cell in the upper-left comer of the range, a colon(:) and then the 
reference to the. cell in the lower-right comer of the range. The following are examples 
of references. 

Table 4.2 

To refer lo Use 

The cell in column A and row 10 AIO 

The range of celJs in column A and rows IO through 20 AIO:A20 

The range of cells in row 15 and columns B through E B15:El 5 

All cells in row 5 5:5 

AH cells in rows 5 through 10 5;10 

All cells in column H H:H 

All cells in columns H through J H:J 

The range of eel Is in columns A through E and rows IO throu,git 20 Al0:E20 

The RICI Reference Style 
-

You can also use a reference style where beth the rows and the columns on the 
worksheet are numbered. The R l C 1 reference style is usefuJ for computing row and 
column positions in macros. In the RIC I style, Excel indicates the location of a cell 
with an "R" followed by a row number and a "C" followed by a column number. 

Relative vs. Absolute References 

Depending on the task you want to perfonrt in Excel, you. can use either relative cell 
references, which are references 'to cells relative to the position of the formula, or 
absolute references, which are cell references that aJways refer to cells in a specific 
location. If a dollar sign precedes the letter and/or number, such as $A$ I, the column 
and/or row reference is absolute. Relative references automatically adjust when you 
copy them, while absolute references do not. 

When you create a fonnula, references to cells or ranges are usually based on their 
position relative to the cell that contains the formula. In the following example, cell 
B6 contains the formula =AS; Microsoft ExceJ finds the value one cell above and one 
cell to the left of B6. This is known as a relative reference. 

l 
When you copy a formula that uses relative references, Excel automatically adjusts 
the references in the pasted formula to refer to different cells relative to the position of 
Lhe formula. 1n the following example, the formula in cell B6, =AS, which is one ceU 
above and to the left ofB6, has been copied to cell B7. Excel has adjusted the fonnula 
in cell B7 to =A6, which refers to the cell that is one cell above and to the left of cell 
B7. 

If you don't want Excel to adjust references when you copy a formula to a different 
cell, use an absolute reference. For example, if your formula multiplies cell AS with 
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cell Cl (=A5*Cl) and you copy the formula to another cell, Excel will adjust both 
references. You can create an absolute reference to cell Cl by placing a dollar sign ($) 
before the parts of the reference that do not change. To create an absolute reference to 
cell Cl, for example, add dollar signs to the fonnuJa as follows: 

=A5*$C$1 

If you created a fonnula aod want to change relative references to absolute (and vice 
versa), select the cell that contains the formula. In the fonnula bar, select the reference 
you want to change and then press F4. Each time you press F4, Excel toggles through 
the combinations: absolute column and absolute row (for example, $C$1 ); relative 
colwnn and absolute row (C$1 ); absolute coh.1mn and relative row ($Cl); and relative 
column and relative row (C l). For example, if you select the address $A$1 in a 
formula and press F4, the reference becomes A$L Press F4 again and the reference 
becomes $Al and so on. 

Insert~ Functions 

A function is a predefined formula that takes zero or more input values (also known as 
arguments) and produces (or returns) a result The arguments can be either constant 
quantities or reference to cells or ranges; as long as data types of all the participating 
values are consistent. 

The general sttucture of a function is given below: 

Function _ name ( comma separated Argument list) 

For example, SUM is an in-beiltfunction that may be us-ed as follows: 

SUM(Al, Bl :B4, 30) 

The result will be the s-um of values stored in cells A 1, B 1, B2, B3, B4 and 30. 

Excel 2003 includes a rich variety of in-built functions that you can use in your 
spreadsheet. For convenience they have been grouped into logical categories such 
as: 

Mathematical 

Statistical 

Logical 

Date and time 

Text 

SUM, EXP, POWER. LOG, etc. 

AVERAGE, COY AR. FISHER, etc. 

AND, OR. NOT, etc. 

DATE, DAY, HOUR, etc. 

LEFT, LEN, MID, etc. 

In most of the cases, these functions will suffice your need. If you do not find an in­
built function suitable to your need, you can create your own functions in 
Visual Basic and then use them in your worksheet. This, however, is out of 
scope of the. present context. In this section only in-built functions will be used in the 
worksheet. 

Inserting a Function 

lnserting a function in a cell is very easy as Excel assists you while using built-in 
functions. Broadly, there are two ways of inserting a function: 

I .. Manually 

2. Using function wizard 

Let us calculate the total of the salary using SUM function. To insert a function in a 
cell manually: 

Clfok oo the cell in which you want to insert the function. 



Enter the formula= SUM(D3:D7) in the cell D9. Now press ENTER. You wiLll see the 
total appear in the cell D9. 

C:• Mir, osoll I xrel Myworkllook 

~ ~ tdit: YJew Insert Fgmat lools Q'ata ~ indow 

D ~1.18 ti S[l ~ J(, ~-· ..,,, 
D9 .., ~ =SUM(D3: D7) 
A B C 0 F 

5 s __ 
7 
__ ........ _...._ __ __, _______ _ 

8 ol---t--1-:-----,-----.1 ..................... _ . 
9 Total INR 21 70.00 
10 

To appreciate how useful Excel is, try changing the salary of Vibhor from 5000 to 
8000. The total wbicb depends on Vibhor's salary (cell D4) will be automatically 
updated. 

. 
L' M1rrosolt I xcel Myworkbook 

@) Ele tat ~ Insert .Fufmat Iools ~ ~ 

D "' iiil d !l &; ~ ~ J. ~ft • <t ~ . 

1 
2 
3 
4 
5 

_j 
7 
8 

;o ~ 

D5 
A 

--

~ Vin_£ld 
4Anil 

F 

I 
I 

51Rajan INR 51670.00 

_. _ ___.__o-tal _:_1NR ] 4 ,270_.oo ______ __, 

As you type the function, Excel provides you with the structural an,d usage 
infonnation of that function. If you have understood the information well, you can 
complete the function without any problem. · 

Let us compute average of the salaries in the cell D 10. You can either use a formula 

= SUM(D3:D7)/5 

or you can use the in-built function 

= A VERAGE(D3:D7) 

To see how Excel helps inserting the in-built functions, type =AVERAGE( in the cell 
DI 0. Excel immediately shows you information about AVERAGE function, as 
shown: 
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Q Micror.oit [xcel Myworkbool< 

I@) E.1e tdlt y_;ew Insert ~mat Iools Qata Window ~ 
r 

1 
2 
3 
4 
5 

g 
DATE 

A 
• X .J ff, "=average( 

B C 0 F 

Notice how Excel promptly offers its help. It shows you that you can use as many 
numeric arguments you want but they should be separated by comma. 

Not only this if you now move the mouse a selection band moves along with it. You 
can use this band to click and drag to select the range or can use arrow and shift keys 
for the purpose . 

. 
L' M1C 1osolt [xi.cl Myworkbook 

ll E.ie tdt ~ Insert tvmat lools 

L. " 
q(, 
v i lQ 

• X .J Ii, =average 

1 
2 

C 

3 1 iSuman 
4 21~ 
5 3Vinod 6 t---+ 4iAn_i_l -

D 
3:D7 

~a ~rdow ~ 

l: 

F 

1 siRa·an- !NR §.:.6-7-0.:.f!J.._ ___ -+------

a --'--.-----9 -1---- Total INR 24 70.00 
1----+-- P'-'.' - - ---------10 1Aver!!J!! =avera e D3:D7 

11 I A'fERAGE(numberl, number2 ... ) 
12 -- ______ _, 
13 

If you want to include any more range, type comma and repeat the process. Close the 
parenthesis to indicate that you have finished the range selection. Press ENTER to see 
the result. 



llao tdt ~ D'l5ert Fgmat roo1s Qata 

D r#lil dti 4if(l~ :t CQB• <> • 
010 .. ~ =AVERAGE(D3:07) 

A D E F 
1 

T 
3 
4 
5 

-6 

7 
8 
9 
10 
11 
12 

J_ 

You can also insert functions using function wizard. This is particularly convenient 
when you do not have much idea of that function. To invoke function wizard select 
the cell in which you want to put the formula. Theµ click at the function c:ommand in . 
Insert menu. 

Let us insert a function for finding standard deviation of salaries in the cell D 11. 
Select the cell. D 11. Then click at the function command in Insert menu .. The Insert 
function dialog box appears. 

A,Vf:AA(.;f. 
A.VEAAliV, 
IIETAOIST 
IIETA.INV 
BINOl'OI.ST 
CHIDIST 

AW!llfV( ....... I ....... Z,...) 
~INA'IWtQtdtlle_.__,,dclil.aOCl'UfrOIII.,_ 
-· ~..-,1,e,u,,boru•-· "'ffl; gr,.,...,_.,_ _,.,,._,_ 

Hpb<plblfhatt!n 

---- ..l --.----~--
~:::;::;;::::=:~:---;;::::======t==:;-,~ ::1--.-t--~ 

tdt 

Study this dialog box carefully. You can search the details of the function you want to 
use by typing the function name in the Search for a function box and then by pressing 
Go button. 

If you do remember the function's name or are not sure which function you want, 
select a category in the Select a category box. All the functions of the selected 
category are displayed in the Select a function box. Select the desired function and 
Excel guides you through. 

For the current purpose, select the Statistical category and observe the functions listed. 
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Inse rt r unc:tion r? ![RI 
i11arch for a function: 

Type a brief description of what you want to do and then 
click Go 

Or select a ~~egory: jStatistkal 3 
Select a functioQ: 

SKEW 
SLOPE 
SMALL 
STANDARDIZE 

J
STDEVA 
STDEVP 

STDEY(numberl,numbeZ, .. ) 

.. 

Estimates standard deviatlon based on a sample (~res logical values and 
text in the sample). 

t:felo on this hl)Ctlon OK cancel 

Select the STDEV function and click Ok to proceed. Function arguments dialog box 
opens up as shown below: 

f unc.tion Argument~ I? liXI 
DEV---

Numberl! i)--t851 Mfflber21 ________ M ...... = 

Estimates standard ~ion based on a sample (JQnores logical values and text in the 
sample), 

Nurnberl: nunber1, rvnber2,, .. are 1 to 30 nunbetscorrespondi)g to a sample of a 
popuatJon and can be nunbers or refeten(es that contain numbers. 

FomwJa resut -

Hok> on this fwctloQ OK 

Select the numbers to be included in the function as arguments. Click the nwnber 

selection icon - in front of Number!. The dialog box rolls up exposing the 
cells of the worksheet. Select the range using mouse oi arrow and shift keys as shown: 

http:referenc.es


t) l'.lt ~dl r- 1M«t iv- I•~~~ 

i " 
5TDE\I • X .J ~STDEV(DJ:07 

A B C D 
1 

E _F __ G I •-1. --, }-- ----~-~~~~----11 
4 2 Vibllor , INRS,00:,. s 3.Y"mod -. ______________ ....._ _ 

_ 6 • An~ 

Awrager-=-'IN-"'-"'"I r S1i !•EV : _ 
12 , 

_;:i=c..., •HUl:IIH:iiiiii .... 
,sl + ~00:07 

16 -- - - -=-===.::==.---------J----=-
!Z 
~ •• M\ ~U J! I I 

Afte, you have selected the rare, r I down the Function a,-gument dialog box by 

clicking at the Roll down icon Ci' . The dialog rolls down. · 

F unc:lion Arguments ? 

--sTDEV-

l"lumberl j03:D71 j,j • {-.000;8000;2300;4 
~ ,---------!ll--

• 2128.515915 
Estimates st«idatd deviation based an a sarl1]le t9101'es logkal valuM Mid text in the 
~ ). 

Numbe,l: n1.MT.ber1,nunber2,, ,. are 1 to 30 iunbers c.orr~ tc,., ~ 'ol a 
population end can be nunbefs,or references th« cO!tain runbers. 

Fomua resut • 

t1M1 on tNs MCtlro 

2128,515915 

OK 

Notice how the selection has been made for you. Click OK. Excel enters the function 
in the cell. 

L' Microsofl I ,u cl Myworkhook 

@) Be ~dlt ~ [nsert F!l"mat Iools Qslto ~ tielP 

D ~gd e d!iC9.~ .l(, ~ 8 · <1 ~. 'A .I: 
D11 f. =STDEV(D3:D7) 

F 

INR 24 270.00 
1 N R '1854.00 ----------
2128.515915 

+-
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You are strongly advised to spend some time making familiarity with various in-built 
functions. In both your academic and professional life you will benefit a lot from 
them. 

Insert ➔ Inserting Charts 

Pictures are more understandable than words. Charts are visually appealing and make 
it easy for users to see comparisons, patterns and trends in data. For instance, rather 
than having to analyze several columns of worksheet numbers, you can see at a glance 
whether sales are falling or rising over quarterly periods or how the actual sales 
compare to the projected sales. 

You can create a chart on its own sheet or as an embedded object on a worksheet. You 
can also publish a chart on a Web page. To create a chart, you must first enter the data 
for the chart on the worksheet. Then select that data and use the Chart Wizard to step . 
through the process of choosing the chart type and the various chart options. 

Using Chart Wizard 

One of the easiest ways to generate a chart from data you enter in a worksheet is by 

using Chart wizard. Chart wizard sits in the tool bar as icon. Chart wizard is a 
simple four-step process of making selections to produce a finished chart. 

1. Select the range of data on which you want to make a chart. 

L' Mir rosolt I ;,:eel Myvrorkbuok :-11L 1 x1 

I) f.le tdt ~ Insert ~ IPols ~ ytndow ~ - fl X 

D~'1 d ti •~ ~ ~4 .., • ~ l: • ti Dl 100% . 13} 
,. 
... 

A1 __, ... fi, S.No. 

A B C D E F G -.. , S.No. ~ . ~ --2 ,.,s.man -3 2 ~ am - 3 \tl!tl ~ 4 
T iiJf ~ 
6 - ! ~an. Si2tl ' 
7 I 
8 . . .L 
9 - I 
fa --
11 ~ 

1~ - ~- -
13 ... 

14 4 ► .. ,\_~ t l >, Salary / It◄ Ir - - - I ~ . ' 
Ready ; 

2. Select the option chart from insert menu, following dialog box appears. 



Chart Wiz,ud Step 1 of 4 Chart Type i?li' 
51:andard Types 

Line. 

Pie 

XV (Scatter) 
Area 
Doughnut 
Radar 

~ Surface 

~ f!ubble 
[.i Stoc.k 

00 

I custom Types I 

· ■wm 
~-­

~~ 
Clustered Column, Compares values across 
categories, 

I 
Press and Hold to ~ Sample 

1 r:text > 

3. Select the type of chart you want. Click on the Press and Hold to view Sample 
button to preview your chart. Suppose you select pie chart as ~own below: 

Ch,utWizdtd 5tep1 of4 Ch.ut Iype 1?11 

standard Types I CUstom Types ) 

Oiart type: Sample; --'-------lit Column 
Bar 

~Line 

~ 
kl XV (Scatter) 

.. Area 

O Doughnut 
Radar 

(i1 Surface 

:: Bubble 

I.a Stock 

pie With a3-0 vfsual effect, 

· etl. ~xt> 

■ 1 s ...... ft 

■ 2 \libllo 

c3Vinod 
a,Anil 

■ 5R•i"" 
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4. If the given charts are not of your choice then click on the Custom Type tab. 

Chdrl Wiz.uc.1 Stell 1 of 4 Chdrl Type I? II XI 

stal'ldard Types Custom Types I 
Qlarttype: Sample: 

j~rea Blocks l • ~l>ry 

B&WArea 

B&WColumn 6000 

B&W Line • Timescale 5000 

4000 

-3000 l■ s.i.,ij 
2000 

1000 
Column· Atea 0 

1K Columns with Depth 

6 Cones . r Floating Bars .!J 
1 0 .., 

l .t .,. 0 

f ·" a. > 

2 3 · 4 

r
't"i,!:r""" I 
r. ~-11"1 

Cancel Ejnish 

5. Select the graph type and Click on the Next button. 

6. If you have forgotten to select the data range or you want to change the data range 
then you can select the data range from here by clicking the button next to Data 
range combo box. 

-
~I 

s-- w.a.-.... ...... 

ES 

Owlf!: 
jsw, ..., .. 

- roo~ .,.,. -' . . !UM• 
IQ .. -1101 

Placechst: 

~ (.• A$.._ '1,eet: {._Chart __ i _________ __, 

m 0As ~ jlctln: 



7. Click Finish to insert this chart into the worksheet. 

@l fJe tdl: ~ I/Wt 1irmet l ools O,.t 

D ~ Iii d '11 f;(l ~ i IQ e · 
Chart Alea ~ 

I A I B D 
1 S.No. 1Name 
~ 1 Suman 

E F 

D .. 
G H_ 3 

3 2 Vibhor 4 --31Vrno"""d ...--L..-~=----=------'-----'---
{ 4 Anil Salary 1-+----+---1 

6 5 ffa·an 
7 
B 9------
10 11 +-------t--i 

12 
13 
14 

) 5 - - - --+-
16 

You should note that all the components of a chart can be modified. Right click and 
choose the command from the pop-up menu. 

Let us modify some of the features of this chart. 

1. You can resize the chart by clicking at it and dragging the size handles. 

2. Suppose you wish to remove the serial number column from the chart. Right click 
in the chart area, click at data source from the context menu. 

Click at range and select the range not including S.No. column. Close the source data 
window to see the effect as shown below: 

[)«.') Range I Serles I 

6000 

5000 

4000 

3000 

2000 

1000 

0 

Series ri: 

&.min Vobho, Vlnod Mi Roj,n 

r B.ows 
~,~ 

()I{ Cancel 
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4.8 DATABASE FUNCTIONS IN SPREADSHEET 

Database functions in Excel are powerful analytical and calculation tools. 

The functions take three arguments or parameters and then execute the result. 

The three parameters are: 
i· 

• Database is the range of cells that makes up the list or database. A database is a 
list of related data in which rows of related infonnation are records, and columns 
of data are fields. The first row of the list contains labels for each column. 

• Field indicates which column is used in the function. Enter the column label 
enclosed between double quotation marks, such as "Designation" or l'Salary1

' or a 
number (without quotation marks) that represents the position of the column 
within the list: 1 for the first column (Designation in our example), 2 for the 
second column (Salary in our example), and so on. 

• Criteria is ~range of cells that contains the conditions that you specify. You can 
use any range for the criteria argument, as long as it includes at least one column 
label and at least one cell below the colwnn label in which you specify a condition 
for the colwn. In our example the criteria range is B14 to Cl5. 

Various database functions of spreadsheet are: 

DAVERAGE Returns the average of selected database entries 

DCOUNT Counts the cells that contain numbers .in a database 

DCOUNTA Counts nonblank ceUs in a datab·•o,; 

DGET Extra.cts from a database a single record that matches the specified criteria 

DMAX Returns the maxim11m value from selected database entries 

DMIN Returns the minimum value from selected database entries 

DPRODUCT Multiplies the values in a particular field of records that match the criteria in a 
database 

DSIDEV Estimates the standard deviation based on a sample of selected database entries 

DSIDEVP calculates the standard deviation based on the entire population of selected database 
entries 

DSUM Adds the number.i in the field column of records in the database that match the 
criteria 

DYAR. Estimates variance based on a sample from selected database entries 

DVARP calculates variance based on the entire population of selected database entries 

I . Define title bar. 

2. Define Worksheet . 

.•....•. ••• ,, , , •. , •.• , . , •. , ............... . ...... . .............. . ... . . . ., . !....:_··· · ········· 

3. Define copying. 

····················································-··································· 
••• • •••••• • ••• " . . ... . ................................... . ..... . .. . . .... . ... ..... . .. i •• • • •• 

l 



4.9 LET US SUM UP 

MS-Excel is a spreadsheet software included in MS-Office 2003 suite. A worksheet in 
MS-Excel is a grid of cells made up of horizontal rows and vertical columns. A 
workbook is a group of worksheets. Three types of data can be entered in a worksheet 
(i) Number, (ii) Text, (iii) Fonnulas. CeJls can be edited by overwriting or by partially 
modifying the cell contents. 

A range of cells can be selected using mouse or keyboard. A range can be copied 
either through copy and paste operations or by dragging the fill handle. A range can 
be moved through cut and paste operations or by dragging the range border. 

To erase everything from a worksheet, select all the cells in the worksheet and then 
use Edit--clears- All. To save a workbook, use ftl~Save command. You can fill in 
a series of numbers, dates, or other Items using Auto fill. A predefined format can be 
set to you table using Auto format Option. 

4.10 KEYWORDS 

Worksheet: A grid of cells made up of horizontal rows and vertical Column:s. 

Workbook: A group of worksheets. 

Cell: Unit of worksheet fonned by intersection of a row and a column. 

Range: Group of contiguous cells that form a rectangular shape. 

Value: Nwnbers and fonnulas which can be used for Calculations. 

Copying: Duplicating the contents oftbe documents at some other desired place. 

4~11 QUESTIONS FOR DISCUSSION 

I. Differentiate between the Normal~ Print and Web vtews of an Excel 2000 
worksheet. 

2. Describe the protection mechanism in Excel_2000. 

3. Is there a limitation on number of worksheets in a workbook? If yes bow many? 

4. Explain the purposes of options available for printing a worksheet. Ho,w can tbe 
worksheet be printed without the cell gridJines? 

5. Explain the purposes of Custom header and footer. 

6. Can a range of cells formed with non-rectangular selection of cells? How? 

7. Differentiate between clearing content and clear format commands. 

8. What purpose is served by Auto fill command? 

9. Explain the difference between deleting cells a,nd a complete row. 

Check Your Progress: Model Answer 

I. Title bar shows the name of the document and is situated in the top of the 
window application 

2. Worksheet is the working area m which you can work. Each worksheet of 
a single workbook has its own identity and is separate from other 
worksheet: 

3. Copying means duplicating the contents of the documents at some: other 
desired place. 
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5.0 AIMS AND OBJECTIVES 

After studying this lesson, you should be able to: 

• Explain managerial applications of computer 

• Describe computer based financial system 

• Define the computer based inventory system 

-
5.1 INTRODUCl'ION 

Computers are u!le!~ tor all aspects of running a business. Computer use in a business 
enhances prodli"ctivity and provides results that might not otherwise bie possible. 
Businesses u1:·e computers to ~eep records, develop budgets and foreca1sts, prepare 
marketing docum,nts, research and stay in contact with other employees and 
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customers. Businesses should look at their operation and ensure that they are using 
their computers to the fullest extent. 

5.2 MANAGERIAL APPLICATIONS OF COMPUTERS 

Computer is used every where in the world in every field of life. There are many 
applications of computer for example. 

Computer can perform any kind of calculations in no time; where as a human being 
would take months and years to do the same calculations. Now a day's computer is 
. used in almost every day application of life. For example, in: 

• Banking: Before when there was no computer, every where manual system was 
followed which was a very complicated and hard work but now with the coming 
of computer every thing is in a very systematic way. Every bank is now using a 
computerized system because it is very fast and user friendly. A TM cards are used 
every where now which let us bank any time we want. PC banking (Personal 
Computer banking) Jet us view our bank balance, request transfers between 
accounts and pay bills electronically etc. 

• Traffic light control: In traffic light control the computer is being employed to 
drive the traffic light. There are some programmed codes like " tl,lrn off the red 
light" or "tum on the red light" to control the traffic light and to carry out the 
instructions that follows. 

Another most import.ant application of computer in real lifo is: 

• Sports: In sports computers are used wildly in conjunction with video cameras. 
These are used to record the motion of all the sports men. 3D programs are used 
later on to help the trainers see there movements and could improve there styles of 
playing. 

• Schools and Colleges: There are many uses of computer in schools and collages, 
for example. 

Every student detajJs need to be stored so a computer program could help in this 
way. 

Multimedia, animations, graphics and charts could be used to teach the students 
and many boring topics can be made interesting using multimedia. Students could 
access internet for online help and courses for more information. 

S.3 COMPUTER AND MANAGEMENT FUNCTIONS 

The common experience in the Indian scene has been a plethora of transaction­
processing systems which have been abiding for long. Left to themselves, computer 
professionals have usually been good at planning, designing, developing and 
implementing the transaction-processing systems, due to their inherent advantages of 
recurring qualitative data and decisive logic base. On the other hand, MTS at a 
corporate level always needs involvement of the user-manager in an intensive way 
and this has shown a tardy growth. 

There are many functional relationships between computer and management and these 
are: 

• Financial Decision~making 

• Personnel Decision-making 

• Marketing Decjsion-making 

• Production Decision-making 
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• Materials Decision-making 

• Maintenance Decision-making 

5.3.1 Financial Decision-making 

At corporate level MJS would still need the database comprising the transaction­
processing inputs, such as, C/lSh transactions, receipts, issues, return, foreign exchange 
earned or spent, rejections, , interests, depreciation, etc. The other inputs are io the 
nature of the various accounting rules and procedures, apart from the scales of 
payment. 

Based on the above, the financial management decisions are made witln monilily and 
annual final accounts, profit and loss accounts, balance sheet, etc. In addition, cash 
accounts are needed by management, apart from the cost accounting for pay-roll 
accounting, suppliers ledger and preparation of capital and operations budget. 

To build up a corporate-level MlS for a tourism organisation, one can look at such 
selective data as bills payable and bills receivable, and segregate iliern commodity­
wise, establishment-wise, region-wise and agent-wise. Thls immedi1ately gives a 
management decision-making capability to examine and take remedial action on the 
differences and deviations from the set pattern. The analysed data for financial 
decision-making can have various management ratios and management trends leading 
on to managerial forecasts. Linked data can be of the form of inter-related items 
between finance and inventory, between finance and marketing, between finance and 
production costing, and between finance and personnel. Integrated data can take the 
fonn of obtaimog a picture for total credit, total sales tum over, total pmfit and so on. 

The corporate areas to be helped would be cash planning, credit planning, profit 
planning, and facility planning. For instance, cash inflow and outflow are of great 
interest for most organisations and much monumental bankruptcy fakes place in 
organisations due to the faulty cash-flow adjustments. Similarly, the credit planning 
takes care of voluntary and involuntary credit, in establishment where voluntary credit 
is often deliberately-introduced to push new products, to lift accumulated stock or to 
provide relief to bulk customers. In all such areas, decision-making is facilitated by an 
appropriate MIS, as has been experienced in many organisations. 

In service organisations, investment planning and budget planning are additional 
features. Interestingly, budget planning can be a common feature in both production 
and service organisations. The tourism organisations have shown a tremendous scope 
for corporate MlS in terms of trends, analysis and forecasts arising out of various 
re~oociliation processes such as inter-branch, inter-agents or even for such 
instruments as travellers cheques and so on. Financial data can be generated and 
stored for hotel tariffs, package tour costs, commissions to distributors, volume of 
business provided by distributors, etc. 

In the domain of public administration, commercial tax data-base has bc~en built up in 
some of the Indian states for various categories of taxes on commodity-wise, 
establishment-wise, region~wise and year-wise bases. Such a data-base has given rise 
to a capability of concentration upon tax evasion cases selectively, to strengthen the 
inspection machinery for tax non-realisation cases, to keep track of recovery of 
diverse installments in court-injunction cases and generally to streaml.ine pursuit of 
the outstandings. 

S.3.2 Personnel Decision-making 
Personnel pay rolls have been an old hat in transaction-processing systems. In a 
number of organisations, pay-rolls have been extended to cover the entire gamut of 
employee service, namely, income-tax assessment and recovery, pirovident fund 
accumulation and withdrawal, compulsory deposits (when they existed)! and statutory 
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reports and returns. A comprehensive database for personnel decision-making would 
require not merely such financial data but also other categories of pre-recruitment and 
post-recruitmem. personnel data. 

Examples of comprehensive personnel data would include prior qualifications, 
experience, categories and grades of posting, places of transfer, experience gained, 
new qualifications, acquired, training undertaken, disciplinary actions, merit rewards 
a~d performance appraisals, etc. Such a data-base can be used for ·retrieval of selective 
data to assess grade-wise, year-wise and region-wise personnel inflow and outflow, 
for deciding upon recruitment planning as well as promotion planning. A similar 
approach can be undertaken to match availability of persons experience-wise, 
location-wise and duration-wise with the demand of such persons in new locations 
with appropriate grades and experiences for purposes of personnel plan. Career 
development planning can also be done while looking at the grade-wise, ex.perience­
wise and qualification-wise profile and decide on fresh areas of training and 
education. 

Finally, retirement planning can be done by looking at the selective aggregation of 
data on personnel wastage, so that recruitment can be undertaken and the bulk of 
retirement benefits can be released rightaway pending the settlement of accounts. 

Personnel decision-making based on coq>orate MlS has become quite commoQ. in a 
number of large organisations in the country. In addition, states like Andhra Pradesh 
and Madhya Pradesh have often done personnel planning for doctors and teachers 
respectively using comprehensive database approach. Bhilai Steel Plant has planned 
total human resource management with creation of complete data-base including 
history and skills of personnel; and manpower planning and administration, including 
establishment functions; training needs as identified in the appraisal reports and so on. 

In tourism many jobs are seasonal and in.certain cases outside people are hired (like 
guides, escorts) to carry specific jobs. Any good organisation will keep a database of 
such persons with quality rankings and their rates for the services. This data needs 
constant upgradation. 

S.3.3 Marketing Decision-making 

Sales invoicing and sales accounting have been the early transaction-processing 
systems in most organisations. The inputs i.:an be the deciding of a tour package, 
inspection of all the places of concern and despatch of documents on tours arranged 
and despatched apart from the price schedules, some occasional returns. Such data can 
be built into a comprehensive data-base which can help eventually the market 
planning and the publicity (advertisement) planning on one hand and linkages with 
order-processing on the other. 

Both market planning and publicity planning depend on the creation of a number of 
profiles with full particulars such as customer profile, product profjle and user 
industry profile. The seasonality of orders, the trends in market fluctuations, the 
philosophy of industrial indents and the ebb and flow of relevant markets can be 
assessed and taken care of io such a planning process. 

Destination data, customer profile data, costs data etc. come bandy in designing the 
product/service mix along with the product line. Similarly data on competition is also 
useful for marketing planning. 

On the other hand, linkages with order-processing gives a vital control on the quantity 
of tours to be arranged or suspended to meet live and dead orders, respectively. Such a 
dynamic inter-facing can help to eliminate a lot of infiuctuous order execution a.od 
finished tours inventory creation. 



5.3.4 Production Decision-making 

The production of goods is a general tenn used very often in most of the organisation. 
In the service sector it can be thought as a substitute for the service to be rendered or 
specifically in the tourism sector, for example, it can be a term used to specify all the 
tour packages specially designed every year as the goods produced. 

The basic inputs are the salient production data collected periodically from all the 
production units or designing units as and when the main events occur. The! corporate 
MIS would involve: perfom,ance review on a periodic basis (daily, monthly and 
annually), monitoring of in-process inventory, other performance statistics, 
comparison of the current production with the past performance, r1~ceipt and 
consumption of services and energy resources and daily analysis of performance. 

Corporate production decision-making involves production planning aind control 
(PPC) and this involves certain elements: 

• The first element of PPC is the order processing involving maintenance: of current 
status of orders aod despatch programmes. 

• The second element of PPC is the corporate production MIS indicated earlier. 

• The third element of .J> PC is the material tracking including mainllenance of 
detailed production schedules through various stages of operations (from initial 
idea up to the final finishing); in-process material and so on. 

• The fourth element of PPC is the planning, including annual plans based on 
market demands; maintenance schedule and corporate plan requirements; 
quarterly and monthly plans based on annual plans and organisation targets; daily 
plans for fulfillment of monthly plans; comparison of plan versus performance at 
different time intervals; and preparation of subs.idiary plans for requirement of 
raw-material, energy resources and finished inventory. 

Many organisations have today incorporated PPC as part of their corporate MIS. This 
is very useful in hotel, airlines and tour opeiators. 

5.3.5 Materials Decision-making 

Materials accounting based on receipts, issues, returns, and rejections have been the 
part of transaction-processing system in all organisations so far. For the purpose of 
materials decision-making, comprehensive databases can have three components of 
purchasing, inventory, and materials review. 

The purchasing data-base can help creaiing a corporate MIS for monitoring of 
purchase indents up to acceptance of tenders, monitoring of purchase ordiers against 
schedules of delivery, analysis of lead-time delays, vendor-rating (in tem,s of quality 
performance of delivery schedule), and monitoring payments against delive1ries. 

The inventory data-base can help increasing a corporate MIS for preparation of 
standard specifications for regular consllmption items, prompt inspection and 
acceptance of deliVered geods, preparation of receipts documents, monitoriing of stock 
balance, pnrchase dues, and indents dues; monitoring of procureme11t of regular 
conswnptton items, decentralised control of consu_mption, analysis of co,nsumptio9 
and movement (particularly for slow moving, non-moving and critical) of items for 
control forecasting and budgetary control of consumption and procurement and so on. 

Materials review data-base can help jo creating a corporate MIS for the~ on-going 
review of the various control parameters such as re-order level, re-order quantity, the 
phasing of deliveries for 'A' class items, the bulk purchasing of 'B' and 'C' class 
items and so on. Basically, materials review should look critically at all the expected 
norms of purchasing and inventory so that a dynamic adjustment is possible before the 
on-set of any crisis. 
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Materials review data is essential for hotels and tourist transporters along with others 
subsidiary products and services in tourism like emporiums, restaurants, etc. 

5.3.6 Maintenance Decision-making 

Maintenance management distinguishes between preventive maintenance and 
breakdown maintenance. While preventive maintenance can be planned, the 
breakdown maintenance is invariably unplanned. 

As regards plant preventive maintenance, the experience with oil refineries, industrial 
blast furnace, dock facilities and thermal projects have all shown that a thorough 
planning and a scheduling of preventive maintenance can be immensely time-saving 
and cost-reducing. The same is applicable in case of tourism transport operations and 
hotels maintenance, vehicle breakdown or bad maintenance in hotels can adversely 
affect the business. 

\ 
Transaction-processing systems have looked at the records of components> spare-
parts, jugs, fixtures and tools as inputs, and consumption statements and maintenance 
accounts as outputs. These inputs can still be valid for building up a corporate MJS 
with such additional data as equipment contlitions, history of failures, direct cost of 
maintenance, inventory values and materials movement, man-hours spent, over-time 
paid, other resource usage, maintenance of employee's performance, reliability and 
maintainability of equipment, and maintenance contribution to the finances. 

From such a comprehensive database, one can generate MIS reports for transport 
control, such as vehicle register (to provide vehicle specifications and project details), 
vehicle history (to provide maintenance particulars), major failure report, forecast on 
maintenance (providing probable failure time and period), office · non-availability, 
reliability and maintainability, and maintenance schedules (providing maintenance 
activities to be done during a specific period). One can also generate MIS reports on 
work control, such as, craft performance report (providing planned and actual 
performance of each craft), craftsman's performance report, maintenance planning 
efficiency report (providing an efficiency ratio on planned activities), overtime report, 
resource levelling report (providing analysis of resource required job-wise), delay 
cause report, etc. One can finally generate materials control reports and cost control 
reports providing management details of costs and material transactions involved in 
maintenance management. 

5.4 COMPUTER BASED FINANCIAL 
ACCOUNTING SYSTEM 

5.4.1 Accounting Information Systems 

Accounting information systems are the oldest and most widely used information 
systems in business. Computer-based accounting information systems: 

• Record and report the flow of funds through an organization on a historical basis 
and produce imP9rtant financial statements such as balance sheets and income 
statements, 

• Produce forecasts of future conditions such as projected financial statements and 
financial budgets. 

• Operational accounting systems focus on transaction processing systems. They 
emphasize legal and historical record-keeping and the production of accurate 
financial statements. Typically, operational accounting systems jnclude: 

❖ Order processing 

❖ Inventory control 



❖ Accounts receivable 

•) Accounts payable 
. ... Accounts payroll 

•:• General ledger systems. 

• Management accounting systems focus on the planning and control of business 
operations. They emphasize: 

❖ Cost accounting reports 

❖ Development of .financial budgets and projected financial statements 

❖ Analytical reports comparing actual to forecasted performance. 

You will have heard the term "double entry book keeping". This is an old established 
system of book.keeping which forms the basis of all accounting systems. Today, of 
course, companies of all sizes usually use computerised accounting systems. 
Nevertheless, it is useful to learn a little about the double entry system as this will help 
you understand how a trial balance is drawn up. 

Every "transaction" is supported by a business document. What do you understand by 
the term "transaction", and which documents are we talking about? I have listed some 
of the most common transactions below. Most transactions are related to thi~ sale or 
purchase of goods, services, capital items and consumables. 

If you are a seller and make a sale: 

• You produce an invoice. 

• You send the top copy of the invoice to the buyer. 

• You retain the second copy of the invoice. 

If you are a buyer and make a purchase: 

• The seller produces an invoice 

• You receive the top copy of the invoice 

• The seller retains the second copy of the invoice. 

If you are a seller who has goods returned: 

• You produce a credit note. 

• You send the top copy of the credit note to the buyer. 

• You retain the second copy of the credit note. 

If you are a buy_er who returns some goods: 

• The sellel" produces a credit note. 

• You receive the top copy of the credit note. 

• The seller retains the second copy of the credit note. 

1n this way everybody receives a document as a record of the transaction. 

When purchasing capital items you will receive the top copy of the seller's invoice. In 
addition, you may also receive a de~d (for premises) or a formal hire purchase 
agreement. When purchasing small quantities of consumables or other small items the 
document you will receive could be the tjlJ receipt. Alternatively, the proprietor may 
make out and sjgn an internal petty cash voucher to release the money from lihe petty 
cash account. 
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Some important subsystems of Accounting Information Systems are as follows: 

• Online Accounting Systems: Accounting infonnation systems are being affected 
by Internet and client/server technologies. Using the Internet, intranets, extranets, 
and otber network changes how accounting information systems monitor and 
track business activity. The online, interactive nature of such networks caJls for 
new forms of transaction documents, procedures, and controls. Many companies 
are using or developing network links to their trading partners through the use of 
the Internet or other networks for applications such as order processing inventory 
control, accounts receivable, and accounts payable. 

• Order Processing: Order processing, or sales order processing, is an important 
transaction processing system that captures and processes customer orders and 
produces data needed for sales analysis and inventory control. In many firms, it 
also keeps track of tbe status of customer orders until goods are delivered. 
Computer-based sales order processing systems: 

❖ Provide a fast, accurate, and efficient method of recording and screening 
customer orders and sales transactions. 

❖ Provide inventory control systems with information on accepted orders so 
they can be filled as quickly as possible. 

• Inventory Control: Inventory control systems process data reflecting changes to 
items in inventory. A computer-based inventory control system: 

❖ Record changes to inventory levels and prepares appropriate shipping 
documents, 

❖ May notify managers about items that need reordering and provide them with 
a variety of inventory status reports. 

❖ Helps a business provide high-quality service to customers while minimizing 
investment in inventory and inventory carrying costs. 

• Accounts Receivable: Accounts receivable systems kepp records of amounts 
owed by customers from data generated by customer purchases and payments. 
Accounts receivable systems: 

❖ Produce invoices to customers, monthly customer statements and credit 
management reports. 

❖ Stimulate prompt customer payments by preparing c1ccurate and · timely 
invoices and monthly statements to credit customers. 

❖ Provide managers with reports to help them control the amount of credit 
extended and the collection of money owed. 

❖ Help to maximize profitable credit sales while minimizing losses from bad 
debts. . 

• Accounts Payable: Accounts payable systems keep track of data concerrung 
purchases from and payments to suppliers. Accounts payable systems: 

❖ Prepare checks in payment of outstanding invoices and produce cash 
management reports. 

,o, Help ensure prompt and accurate payment of suppliers to maintain good 
relationships, ensure a good credit standing, and secure any discounts offered 
for prompt payment. 

❖ Provide tight financial control over all cash disbursements of the business. 

❖ Provide management with infonnation needed for the analysis of payments, 
expenses, purchases, employee expense accounts, and cash requirements. 



• Payroll: Payroll systems receive and maintain data from employee time cards and 
other work records. Accounts payable systems: 

❖ Produce paychecks and other documents such as earning statemen,ts, payroll 
reports, and labor analysis reports 

❖ Product reports for management and government a,'!encie<; 

❖ Help businesses make prompt and accurate payments to their employees, as 
well as reports to managem1;i.1t, employees, and government agencies 
concerning earnings, taxes, and other deductions. 

❖ Provide management with reports analyzing labor costs and productilvity. 

• General Ledger: General ledger 3ystems consolidate data from accounts 
receivable, accounts payable, payroll, and other accounting information systems. 
General ledger systems: 

❖ At the end of each accounting period, these systems produce tb.e general 
ledger trial balance, the incoµ1e statement and balance sheet of the fmn, and 
various income and expense reports for management. 

❖ Help businesses accomplish accounting tasks in an accurate amd timely 
manner. 

❖ Typically provide better financial controls and management reiports and 
involves fewer personnel and lower costs than manual accounting methods. 

Newer technologies play an important role in improving the effectiveness of internal 
financial information. For example, the cost-volume-profit (CVP) analysis technique 
and other methods of analyzing costs and margins give management the subtle 
infomiation it needs to make short- to medium-term financial decisions. Activity­
based costing (ABC) opens up a whole new approach to matching costs and resources 
to their true causes. A state-of-the-art financial infonnation system Jays the foundation 
for consistent and reliable reporting, regardless of the way the company anialyzes the 
information. 

5.4.2 Financial Management Systems 

Computer-based financial management systems support financial managers m 
decisions concerning: 

• The financing of a business. 

• The allocation and control of financial resources within a business. 

Major financial infonnation system categories include: 

• Cash and investment management. 

• Capital budgeting 

• Financial forecasting 

• Financial planning 

Cash Management 

Cash management systems collect information on all cash receipts and disbursements 
within a company on a real-time or periodic basis. Cash management systems: 

• Allow businesses to deposit or invest excess funds more quickJy, and thus 
increase the income generated by deposited or invested funds. 

• Pmduce daily, weekly, or monthly forecasts of cash receipts or disbursements 
( cash flow forecast) that are used to spot future cash deficits or surpluses. 
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• Mathematical models frequently can determine optimal cash collection programs 
and determine altemative financing or investment strategies for dealing with 
forecasted cash deficits or surpluses. 

Online Investment Management 

Many businesses invest their excess cash in short-term low-risk marketable securities 
or in higher return/higher risk alternatives, so that investment income may be earned 
until the funds are required. Portfolio of securities can be managed with the help of 
portfolio management software packages. Online investment management services: 

• Are available from hundreds of online sources on the lntemet and other networks. 

• Help a financial manager make buying, selling, or holding decisions for each type 
of security so that an optjmum mix of securities is developed that minimizes risk 
and maximizes investment income for the business. 

Capua/ Budgeting 

The capital budgeting process involves evaluating the profitability and financial 
impact of proposed capital expenditures. 

• Long term expenditure proposals for plants and equipment can be analyzed suing 
a variety of techniques. This application makes heavy use of spreadsheet models 
that incorporate present value analysis of expected cash flows and probability 
analysis of risk to determine the optimum mix of capital projects for a business. 

Financial Forecasting and Planning 

A variety of financial forecasting packages provide analytical techniques that result in 
economic or financial forecasts of national and local economic conditions, wage 
levels, price levels, and interest rates. 

Financial Plannin.g: Financial Planning systems use financial planning models to 
evaluate the present and projected financial perfonnance of a business or of one of its 
divisions or subsidiaries. Financial planning systems: 

• Help detennine the financial needs of a business and analyze alternative methods 
of financing the business. 

• Use financial forecasts concerning the economic situation, business operntions, 
types of financing available, interest rates, and stock and bond prices to develop 
an optimal financing plan for the business. 

• Frequently use electronic spreadsheet packages and DSS generators to build and 
manipulate models. 

• Are used to answer what-if and goal-seeking questions in order to evaluate 
financial and investment alternatives. 

lntemal financial reporting traditionally means compiling and distributing g1meric 
reports that show a company's pait, short-tenn financial perfonnance. The financial 
reports at one company look the same as they would at any other company. And the 
infonnation leaves management without insight, unable to link what happened 
yestetday with how the company will meets its financial targets of tomorrow. 

Best Practices 

Best practices in the area of prnviding financial information can be quite technical and 
complex. For example, the best practices address the fundamental assumptions and 
structure of internal financial reporting, the selection of performance measures at the 
company1 approaches to financial analysis, and choices in the financiaJ information 
system. As daunting as these best practices may appear, companies should keep in 



mind that they have complete control and flexibility in the area of intennal financial 
reporting. After all, it is internal reporting, so it is completely up to the company to 
decide what serves it best. In as much as these best practices are intricate and 
complex, a company in the end should select the approaches and technologies that 
support its own decision-making process. A list of the best practices is given below. 

• Identify and understand the information needed by internal customers to execute 
the business strategy, satisfy customers, and evaluate busin,~ss process 
performance. 

Once the finance group understands management's f rnancial information needs, 
the next step is to design, or redesign, the financial information syst,ems to meet 
those needs. At this point, most companies shift from the traditional focus on 
historical financial data, which provides after-the-fact record keeping, to a new 
emphasis on information for decision making. For example, reports that include 
activity-based costing, target costing, and life cycle costing link financial 
performance with factors that affect revenues and expenses. These costing 
~ethods also uncover trends in financial performance and indicate tliie effects of 
the current trends on the company's attainment of strategic objectives. 

• Measure and report profit contributed by appropriate segments, such as product 
line, customer, channel, division, and geographic location. 

Meaningful internal financial information differentiates profitable customers and 
business segments from those that are not. To achieve this all-import.ant goal, the 
company needs to structure financial reports appropriately, so that irecipients of 
the reports can plainly grasp the profitability analysis. To collect the appropriate 
information to analyze, a company first needs to identify bow to segment its 
business to reflect the flow of profits, such as by market segment, by distribution 
channel, by customer, or by division. Then the company assigns to each segment 
the appropriate revenues, variable costs, and fixed costs. For example. for a 
channel profitability analysis, costs would include channel managc~ment costs; 
channel maintenance costs; advertising, promotion, and marketing costs; trade 
show costs; and marketing staff costs. Through assigning the relevant revenues 
and costs to tbe business segments, the company may identify high-profit and 
high-loss segments, and then set objectives for avoiding costs relevant to high-loss 
segments. 

• lntegrate financial analysis with operational and industry analyses to identify 
opportunities for improving business performance. 

Many companies could use more sophistication in their financial reporting, with 
techniques such as analysis of ratios and comparisons to indust:Jry and peer 
perf onnance. These techniques give management insight into where the business 
may be vulnerable and where it might enjoy unique strengths. However, it's easy 
to go overboard with sophisticated financial analysis techniques; keeping the 
measures simple and relevant to strategic business issues is a reliable, powerful 
course of action. 

Companies that apply best practices select a small number of key financial 
statistics and ratios to watch closely, keeping in mind the company's 
circumstances and objectives. Ratios and statistics are more meaningful if 
evaluated in tenns of their trends over time. To broaden the focus of financial 
analysis, high-performance companies compare their numbers 1to those of 
competitors and best-of-class performers. 

The balanced scorecard approach to frnancial reporting is particularly powerful. 
For a balanced scorecard, the company selects a short list of measures that not 
only indicates the operational and financial health of the business, but also its 
level of customer satisfaction and the creative health of the business. An example 
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of a balanced scorecard is one that chooses measures that focus on four critical 
issues: 

❖ The customer perspective: how do customers see the company? 

❖ The internal business perspective: what must the company excel at? 

❖ The innovation and learning perspective: can the company continue to 
improve and create value? 

❖ The financial perspective: how does the company look to shareholders? 

Ta.king a balanced scorecard approach, a company creates performance measures 
to track all levels of the company that reflect these four critical issues. For 
example, on periodic internal reports, customer satisfaction metrics and statistics 
on the number of employees participating in coursework are reported right 
alongside finance and operations numbers. To create meaningful report content, 
employees from finance, operations, and other functional areas need to collaborate 
with one another. 

• Use cost-volume-profit analysis, contribution margins, and relevant costs and 
qualitative factors to evaluate business opportunities. 

Methods such as cost-volume-profit analysis, contribution margin calculation, and 
relevant cost calculation help a company to evaluate the impact of expe<:ted 
changes in the volume of sales on resulting costs and profits. 

Special business opportunities require a company to look at short-term financial 
issues - such as revenues, expenses, and cash flow - as opposed to long-term 
financia l fasues such as equity distribution and indebtedness. Also, when · 
evaluating special opportunities, in addition to looking at the numbers, companies 
need to consider qualitative factors. Market expectations and customer 
expectations should always play a role in a company's decision to accept a one­
time special order or to outsource its core business. Will existing customer 
schedules be affected? Will the company lose expertise in a key skill area? Are 
there bidden costs, like training and supervising time, that do not appear in the 
original analysis? 

• Ose the attributes of world-class financial information systems to evaluate and 
improve the company's existing financial information systems. 

At the foundation of effective intemal financial reporting is a robust information 
system that collects and disseminates information flexibly and reliably. Best 
practices companies study the attributes of a world-class information system and 
look for computer hardware, software, and systems design for their business that 
deliver these attributes: 

❖ Standardized: the system captures and processes information consistently 
throughout the company 

❖ Complete: the system bandies the infoanation requirements of diverse groups 
of users 

❖ Appropriate: the information is relevant,'predictive, exception oriented, and at 
the right level of detail 

❖ Unified: the system bas information links to customers and suppliers, and 
changes to data in one area move through the whole system 

❖ Flexible: applications may be tailored to the company's needs 

❖ Cost-effective: the system makes efficient use of hardware and software 
Licenses 

❖ Easy to use: all tyPes of users are comfortable with the system 
t, • 

❖ TirreJy: ~ e;y.:tem provides information when it's needed 



• Ensure that key decision makers understand the strengths and we;3knesses of 
internal financial information. 

.Internal infonnation has its limitations. The information is more meaningful and 
relevant when decision makers understan~ its limits, how it is productid, and how 
it can help them. 

The fmance group can assist management in understanding internal financial 
information by explaining the processes that underlie it. For example, the finance 
group can explain how the financial system measures, records, an.d classifies 
transactions; how the finance group periodically summarizes and repo;rts financial 
information; and the meaning and limitations on interpreting the infonnation. One 
limitation of internal information is its bias toward analyzing the past and 
focusing on short-tenn profitability. Another is its tendency to focus on issues 
important only to the company, opposed to issues of concern to customers as well. 

• Provide accurate and reliable activity-based cost information for resource 
alJocation decision making. 

Activity-based costing (ABC) is a powerful tool that companies use to determine 
which activities contribute to profitability. The concept of ABC is to distill a 
company's production process into a set of activities and then attribute and 
analyze costs by activity. With ABC, a company sees which aotiviti,es cause its 
costs. 

Implementing ABC lets a company allocate resources based on critical activities; 
eliminate redundant activities and costs; eliminate activities that do not add value 
to the customer; set budget levels in accordance with activities that cause costs; 
and place more reliable information on activities and processes into the hands of 
management. 

5.5 COMPUTER BASED INVENTORY SYSTEM 

"Inventory" to many business owners is one of the more visible and tangible aspects 
of doing business. Raw materials, goods in process, and finished goods, all represent 
various forms of inventory encountered in a manufacturing organization. Each type 
represents money tied up until the inventory leaves the factory as a purcbruied product. 
Likewise, met:chandise stocks in a retail store contribute to profits only when their 
sale puts money into the cash register. 

Inventory refers to stock of anything necessary to do business. These stocks represent 
a large portion of the business investment and must be well managed in order to 
maximize profits. In fact, many small businesses cannot absorb the types of losses 
arising from poor inventory management. Unless inventories are controlled they are 
unreliable, inefficient, and costly. In attempting to control inventories, managers 
usually lean towards keeping inventory levels on the high side, yet lthis greater 
investment (given a constant amount of profit), yields a lower return on the dollar 
invested. This is one of the contradictory demands made upon the manager with 
respect to keeping·inventory, oth~rs include: 

· • Maintain a good assortment of products - but not too many; 

• .Increase inventory turnover - but only at a good profit level; 

• Keep stocks low - but not too low; 

• Make volume purchases to obtain lower prices - but don't overbuy; and 

• Get rid of obsolete items - but not before their replacements have taken hold in 
the market. 
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Today, the use of computer systems to control inventory is far more feasible for small 
business than ever before, both through the widespread ex.istence of computer services 
organizations (listed in the yellow pages of many telephone directories) and the 
decreasing cost of micro computers. Often the justification for such a computer-based 
system is enhanced by the fact that company accounting and billing procedures can 
also be handled on the computer. 

Most computer manufacturers offer free, written information on the inventory 
management systems available for their computers. In addition, computer service 
companies often have material readily available describing the use of their particular 
computer "software" programs for inventory management. These companies provide a 
good source of information on general descriptions of particular inventory 
management techniques, as well as help on specific inventory management problems . 

. Whether a manual or computerized inventory management system is used, the 
important thing to remember is that inventory management involves two separate, but 
closely related elements: the first is knowing what and how much to order, when to 
order and what price to pay; the second is making sure that the items, once brought 
into inventory, are used properly to produce a profit. 

5.6 INVENTORY CONTROL SYSTEM 

Inventory control systems maintain information about act1v1t1es within firms that 
ensure the delivery of products to customers. The subsystems that perform these 
functions include sales, manufacturing, warehousing, ordering, and receiving. In 
different firms the activities associated ,vith each of these areas may not be strictly 
Qontained within separate subsystems, our these functions must be performed in 
sequence in order to have a well-run inventory control system. 

In today's business environment, even small and mid-sized businesses have come to 
rely on computerized inventory management systems. Certainly, there are plenty of 
small retail outlets, manufacturers, and other businesses that continue to rely on 
manual means of inventory tracking. Indeed, for some small businesses, like 
convenience stores, shoe stores, or nurseries, purchase of an electronic inventory 
tracking system might constitute a wasteful use of financial resources. But for other 
finns operating in industries that feature high volume turnover of raw materials and/or 
finished products, -computerized tracking systems have emerged as a key component 
of business strategies aimed at increasing productivity and maintaining 
competitiveness. Moreover, the recent development of powerful computer programs 
capable of addressing a wide variety of record keeping needs-including inventory 
management-in one integrated system have also contributed to the growing 
popularity of electronic inventory control options. 

5.7 COMPUTERS AND INVENTORY 

Automation can dramatically impact all phases of inventory management, including 
counting and monitoring of inventory items; recording and retrieval of item storage 
location; recording changes to inventory; and anticipating inventory needs, including 
inventory handling requirements. This is true even of stand-alone systems that are not 
integrated with other areas of the business, but many analysts indicate that 
productivity-and hence profitability- 6ains that are garnered through use of 
automated systems can be increased even more when a business integrates its. 
inventory control systems with other systems such as accounting and sales to better 
control inventory l"lvels. As Dennis Eskow noted in PC Week, business executives are 
"increasingly integrating financial data, such as accounts receivable, with sales 
information that includes customer historjes. The goal: to control inventory quarter to 
quarter, so it doesn't come back to bite the bottom line. Key components of an 



integrated system . . . are general ledger, electroruc data interchange, database 
connectivity, and connections to a range of vertical bus:iness applications." 

I. Personnel pay rolls have been an old hat in ..................... . 

2. Sales invoicing and ..................... have been the early transaction-
processing systems in most organizations. 

3. . . . . . . . . . . . . . . . . . . . . . systems keep records of amounts owed by customers 
from data generated by customer purchases and payments. 

5.8 LET US SUM UP 

Computer programs such as QuickBooks and other accounting programs allow 
businesses to keep detailed records. These programs track accowits payable, accounts 
receivable and sales. They also provide an easy and quick way for a business to send 
out invoices to customers and handle payroll functions. Back office productivity and 
accuracy can increase greatly when using an accounting program. There are a wide 
variety of programs that allow businesses to easlly prepare dynamic marketing 
documents. Adobe Photoshop provides many templates that users can manipulate to 
produce eye-catching custom marketing materials. These programs make it easy for 
people who do not have a creative background to prepare professional-looking 
documents quickly and painlessly. 

5.9 KEYWORDS 

Computer Program: Set of instructions in a programming language along with data 
structure and documentation. 

B usiness Process: A related group of steps or activities that use people, information, 
and other resources to create value for internal or external customers. 

System: Set of interacting components that operate together to accompJjsh a common 
purpose. 

5.10 QUESTIONS FOR DISCUSSION 

l. Describe the managerial uses of computers. 

2. Explain personal C:ecision making. 

3. Describe accounting infonnation system in details. 

4. Explain inventory control system. 

Check Your Progress: Model Answer 

·1. transaction-processing systems 

2. sales accounting 

3. Accounts receivable 
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6.0 AIMS AND OBJECTIVES 

After studying this lesson, you should be able to: 

• Describe Information System and its need 

• Define Digital Convergence 

• Identify the Change in Business Environment 

• Understand the Information and Knowledge Economy 

• Describe Contemporary Approach to Information System 

• Acknowledge Information System Management Challenges 

• Define the Ethical and Social Issues of IS 

6.1 INTRODUCTION 

Management Information System is an old management tool, which has been long 
used by people for better management and scientific decision-making. 

Management Information System is mainly dependent upon information, which is a 
vital ingredient of any Management Information System. Information is the most 
critical resource of Management Information System. We all know that information is 
a vital factor for our existence. Just as our body needs air, water and clothes, we are as 
much dependent upon information. To make life more interesting and to achieve the 
feeling of being a pa.rt of the social system, we want to know our surroundings and for 
that we need information. Information is an important input for achieving our goals 
such as learning to help each other and to become integral part of society. 

Actually, information system is not a new concept; it is as old as the hills. From 
biblical times, humans have been making the use of information generated through 
information systems in all times. There have been systems that generated and 
communicated information. Kings and rulers bad their own ways of designing 
infon'llation systems to retrieve information. The main objective of these information 
systems was to ascertain the well being of their people in the kingdom and to 
effectively and efficiently manage the kingdom. The church had its own information 
system. In India, Tainali Rama, Akbar and many others liad impressive management 
.information systems in operation. Similarly, the merchants of Venice had their own 
fully functional appropriate management information system in place. 

6.2 WHAT IS AN INFORMATION SYSTEM? 

Now, it is titne to see the real meaning and concept of Information Systems. Too often 
you hear someone say, "Oh yeah, I know how to use a computer. I can surf the Web 
with the best of them and I can play Solitaite for hours. I'm really good at computers." 
Okay. So that person can pound a keyboard, use a mouse at lightning speed, and has a 
list of favorite Web sites a mile long. But the real question is "Is that person's 
information literate?" Just because you can pound the keyboard it doesn't necessarily 
mean that you can leverage the technology to your advao1.<1ge or the advantage of you_r 
organization. An organization can gather and keep aU the data on its customers that a 
hard drive can hold. You can get all the output reports that one desk can physically 
bold. You can have the fastest ' Intemet connection created to date. But if the 
organization doesn't take advantage of customer data to create new opportunities, then 
all it has is useless information. If the output report doesn't tell the management that it 
has a serious problem on the factory floor, then all that's been accomplished is to kill a 
few more trees. If you don't know how to analyze the information from a Web site to 
ta.lee advantage of new sales leads, then what have you ~y done 'for y~urself today? 



Most of us think only of hardware and software when we think of an Infonnati'on 
System. There is another component of the triangle that should be considered, and 
that's the people side, or ''liveware." 

We talk about the input, processing, output and feedback processes. Most :important is 
the feedback process; unfortunately it's the one most often overlooked. Just as we 
discussed above, the hardware (input and output) and the software (processing) 
receive the most attention. With those two alone, you have computer literacy. But if 
you don't use the ''liveware'' side of the triangle to complete the feedback loop, you 
don't accomplish much. Add the '1liveware" angle with good feedback and then you 
have the beginnings of information literacy. 

An information system differs from other kinds of systems in that its objiective is to 
monitor/document the operations of some other system, which we can ciall a target 
system .. An information system cannot exist without such a target system. 

for example, production activities would be the target system for a production 
scheduling system, human resources in the business operations would b,e the target 
system of a human resource information system, and so on. lt is important to 
recognize that within a vending machine there is a component/sub-system that can be 
considered an information system. In some sense, every reactive system will have a 
subsystem that can be considered an information system whose objective is to monitor 
and control such a reactive system. 

6.3 THE NEED FOR INFORMATION SYSTEMS 

Ask managers to describe their most important resources and they'll list money, 
equipment, materials, and people - not necessarily in that order. It's very unusual for 
managers to consider infonnation an important resource and yet it is. This ,chapter will 
help explain why you need to manage this resource as closely as any other in your 
organization. 

6.3.1 The Competitive Business Environment 

For many years computer technology was relegated to the backrooms or basements of 
a corporation. Only the "techies" worried about it and were often the onl:y ones who 
really knew how it all worked. Now computers are all over the organizati,on - one on 
every desk. It's not enough for you to know how to potmd a keyboard: or click a 
mouse. It is not even enough for you to know how to surf the Web. Now every 
employee, irtcludin.g you, must know bow to take advantage of Information Systems 
to improve your organization and to leverage the available infonna1tion into a 
competitive advantage for your company. 

6.3.2 Why Business Need Information Technology? 

Infonnation Technology is reshaping the basics of business, customer service, 
operations, product and market strategies, and distribution are heavily, or sometimes 
even entirely, qependent bon IT. The computers that support these funct1ions can be 
found on the desk, on the shop floor; in the store, even in briefcases. Information 
technologies, and its expense, have become an everyday part of business lilfe. 

The fundamental reasons for the use of information technology in .business are: 

• Support of business operations 

• Support of managerial decision making 

• Support of strategic competitive advantage. 
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6.3.3 Emergence of the Global Economy 

Next time you purchase a product, any product, look at the fine print and see where 
it's made. It could be China, or the Philippines, or India, or even USA. You can 
disagree with many manufacturing jobs that are being moved from other U.S. to 
foreign countries. But look at the vast number of jobs that are being created in this 
country. Maybe they aren't the traditional factory jobs we're used to. In fact, many of 
our new jobs are in the information fodustry. Many of them service entirely new 
markets that di~'t exist just a few years ago. There was no position called 
"Webmaster" in 1991 because the Web didn't exist. But now, that particular job 
category is one of the fastest growing in the overseas. The global economy I am 
talking about is being made possible by technology. And that's why it's so important 
that you understand how to use Information Systems Technology instead of just 
computer technology. There's' a big difference between the two, and we'll talk about it 
more. 

6.3.4 Transformation of the Business Enterprise 

You can't help but know about the entire job c1:1ts occurring in our country. lt seems 
like every week we hear about thousands and thousands of people losing their jobs. 
Back in the 80s most of the job losses were in the blue-collar sector. In the 90s it 
seems many of the cuts were being made in the white collar, management jobs. Why? 
Think about it. Technology, to a large extent, has driven organization_s to change the 
way they operate and that includes the way they manage. We're going to take an in­
depth took at bow organizations work and how they've been transfonned by 
technology. 

But it isn't always bad! You just have to ask yourself this question: "With all the job 
losses in the last few years, many driven by technological changes, why has the Indian 
W1employment rate dropped to it's lowest in decades and remained so low?" 

6.4 DIGITAL CONVERGENCE 

The speed and computing capacity of technology continues to advance at dizzying 
speeds and in ways we can hardly imagine. 

6.4.1 Interactive Multimedia 

One trend highly touted by the experts is that of the "infonnation appliance." Do we 
need to have a separate device for watching television, another one for listening to 
music, a different one called a telephone, and · yet a whole separate device for 
computing? Some people say we can do all of that with one central appliance with a 
variety of input and output devices. 

lf you watch the mergers taking place in the corporate world between the telephone 
companies and cable TV companies, you can s.tart to understand another major change 
that may be in store for us. The companies are working toward a convergence of the 
"entertainment outlets" we know as television and the Internet. Why can't we 
download a movie off the Internet whenever we're ready to watch it instead of having 
to follow a TV channel's set schedule? This idea may be a reality in a few years. 

The music industry is struggling with the issue of music downloaded from Web sites, 
How do the m~sicians protect their copyrighted work while making the music more 
accessible to the public? How do the musjc publishing companies protect their 
business from disintennediation, the process of eliminating the middleman from 
transactions? 



6.4.2 Role of Information Technologies on the Emergence of New 
Organizational Forms 

During the last years, a consensus is emerging that to survive in the competitive 
turbulence that is engulfing a growing nwnber of industries, firms will need to 
pinpoint innovative practices rapidly, to communicate them to their suppl!iers and to 
stimulate further innovation. In order to be competitive, companies are forc:ed to adopt 
less hierarchical and more flexible structures, and to define strategies able to combine 
reduced costs, high quality, flexibility and a quick answer to customer requirements. 
Nowadays, there are very few companies with enough resources to forrn its value 
chain on their own. 

Therefore, some changes are taking place within individual companies and in their 
relations with other organizations, creating new structures in which re:lationships 
between customers and suppliers are suffering considerable changes. One of these 
changes is concerned with the formation of networks in which there is a division of 
labour that allows each company to exploit their distinctive advantages, and be more 
competitive globally. 

ln a network model, a set of juridi'caUy independent companies establish cooperative 
long term links in order to achieve a higher level of competitiveness. The enterprises 
that belong to a network have not all the elements needed for manufacturing a product 
or providing a service under their absolute control. Therefore, the success of this kind 
of structures is conditioned by the coordination degree obtained along the realization 
of inter-ol'ganizatiooal activities, which requires an efficient communication system 
among the partners. The lnfonnation Technology (IT) represents a supportive element 
that facilitates the transfer of information across organizational boundaries. In this 
paper we analyze the inclusion of the Interorganizationa1 Information Systems (10S) 
concept within the network model and discuss the role IT plays in enabling 
orgahizational transfonnation towards emergent forms of organization. 

1n order to attain relatively low costs in the last two decades the eoterprise1s followed 
strategies of backward-forward integration, based on the improvement of the effects 
of the experience curve and the scale economies. We consider that this internal growth 
may be inadequate to face the new situations appearing in the nineties and, no doubt, 
those that will appear in the next century, The individual enterprise has less1 capability 
for foreseeing the consequences of the different busines-s dec:isions; however, the need 
for competing in a more and more complex context requires the adoptioin of quick 
decisions, which facilitate the flexibility of the enterprise. New technollogies, fast 
changing markets and g1obal competitiveness are revolutionizing relationtships both 
within and between organizations. Thus, the new environment requires from the 
enterprises a strategy able to agglutinate reduced costs, high quality, flexibility, and a 
quick response to the needs of the customer. 

Nowadays, the enterprises have to compete in a more and more turbulent scene, which 
obliges them to adopt Jess hierarchical and more flexible structures. During the last 
years, a major transformation in the strategy of many enterprises has been observed 
with a tendency to disintegration. This is accompanied by a need for increasing the 
quality of th_e products or services offered, which requires more interdependency 
among the different corporate units. As a consequence of it, several trans:formations 
both inside the enterprises and in the relationships between them are taking place, 
which establishes new structures through which the relationships among competitors, 
customers and suppliers are changing substantially. Ooe of these changes is the 
cooperation established among different enterprises, which allows them to develop 
their competitive capability. Companies are fonning strategic alliances because there 
is an increasing acknowledgement that organizations operate in a relational! context of 
environmental connectedness and that organizational survival and PJ~rfonnance 
depend.upon connections with other organizations. 
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The co-operation among enterprises allows their fleltibility and their innovative 
capacity to be increased. Current products are based on so many critical technologies 
that most of the enterprises cannot keep constantly updated in all of them. 

The Network Structure 

The concept of the network's form of organization has been particularly popular with 
management writers for its potential to build the flexible organization wjth the ability 
to meet the challenges of a changing and global environment. Despite both the 
abundant available literature and the existence of a certain consensus on some aspects, 
there is still too much ambiguity in the concepts used in this area. Taking into account 
the formation of networks, which is an interesting field of recent development with 
strong repercussions on the inter-organizational relationships, it is necessary to clear 
the ex.istinJ? terminological confusions in order to formulate its theory and to improve 
its implementation. 

Starting from the definition, a network is a specific kind of relationship joining a 
particular group of people, objects, or events. Two factors needed for constituting a 
network can be obtained from this definition; first, a network is formed by a group of 
elements; second, these elements establish specific relationships among them. We 
must show that the establishment of a co-operative network is not a purpose itself but 
"it must be a dynamic structure that allows consolidating the competitive position of 
its members" . . 

By means of a network structure, the competitive position of the enterprises can be 
reinforced as these concentrate on what they do best, and on what maintains their 
success in the market. In this way, other enterprises make the activities left, in which 
they have distinctive competences too. The enterprises outsource those activities that 
are ballast and bureaucratize them. 

The enterprises that belong to a network have not all the elements needed for 
manufacturing a product or providing a service under their absolute control. Within 
the networks, the involved elements belong to independent enterprises and are placed 
along the value system of a product or service. 

AJI this drives to an organizational structure in which the enterprises generate more 
value in those areas where they have specific competencies. The success of these 
emergent organizational forms seems to be based, on a great extent, on an effective 
co-ordination by means of the use of advanced information systems, which are based 
on the Infonnation Technologies (IT). There is an increasing interest in the 
relationship between the emerging organizational ways and the function of the IT/IS 
insofar as the progresses in each field have influenced the others. 

Information Technology on the Emergence of Networks 

At the moment, the most spectacular and potentially powerful uses of th.e information 
systems technology go beyond the individual borders of the enterprises. In fact , the 
most important function of IT in the nineties is the better manage·ment of the 
interdependencies among the enterprises. Information Technology has to be the most 
powerful instrument to reduce th.e co-ordination costs». While the traditional uses of 
1T tried to facilitate the internal processes of the enterprises, the Interorganizational 
Information Systems (IOS) are addressed towards the efficiency of a group of 
enterprises. 

Most of the studies about IOS have focused on the incidence of IT on the flows of 
information among tbe organizations, its capability of reducing the transaction costs, 
and its potential to achieve competitive advantages. Many authors have verified that: 

• IT influences the nature, punctuality and detail level of the information shared by 
enterprises 



• IT reduces the transaction costs, while it provides a better management of the 
ri~ ' 

• IT reduces the.co-ordination costs. 

In order to benefit from the advantages of IT, the enterprises have to keep in mind that 
IT cannot be isolated from its organizational context». We do not agree with the 
existence of causation between the implementation of IT and the organizationaJ 
changes in the enterprise driving to an increase in the competitiveness of the 
enterprises. On the contrary the technological and organizational implementations are 
both sides of the same issue, since they depend on and detennine each othen>. We 
think that, although IT might have the above mentioned positive effects on the 
organizations, the will and capabilities of the directors of the company are needed in 
order to make the most of those advantages. 

In order to make the most of the whole potential of the JOS, it will be required that the 
managing directors get involved with the project, since they have a wider and more 
strategic view of the company. In this way, a system coherent with the objectives of 
the company would be implemented. This system would allow taking even more 
profit from IT, what would have positive repercussions on the enterprise and would 
facilitate the achievement of its objectives. The active_ participation of the 
Management Board in the planning of the IOS brings a problem related to the fact that 
IT is a relatively oew resource that did not exist when most of the current managers 
were trained. Therefore, they usually do not feel comfortable with these new 
technologies. 

As a proof of tftis, we will consider an example. McKesson was a dealer company of 
chemical products. This company knew that its success was linked to that of its 
customers, which were small stores, so it established a close relationship with them. 
By means of an appropriate use of lnformation Technologies, it helped its customers 
to maximize their profits, since it gave them useful information for competing with 
the big pharmaceuticaJ chains, which were getting F ~ ter market share. The 
McKesson Corporation directors• idea was so successful that many other enterprises 
of the sector tried to imitate it, but they made a terrible mistake. They thought that the 
network created by McKesson was just a computerized system with terminals 
connected in other enterprises. 

The secret of the success of this company were not the computer links; information 
technology did not create the network. The network's success was due to the fact that 
the directors of McKesson were aware of bolh the relationships along the added value 
chain and the need to strengthen as much as possible every link within the chain, so 
cooperative behaviors could be established in order to provide the share of 
information and the quick response to the changes of the demand. 

Another example, widely mentioned in the literature on Information Systems, is the 
one of the American Hospital Supply Company whose success has shown up the need 
to consider the network established not only as a mere system of electronic data 
exchange, but also as a better implementation of the technology found within a 
conteJet of changes in the commercial relationships between the enterprise and its 
main customers. 

They state that the implementation. of this kind of technologies per se does not bring 
any competitive advantages; on the contrary, they must be accompanied by some 
particular elements, · generally intangible, which faci litate the operation of the 
organization by means of a better distribution of the infonnation and the experience. 
They also reflect a collaborative attitude among the enterprises. 

A positive consequence of the revolution of communication and Infonnation 
Technologies is that there are more available options for designing the Jabour now, 
because the technology can be used to increase the capacit1es of the workforce, and 
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the information can be transferred to those places were the labour is carried out. 
Workers do not need to be located according to parameters of time and space to co­
ordinate any more. We consider that technology, although it is not the ground for the 
emergence of a new and innovative way of organizing the enterprises, plays an 
important role in its operation. 

Technology allows doing things in a different way, which provides the directors some 
organizational possibilities that would be unthinkable without its implementation. 
Thus, using a mathematical expression, we can state that lnfonnation Technologies 
are necessary but they are not enough to achieve greater business competitiveness. 

The Role of JOS within the Network Structure 

The enterprises involved in an alliance must decide whether to use the manual 
managern.::nt of all the exchanged data, or to complement that management with the 
interconnection of their respective computer applications. This interconnection may 
bring, however, compatibility problems in the integr:ation of the data from the 
different enterprises, since those applications would have possibly been designed 
without talcing into account any requirement of integration among enterprises. The 
establishment of co-operation networks implies the need for wider communication in 
the organizational field, as well as the requirement of capability to integrate the 
information systems from different enterprises. 

The enterprises inside a network cannot operate properly if they have not the 
possibility to communicate quickly, accurately, and over long distances. Within a 
network, it ~:loes not make any sense to restrict the application of modem computer 
technologies to the individual borders of each enterprise. The Management Board of 
the enterprises in the network must, on the contrary, consider the possibilities of 
coordinating the processing of data outside the limits of their own organizations by 
means of an 10S. 

The application of the 1T which provides the electronic integration among the 
shareholders of an industry may make easier the outsourcing of activities, as well as 
be a basic part of the proper operation of the reticular structures. An 10S may play an 
important role in the coordination of interdependent activities, which would be carried 
out by distant organizational units. Thus, the enterprises can reduce their dependency 
on strategies of backward-forward integration. in order to ensure the control over the 
production process. 

The concept of network emphasizes the interdependency among enterprises, which is 
provoked by the presence and the sharing of the following key attributes: objectives, 
experience, labour, taking of decisions, responsibiJity, trust, and acknowledgement or 
reward. The enterprises within a network will adopt a common objective, namely to 
provide a quicker and better service to the final customer. With this aim in view, 
independent organizations will have to establish close interrelationships, in which 
Information Technologies have a vital role to play. In this way, the aim of optimizing 
the flow of profits along the supply chain could be achieved too. 10Ss are, basically, 
new means to facilitate the relationships among organizations; they are, therefore, a 
strategic instrument. However, an IOS allows to obtain operative advantages too, such 
as: 

• Reducing paper-work and manual operations; 

• Reducing the stock levels; 

• Accelerating the product and material flow; 

• Standardizing of procedures; 

• Accelerating the flow of information about changes on the demand; 

• Reducing telecommunication costs. 



The IT is a basic support that facilitates the co-ordination of different enterprises 
through EDI systems~ shared databases, e-mail,_ videoconferences, which will allow 
them to . work together. They will be able to share infonnation on the markets, on the 
needs for materials, on stock levels, production schedules, and delivery programs. A 
key factor in an efficient exchange of-information within a network is the computer 
connection of its members. The computer links accelerate the transference of 
information, since it provides the automatic transmission of data between physically 
distant computers. These links can be used as a strategic instrument to increase the 
competitiveness of the enterprise, binding it electronically witb its customers and 
suppliers through inter-organizational systems. The electron.ic connection facilitates 
the approaching of the linked enterprises, which means that the companies may 
provide the customers direct access to the internal databases, as well as just-in-time 
stock control. 

6.5 CHANGE IN BUSINESS ENVIRONMENT 
The powerful worldwide changes have altered the environment of business. These 
changes in the business environment and climate are classified into political, social, 
economical and technological categories. 

Envirorunental, organizational, and technological factors are creating a highly 
competitive busin~ss environment where customers are the focal point. Further, 
environmental, organizational, and technological factors can change quickly, 
sometimes in an unpredictable manner. 

Therefore. companies need to react often and quickly to both the problems and the 
opportunities resulting from this new business environment. This dramatic chang~ is 
due to a set of business pressures or drivers. They maintain that in order to succeed (or 
even to survive) in this dynamic world, companies must not rely only on traditional 
actions such as lowering cost, but also encourage innovative activities by empowering 
employees. 

Organizations are composed of five major components: IT, organizational structure 
and corporate culture, management and business processes, organization's strategy, 
and individuals and roles. These components are in stable condition,, called 
equilibrium, as long as no significant changes occur in the environment or in any of 
the components. However, as soon as a significant change occurs, the system becomes 
unstable and it i_s necessary to adjust some or all of the internal components since all 
are interrelated. 

6.5.1 IT and Organizational Design 

Arr important and fast growing technological innovation during this century is 
computer-based information systems. Computer-based infonnation systems (CBIS or 
only IS) provide an opportunity for businesses to improve their efficiency and 
effectiveness, and even to gain a competitive advantage. IT is also a catalyst of 
fundamental changes in the structure, operations and management of organizations. 
Most businesses in the industrial world could not compete, and many could not even 
survive withoµt computers and software. Now 1T is an integral part of the products 
and services delivered to customers. 

Competition leads to environmental uncertainty and increases both the need for and 
the rate of innovation adoption. By adopting IS, businesses will be able to compete in 
three ways; 

• JS can change the industry structure and, in doing so, alter the rules of 
competition; 

• IS can also create competitive advantage by offering business new ways to 
outperfonn their rivals; and 

• IS spawns new businesses, often from within existing operations of the business. 
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6.5.2 IT-enabled Organizational Transformation 

There is a growing body of conceptual papers and case studies on IT-enabled 
organizational transfonnation in the infonnation systems literature. Most of the 
studies suggest that the use of IT without concomitant organizational changes is 
unlikely to yield significant gains in tenns of organizational perfonnance. 

6.5.3 4R's of Business Transformation 

Business Transformation Gan be defined as "The orchestrated redesign of the genetic 
architecture of the corporation, achieved simultaneously - although at different speed 
- along the four dimensions of reframing, restructuring, revitalization and renewal." 
By this definition a biological model bas been developed that we call the Four R's of 
transformation are: 

• Reframiog 

• Restructuring 

• Revitalization 

• Renewal 

Reframing is the shifting of a COf!lpany's conception of what it is and what ft can 
achie , e with new visions and a new resolve. 

Restructuring is a girding of corporate loins, getting it to achieve a competitive level 
of performance by dealing with the body of corporation and competitiveness. The 
need to be lean and fit is the primary cori:ideration. 

Revitalization is about igniting growth by linking the corporate body to the 
environment. 

Renewal deals with the people side of transfonnation, and with the spirit of the 
company. It is about investing individuals with new skills and new purposes, thus 
allowing the company to regenerate itself. 

6.5.4 Five Levels oflT-induced Reconfiguration 

The above figure is a schematic repiesentatioo of these five levels along two basic 
dimensions - the degree of business traosfonnation and the range of potential benefits 
from IT. Organizations thereby proceed to higher levels of transfonnation as the 
demands of competition and value creation for customer increases. The first two 
levels are evolutionary, requiring relatively incremental changes in the existing 
organizational processes. In contrast, the other three levels are conceptualized as 
revolutionary, requiring fundamental changes in the nature of business processes. 

High 

Degree or Business 
Transformation 

Revolutionary Levels 

Evolutionary Levels 

Low Range of Potential Benefits High 

Figure: 6.1: Levels of IT-induced Reconfiguration 



These five levels are expJained as following: 

Level 1: Localized Exploitation (Automation), · which is concerned with the 
exploitation ofIT within business functions. 

Level 2: Internal Integration, a logicaJ extension of the first in the sense that IT 
capabilities are exploited in all the possible activities within the business 
process. Two types of integration are critical here: technical integration and 
the organizational integration by using common 1T platform to integrate the 
organization's business processes to enhance efficiency and effectiveness. 

Level 3: Business Process Redesign, involving the reconfiguration of the business 
using TT as a central lever 

Level 4: Business Network Redesign concerned with thereconfiguration of the scope 
and tasks of the business network involved in the creation and delivery of 
the products and services and · 

Level 5: Business Scope Redefinition concerned with the undedying principle of a 
corporation, pertaining to the possibilities of enlarging the business mission 
and scope (through related products and services) as well as shifting the 
business (through substitution of traditional capabilities with IT-enabled 
skills). 

6.6 INFORMATION AND KNOWLEDGE ECONOMY 

Information work is the art of creating and processing information. We use the term 
''art" because some companies do a very good job of creating, processing, and 
managing their information;- others do such a poor job that these tasks become a 
detriment to the success of the organization. Which kind of company do you want to 
work for or own? 

The two groups of employees primarily concerned with KWS are the data workers 
who process and distribute information and the knowledge workers who create 
knowledge and information. There are several ways to distinguish these two groups, 
You can also distinguish the two by the type of work they perform and how they 
create and use information. Here are some questions to help you: 

• Do they create original ideas, or do they process, record. and store someone 
else's? 

• Do they make th.eir own original decisions regarding the- information? 

• Do they establish procedures to create and process the infonnation, or do they 
follow someone else's procedures? 

6.6.l Distributing Knowledge: Office and Document Management Systems 

Manufacturing 
and Production 

Marketing 
and Sales 

Figure 6.2 
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The offii::e, as we know it in the traditional sense, is the setting for the generation and 
processing of information. As the above figure shows, it's where different roles mesh 
into a smooth "machine" of producing information, knowledge, and ideas instead of a 
product that you can touch, feel, or smell. 

Table 6.1 

Office Activity Technology 

I Managing documents Word processing, desktop publishing, document imagmg, web publishing, 
work flow managers 

Scheduling Eleotronic calendars, groupware, intranets 

Communicating E-mail, voice mail, digital answering systems, groupware, intranets 

Managing data Oes)(top databases, spreadsheets, user-friendly interfaces to mainframe 
databases 

The table describes typical Office Automation Systems and the activities they support, 
all of which are vital to the success of the organization. While some OAS still rely on 
stacks and stacks of paper, modem technology emphasizes digital sourcing, storage, 
and distribution. As computers and associated technology become more embedded 
into the normal work.flow of offices, more is being done without paper. For instance, a 
clerical worker can create a document, send it to co-workers or supervisors for their 
input via email, have it returned electronically, correct it, and distribute it online. 

But no matter how much we talk about a paperless society, we are actually generating 
more paper than ever. One of the emerging technologies that is enhancing the 
productivity and ease-of-use of Office Automation Systems and reducing paper 
problems. is the document imaging system, which converts documents and images into 
digital form so they ~n be stored and accessed by computer. 

Documents not in use are stored on-line on an optical disk system called a jukebox. 
The index server maintains the information the system will use to locate, access, and 
retrieve a document. 

A wonderful example of document imaging systems is bank checks. Most banks don't 
return canceled checks any more. They make a digital image of the check, store it 
electronically, and then destroy the piece of paper. If you ever need a copy of one of 
your old checks, you have to request it. While the initial use of paper isn't reduced, the 
cost of processing and mailing the checks to the customer is gone altogether. 

The advantages of using document imaging systems lie in the chance to redesign 
workflows. lf companies aren't willing t-0 do this, then they are laying out a lot of 
money to buy and install a system that they'll never fully use. 

6.6.2 Creating Knowledge: Knowledge Work Systems 

Now wce'll review many different Knowledge Work Systems (KWS) so that you have 
a clear understanding of how they differ from OAS and other Information Systems. 
These systems help create new products or improve pld ones, and they're also used to 
integrate new data into the flow of infonnation th;tt is so vital to an organization. 

It's important that you understand the fw)ctions 16vs perform. They: 

• Keep the organization up-to-date in knowledge 

• Serve as internal consultants 

• Act as change agents 

6.6.3 Requirements of Knowledge Work Systems 

The first requirement of a KWS is that it provides knowledge worKers with the 
necessary tools: 

• Graphics tools 



• Analytical tools • 

• Communication tools 

• Docwnent management tools 

External 
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Figure 6.3 

The above figure also shows how the elements of a KWS work together. Note that this 
kind of system requires links to external knowledge bases. 

Most KWS require powerful workstations that can process the huge graphics files 
some professionals need or perf onn the massive calculations other types of 
professionals require. We're not talking clip art or simple adding or subtracting. We 
are talking huge amounts of data that must be processed quickly and .the necessary 
-storage for large files. The workstations must also have the necessary equipment and 
telecommunication connections that enable the knowledge workers to c-onnect to 
external sources of information via Extranets, Intranets, or the Internet. These systems 
must have system and application software that is easy to use and manipulate, and 
intuitive to learn. 

6.7 CONTEMPORARY APPROACH TO 
INFORMATION SYSTEM 

There are several different approaches to Information Systems: technical, behavioral, 
socio-technical. Think of this analogy: A "techie" looks at most things associated with 
computing as a series of zeroes oi ones. After all, everything in a computer is 
ultimately reduced to a zero or a one. So usi.n,g the technical approach, you could say 
that 2 + 2 = 4. The behavioral approach, on the other hand, takes into account the very 
nature of human beings. Nothing is totally black and white. Therefore the behavioral 
approach to the same equation would be "2 + 2 = maybe 4 or perhaps 3.5 to 5.5, but 
we'll have to put it before the committee and see what the next quarter's figures say." 
Neither approach is better than the other, depending on the situation. Neither approach 
is more right than the other, depending on the situation. 

An organization can't afford to view its information resources as belonging to either 
the techies (technical approach) or the non-techies (behavioral approach). 
Responsibility for information belongs to everyone in the organization. This is the 
socio-technical approach, that is, a combination of the two. Everyone has to work 
together to ensure that Information Systems serve the entire organization. 

To help you understand the importance of viewing Information Systems through the 
socio-technical approach, look at what the current trade journals are saying. David 
Haskin, writing in the April 1999 issue of Windows Magazine, quotes Steve Roberts, 
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vice president of infonnation technology for Mind Spring Enterprises, an Atlanta­
based Internet service provider: "The gap in understanding between technical and non 
technical people is the biggest challenge I've seen." Haskin goes on to say, "Because 
technology is the bedrock on which successful businesses are built, the stakes in 
making this relationship work are high. Failing to use tlie correct technology can put 
you at a competitive disadvantage, and glitches in existing technologies can bring a 
business to a grinding halt." · 

Infonnation Systems and the use of technology belong to everyone in an organization. 
This concept is best carried out through a socio-technical approach, which allows both 
the technical and behavioral approaches to be combined for the good of the 
organization. 

Infonnation systems are socio-technical systems. Through they are composed of 
machines, devices, and .. hard' physical technology, they require substantial social, 
organizational, and intellectual investments to make them work property. 

Behavioural 
App,oaches 

Figure 6.4: Contemporary Approaches to Information Systems 

The study of infonnation systems deals with issues and insights contributed from 
technological and behavioral disciplines. 

Technical Approach 

The technical approach to infonnation systems emphasizes mathematically based 
models to study information systems, a well as the physical technology and formal 
capabilities of these systems. 

Behavioral Approach 

An important part of the information systems field is concerned with behavioral issues 
that arise in the development and long-term maintenance of information systems. 
Issues such as strategic business integration, design, implementation, utilization, and 
management cannot be explored usually with the model used in the technical 
approach. 

Approach of this Text: Socio-technical Systems 

MJS combined the theoretical work of computer science, management science, and 
operations research with a practical orientation toward building' systems and 
applications. Technology must be changed and designed in such way as to fit 
organizational and individual needs. At times, the technology may have to be "de­
optimized" to accomplish this fit. 



6.8 INFORMATION SYSTEM MANAGEMENT 
CHALLENGES 

Is this new technology worth the headaches and heartaches associated with all the 
problems that can and will arise? Yes. The opportunities for-success are endless. The 
new technologies do offer solutions to age-old problems. Improvements are possible 
to the way you operate and do business. 

6.8.1 The Strategic Business Challenge 

Companies spend thousands of dollars on hardware and software. only to find that 
most of the technology actually goes unused. "How can that be?'' you ask. Usually 
because they didn't pay attention to the full integration of the technology into the 
organization. Merely buying the technology without exploiting the new ,opportunities 
it offers for do~ng business smarter and better doesn't accomplish mucill. Think and 
rethink everything you do and figure out how you can do it better. Change is 
inevitable, and information must be managed just as you would any other resource. 

Creating a digital firm and obtaining benefit is a long and difficult journey for most 
organisations. Despite heavy information technology investments, many Qrganisatioos 
are not realising significant business value from their business systems., nor or they 
become digitally enabled. The power of computer hardware and software has grown 
much more rapidly than the ability of organisations to apply and to use this 
technology. To fully benefit form information technology, realize genuine 
productivity, and take advantage of digital firm capabilities, many organisations 
actually need to be redesigned. They will have to make -fundamentall changes in 
organisational behavior, develop new business models and eliminate the inefficiencies 
of outmoded organisational structures. If organisations merely automate what they are 
doing today, they are largely missing the potential of information technology. 

6.8.2 The Globalization Challenge 

The world becomes smaller every day. Competition increases among coultltries as well 
as companies. A good Management Information System meets both dlomestic and 
foreign opportunities and challenges. The rapid growth in international trade and the 
emergence of a global economy call for infonnation systems that can ,support both 
producing and selling goods in many cliff erent countries. In the past, e1ach. regional 
office of a multinational corporation focused on solving its own unique, information 
problems. Given language, cultural and political differences among countries, this 
focus frequently resulted in chaos a_nd the failure of central management controls. To 
develop integrated. multinational, information systems, businesses must develop 
global hardware, software and communication standards; create cross,.cultural 
accounting and reporting structures; and design transnational business pmcesses. 

6.8.3 The Information Architecture Challenge 

You have to decide what business you are in, what your core competencies are, and 
what the organization's goals are. Those decisions drive the technology, i:nstead of the 
technology driving the rest of the company. Purchasing new hardware involves more 
than taking the machine out of the box and setting it on someone's desk. Remember 
the triangle of hardware, software, and persware. Take care of the people :and they will 
take care of the rest! Information architecture describes bow to incorporate technology 
into the mainstream processes in which the business is involved. How will the new 
Information System support getting the product produced and shipped? How will 
Advertising and Marketmg know when to launch ad campaigns? How will 
Accounting know when to expect payment? 

Many companies are saddled with expensive and unwieldy information technology 
platfonns that.cannot adopt to innovation and change. Their informatiolll systems are 
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so complex and brittle that they act as constraints on business strategy and execution. 
M!et~g _ new business and technology challenges may require redesigning the 
?r arusahon and building a new information architecture and information technology 
m astrocture. 

6 .. 4 The Information Systems Investment Challenge 

Tdo often managers look at their technological investments in terms of the cost of new 
h~dware or software. They overlook the costs associated with the non-technical side 
of technology. Is productivity up or down? What is the cost of lost sales opportunities 
an lost customer confidence from a poorly managed E-Business Web site? How do 
yoµ determine if y9ur Management Information System is worth it? 

A 1major problem raised by the development of powerful, inexpensive computers 
involves not technology but management and organisations. It's one thing to use 
information technology to design, produce, deliver and maintain new products. It's 
anpther thing to make money doing it. How can organisations obtain a sizeable payoff 
from their investments.in information systems? How can management make sure that 
the management information systems contribute to corporate value? 

6.8.5 The Responsibility and Control Challenge 

Remember, humans should drive the technology, not the other way around. Too often 
we find it easier to blame the computer for messing up than to realize it's only doing 
wl:(at a human being told it to do. Your goal should be to integrate the technology into 
the world of people. Humans do control the technology, and as a manager, you 
sh9uldn't lose sight of that. 

How can we define infonnation systems that people can control and understand? 
Alt• ougb information systems have provided enormous benefits and efficiencies, they 
ha e also created new problems and challenges of which managers should be aware. 

Th following table describes some of these problems and challenges. 

Table 6 . .2: Positive and Negative Impacts of Information Systems 

Benefits of Information Systems Negative Impact 

Infonnation system can perfonn calculations or By automating activities that were previously 
prtx:ess paperwork much faster than peo(>le. performed by people, information systems may 

eliminate jobs 

Information systems can help companies learn lnformation systems may allow organisations to 
mpre about the purchase (>3ttems and the collect personal details about people that violate 
preferences of the customers. their privacy 

Information systems provide new efficiencies Infonnation systems are used in so many aspects 
through services ~uch as automated teller of everyday life that system outage$ can cause 
m~chioes (A TMs), telephone systems, or shutdowns of businesses or transportation 
c~mputer controlled airplanes and air terminals services, paralyzing communities. 

lnfonnatioo systems have made possible new Heavy uses of information systems may suffer 
m~ical advances in surgery, radiology, and repetitive stress injury, technostress, and other 
patient monitoring health problems 

The internet distributes information instantly to The internet can be used to distribute illegal 
mjllions of people acro~s the world. copies of software, books, articles, and other 

l intellectual property. 
. 

Management's focus must continually change to take advantage of new opportunities. 
Changes should take place throughout the organization. They require lots of attention 
and planning for smooth execution. 



6.9 ETIDCAL AND SOCIETAL ISSUES OF 
INFORMATION SYSTEM 

It probably goes without saying that the security and ethical issues raised by the 
Information Age and speci'tically the Internet are the most explosive to face our 
society in decades. It will be many years and many court battles before socially 
acceptable policies and practices are in place. 

6.9.1 A Model for Thinking about Ethical, Social, and Political Issues 

Many of these issues not only touch our society as a whole, but also raise lots of 
questions for organizations, companies, and the workplace in general. We hear 
arguments for free speech, personal responsibility, and corporate respons,ibility. There 
are discussions about the government's role in all this. 

How you act, individually and as groups, in· this gray area may well define the future 
of OU!" society. Though that may sound a bit dramatic, you must unders1tand that you 
are part of the development of "acceptable usage" of this new medium and will help 
define the direction in which it goes. That's no exaggeration: You use; the lntemet 
frequently (and be assured the frequency will increase), therefore you are .... ! 

Five Moral Dimensions of the Information Age 

Information 
Rights and 
Obligations 

Quality of Life 

Properfy Right 
and Obligations 

Figu.re 6.S: Ethical, Moral, Political Issues io ao loformatioo Soctety 

This above figure 6.5 shows the relationship between ethical, social, and political 
issues in an in.formation society. You could change this diagram somewhat to avoid 
the impression that the five dimensions are separate. You'd show significant overlap 
of each area, and most of the diagram would be in shades of gray. The five 
dimensions we'll discuss are: information rights and obligations, pmperty rights, 
accountability and control, system quality, and the quality of life. 

6.9.2 Key Technology Trends that Raise Ethical Issues 

Infonnation technologies pose problems and threats to established societal rules, and 
new advances pose new situations and possible threats to privacy and ethics. In 
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addition to the technologies in the book, you need to understand the most recent 
technological threats to your privacy in cyberspace: 

Y ~u say to yourself, ''Hey I don't really care. Nobody will ever care about what J do or 
wrere I go on the Internet." Well, you might want to think twice about that. There 
have been reported instances of companies accessing databases from various sources 
as part of the screening process to determine what chat rooms, Web sites, etc., 
prpspective employees have visited. How can that be, you ask? The technological 
trclnds we discuss, such as advances in data storage, will give you one clue. The 
scfoario at the beginning of this section about a personal profile is possible through 
the technique called datamining. It can. and has been done, so you should be 
cobcemed and you should care. · 

6.~.3 Ethics in an Information Society 
' Ord you ever hear the old warning, "Just because you can, doesn't mean you should?" 

Well., a lot of things are possible on the Internet nowadays, but that doesn't mean you 
should do them. · 

Ethics is easily managed in small groups because the group itself tends to control the 
individual's behavior. The larger the group, the harder it is to manage the actions of 
inilividuals. Now stretch that to a huge number of people with many frames of 
reference and experiences. Responsibility to the group becomes harder to police and 
accountability for an individual's actions is harder to enforce. 

Basic Concepts: Respomibility, Accountability, and Liability 

Every action causes a reaction. When you'.re using the Internet, computers on campus, 
or your employer's co~puter, you should be aware of: 

• Responsibility: accepting potential costs, duties, and obligations for your 
decisions. 

• Accountability: determining who should take responsibility for decisions and 
actions. 

• Liability: legally placing responsibility with a person or group. 

• Due Process:. ensuring the laws are applied fairly and correctly. 

Responsibility, accountability, and liability are all yours when it comes to your actions 
in cyberspace. Every Intetnet Service Provider has a "usage policy," even the so­
called anonymous e-mailers that hide your real identity. HotMail is a popular Internet 
email service that allows you to mask who you really are. You could send out all the, 
shall we say, unethical, threatening, nasty, aberrant email you like. You think: "Hey, 
no one will really know who I am. This is cool." 

And then here comes the message from HotMail to cease and desist. Your free email 
account is cancelled because you violated HotMail's usage policy. Then your local 
Internet Service Provider contacts you and tells you you're terminated, baby! You 
vio,lated its usage policy by your actions. By now you're really mad, not to mention 
embarrassed (at least we hope so). It's true. It happens. 

Just because you think you can, doesn't mean you should. Would you stand in the 
middle of campus and shout insults? As the text points out, "Using information 
technology in a socially responsible manner means that you can and will be held 
acqountable for tbe consequences of your actions." Just as you are subject to rules, 
whether you like them or not, in public, you are subject to societal rules in cyberspace. 
Anonymity isn't a license for socially unac~eptable behavior. 

Some people $eem to absolve themselves of responsibility by putting the blame on the 
computer - ''Hey, the computer screwed up," or "Since it was an anonymous 



usemame, I didn't think I'd get caught." It just doesn't work that way. No one can bide 
behind tbe technology. Humans control the computers, not the other way around. 

And if you have received threatening, aberrant emails or flames in c:hatroom or 
discussion groups, and haven't reported them according to the usage policies, you may 
be as much a part of the problem as the perpetrator! 

Ethical Analysis 

It's safe to say you'll find yourself in situations where your ethics are challenged. 
What should you do? Try: 

• Separating fact from fiction. 

• Remembering, no matter how thin you slice it, there are always two sides. 

• Determining who's really involved. 

• Compromising; it doesn't always have to be an "either-or" outcome. 

• Anticipating the outcome; it will help you. devise better solutions. 

I. The music industry is struggling with the issue of music downloadi!d from 

2. The ..... . . ..... . ...... represents a supportive element that facilitates the 
transfer of information across organizational boundaries. 

3. An .. ....... ...... .... may play an important role in the coordina1tion of 
interdependent activities, which would be carried out by distant 
organizational units. 

6.10 LET US SUM UP 

Infonnation Literacy is more than just clicking a roou5e, pounding th•~ computer 
keyboard, or surfing the Web. It's about integrating various elemc~nts of an 
organization, technical and non-technical, into a successful enterprise. As a successful 
manager you must concentrate on all the three parts of the lnformatfon Systems 
triangle (hardware, software, and liveware) and integrate them into a singl.e, cohesive 
system that serves the needs of the organization, the wants of the customer, and the 
desires oftbe employees. The more complex, the harder to manage, but the, greater the 
payoff. Managers will also be faced with ongoing problems of security a1nd control. 
Information systems are so essential to business, government and daily life that 
organizations must take special steps to ensure that they are accurate, reliable and 
secure. A firm invites disaster if it uses systems that don't work as intended, that don' t 
deliver information in a form that people can interpret correctly and use, or that have 
control rooms, where control don' t work or where instruments give false signals. 
Information systems must be designed so that they function as intended and so that 
humans can control the process. 

6.11 KEYWORDS 

Information System: A collection of elements that capture data and convert it in 
information and disseminate to the decision-makers in an organization. 

Information Technology: Hardware and software that perfonn data proce,ssing tasks, 
such as capturing, transmitting, storing, retrieving, manipulating or displaying data. 

Input: Consists of data, instructions and inv9lves capturing and assembling elements 
that enter the system to be processed. 
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Output Controls: Output controls are developed to ensure that infonnation products 
are correct and complete and available to authorized users in a timely manner. 

Information Superhighway: An advanced high-speed Internet-like network that 
connects individuals, households, businesses, government agencies, libraries, schools, 
universities, and other institutions with interactive voice, video, data, and multimedia 
communications. 

Jnformation Retrieval: The methods and procedures for recovering specific 
inforrnation from stored data. 

Information Systems Planning: A formal planning process that develops plans for 
developing and managing information systems that will support the goals of the 
organization. This includes strategic, tactical, aod operational planning activities. 

IT Architecture: A conceptual design for the implementation of infonnation 
technology in an organization, including its hardware, software, and network 
technology platfonns, data resources, application portfolio, and IS organization. 

6.12 QUESTIONS FOR DISCUSSION 

I. Why are infonnation systems essential in business today? Identify atleast two 
trends in the global business environment that have made information systems so 
important 

2. Evaluate the role of information systems in supporting various levels of business 
strategy. Why is there considerable resistance in organizations towards 
introduction of information systems? 

3. How are information systems changing the management process? What specific 
managerial roles can information systems support? 

4. How can information systems support an organisation's business operations, 
decision making by their managers and give them a competitive advantage? 
Identify examples within your organisation to illustrate your answer. 

5. What are the key management challenges involved in building, operating and 
maintaining information systems today? 

6. How we change our infoanation system according to the competitive business 
-environment? 

7. How IT provides help in the design of organization? 

8. What an: the roles of information tech.tiology on the emergence of new 
organizational system? 

Check Your Progress: Model Answer 

1. Web sites 

2. Information Technology (11) 

3. 10S 
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